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Attributes and Rights
Change the Attributes of a File or Directory
Change the IRF of a File or Directory
View an Object's Effective Property Rights to another Object
View an Object's Effective Rights to another Object
View an Object's Effective Rights to a File or Directory



Change the Attributes of a File or Directory

To change the attributes of a file
1. Select a file.
2. From the Object menu, choose Details.
3. Choose the Attributes page.
4. Select check boxes for attributes that you want to set for this file.
5. Choose OK.
To change the attributes of a directory
1. Select a directory.
2. From the Object menu, choose Details.
3. Choose the Attributes page.
4. Select check boxes for attributes that you want to set for this directory.
5. Choose OK.



Change the IRF of a File or Directory

To change the IRF of a file
1. Select a file.
2. From the Object menu, choose Details.
3. Choose the Trustees of this File page button.
4. In the Inheritance Filter field, select check boxes for rights that you want to allow to be inherited for 

that file.
Rights that are not checked cannot be inherited.

5. Choose OK.
To change the IRF of a directory
1. Select a directory.
2. From the Object menu, choose Details.
3. Choose the Trustees of this Directory page button.
4. In the Inheritance Filter field, select check boxes for rights that you want to allow to be inherited for 

that directory.
Rights that are not checked cannot be inherited.

5. Choose OK.



View an Object's Effective Property Rights to Another Object
1. Select the object that you want to see another object's property rights to.

Example: If you want to see the property rights User ANDREW has to Printer LASER, choose 
LASER in this step. 

2. From the Object menu, choose Trustees of this Object.
3. Choose the Effective Rights button.

4. Choose the browser icon. 
5. Select the object whose effective property rights to the object selected in Step 1 you want to see.
6. In the Select Object dialog, choose OK.

The effective rights of the selected object to all properties are bolded.
7. To see the effective property rights for a specific property, select the Selected Properties button; then 

choose a property from the list.
The effective property rights for that individual property are bold.

8. In the Effective Rights dialog, choose Close.
9. Choose Cancel to return to the browser.



View an Object's Effective Rights to another Object
1. Select the object that you want to see another object's effective rights to.

Example: If you want to see the effective rights User ANDREW has to Printer LASER, choose 
LASER in this step. 

2. From the Object menu, choose Trustees of this Object.
3. Choose the Effective Rights button.

4. Choose the browser icon. 
5. Choose the object whose effective rights to the object selected in Step 1 you want to see.
6. In the Select Object dialog, choose OK.

The effective rights of the selected object are shown in bold.
7. In the Effective Rights dialog, choose Close.
8. In the Trustees dialog, choose Cancel to return to the browser.



View an Object's Effective Rights to a Directory or File

To view an object's effective rights to a directory
1. Select a directory.
2. From the Object menu, choose Details.
3. Choose the Trustees of this Directory page button.
4. Choose the Effective Rights button.

5. Choose the browser icon. 
6. Select the object whose effective rights to this directory you want to see.
7. In the Select Object dialog, choose OK.
8. Choose Close.
9. To return to the browser, choose Cancel.
To view an object's effective rights to a file
1. Select a file.
2. From the Object menu, choose Details.
3. Choose the Trustees of this File page button.
4. Choose the Effective Rights button.

5. Choose the browser icon. 
6. Select the object whose effective rights to this file you want to see.
7. In the Select Object dialog, choose OK.
8. Choose Close.
9. To return to the browser, choose Cancel.



Directories and Files
Add or Delete a Trustee
Change the Attributes of a Directory or File
Change the Current Context
Change the IRF of a Directory or File
Change the Owner of a Directory or File
Create a Directory
Purge a File
Salvage a File
Set the Preferred Name Space
View an Object's Effective Rights to a Directory or File
View Information about a Directory
View Information about a File



Change the Owner of a File or Directory
1. Select a file or directory.
2. From the Object menu, choose Details.
3. Choose the Facts page button.

The owner is listed on the Facts page.

4. Choose the browser icon. 
5. Choose the object that you want to be the new owner of this file or directory.
6. When the correct object is displayed in the Selected Object field, choose OK.

The new owner appears in the Owner field
7. Choose OK.



Create a Directory
1. Choose the directory or volume that will be the parent of the directory you want to create.
2. From the Object menu, choose Create.
3. From the list of objects, select Directory.
4. Choose OK.
5. In the Directory name box, type the name for the new directory.
6. (Optional) To define additional information about this directory right now, select Define Additional 

Properties.
You cannot select this if you select Create Another Directory.

7. (Optional) To create another directory immediately after this one, select Create Another Directory.
You cannot select this if you select Define Additional Properties.

8. Choose Create.
If you selected Define Additional Properties, the directory object dialog appears.
If you selected Create Another Directory, this dialog appears again.



Purge a File
1. Select the directory that contains the file that you want to purge.

If the directory containing the file was also deleted, select any directory.
2. From the Tools menu, choose Salvage.
3. To list all the files that have been deleted in this directory, choose List.
4. Select the file that you want to permanently delete.

If the file was in a directory that was deleted, choose Deleted Directories in the Source Option field. If 
the file does not appear, check that the Include field includes the file's pattern in its file specification.

5. Choose Purge.
6. At the confirmation box, choose Yes.
6. To return to the browser, choose Close.



Salvage a File
1. Select the directory that contained the file that you want to salvage.

If the directory containing the file was also deleted, select any directory.
2. To list the files that have been deleted from this directory, choose List.
3. From the Object menu, choose Salvage.
4. Select the file that you want to salvage.

If the file was in a directory that was deleted, choose Deleted Directory in the Source Option field. If 
the file does not appear, check that the Include field includes the file's pattern in its file specification.

5. Choose Salvage.
The file will now appear in regular directory searches and can be used by applications.

6. To return to the browser, choose Close.



View Information about a Directory
1. Select a directory.
2. From the Object menu, choose Details.
3. Choose the page button for the information you want to see about this directory.



View Information about a File
1. Select a file.
2. From the Object menu, choose Details.
3. Choose the page button for the information you want to see about this file.



Logging In
Create or Change a Profile Login Script
Create or Change a System Login Script
Create or Change a User Login Script
Prevent a User from Logging In
Set Login Restrictions



Login Scripts
Create or Change a Profile Login Script
Create or Change a System Login Script
Create or Change a User Login Script



Create or Change a Profile Login Script
1. Select the Profile object.
2. From the Object menu, choose Details.
3. Choose the Login Script page button.
4. Type the login script commands you want.
Note: When you have made all necessary changes to the pages of this dialog, choose OK.



Create or Change a System Login Script
1. Select the Organizational Unit.
2. From the Object menu, choose Details.
3. Choose the Login Script page button.
4. Type the login script commands you want.
Note: When you have made all necessary changes to the pages of this dialog, choose OK.



Create or Change a User Login Script
1. Select the User object.
2. From the Object menu, choose Details.
3. Choose the Login Script page button.
4. Type the login script commands you want.



Objects
To perform a task on an object, choose that object. The object dialog will appear. You can do most tasks 
in the object dialog. For help while using the object dialog, choose Help.

Add or Delete a Trustee of an Object
Change an Object's IRF
Create an Object
Find Objects Associated with an Object
Include Certain Object Classes in the browser
Rename an Object



Change an Object's IRF
1. Select an object.
2. From the Object menu, choose Trustees of this Object.
3. Choose the Inherited Rights Filter page button.
4. Select check boxes for rights that you want to allow to be inherited.

If the check box by a right is not marked, that right cannot be inherited. To change the Inherited Rights
Filter for specific property rights, you must also choose Specific Property and select a property from 
the Properties list.

5. Choose OK.



Create an Object
1. Select the container that you want the object created under.
2. From the Object menu, choose Create.
3. From the list of objects, select the type of object you want to create.
4. Choose OK.

Choose the Help button in the dialog for more information.



Find Objects Associated with an Object
1. Select the object.
2. From the Object menu, choose Details.
3. Choose the See Also page button.
4. Choose Add . . .
5. Choose the object you want associated with the object you selected in Step 1.
6. Choose OK to close the Select Object dialog.
7. Choose OK.



Partition
Create a Partition
Merge Partitions
Move a Partition

View or Edit a Replica



Create a Partition
1. From the Tools menu, choose Partition Manager.
2. Select the container object that you want to be the root object of the new partition.
3. Choose Create Partition.



Merge Partitions
1. From the Tools menu, choose Partition Manager.
2. Select the container object that is the root of the partition that you want to merge with its parent.

You must select a container that has a partition icon to the left. The [Root] partition cannot be merged,
because it is the top partition.

3. Choose Merge.



View or Edit a Replica
1. From the Tools menu, choose Partition Manager.
2. Select the container that is the root object of the partition whose replicas you want to see.
3. Choose Replicas.



Move a Partition
1. From the Tools menu, choose Partition Manager.
2. Choose Help for help from here.



Passwords
Allow Users to Change Passwords
Create or Change a Password
Set Password Restrictions



Allow Users to Change Passwords
Follow these procedures if you want to allow a user in your network to have the right to change his or her 
password.
1. Select a User object.
2. From the Object menu, choose Details.
3. Choose the Password Restrictions page button.
4. Select the Allow User to Change Password check box.
5. Choose OK.



Create or Change a Password
1. Select the User object.
2. From the Object menu, choose Details.
3. Choose the Password Restrictions page button.
4. Choose Change Password.
5. In the Old Password box, type the old password.

If this is a new user, the Old Password option is disabled.
6. In the New Password box, type the new password.
7. In the Retype Password box, type the new password again.
8. Choose OK.



Set Password Restrictions
1. Select the User object.
2. From the Object menu, choose Details.
3. Choose the Password Restrictions page button.
4. Set the restrictions you want.

Note: For more information, choose the dialog's Help button.
5. Choose OK.



Printing
Assign Printers to Print Servers
Assign Queues to Printers
Create a Print Queue
Create a Print Server
Create a Printer
Control a Printer
Monitor Print Job Status
Setting up NetWare Print Services



Assign Printers to Print Servers
1. Select a Printer.
2. From the Object menu, choose Details.
3. Choose the Connections page.
4.  When you have modified everything you want, choose OK to return to the browser.



Assign Queues to Printers
1. Select a Printer object.
2. From the Object menu, choose Details.
3. Choose the Connections page.
4.  When you have modified everything you want, choose OK to return to the browser.



Monitor Print Job Status
1. Select a Printer object.
2. From the Object menu, choose Details.
3. Choose the Printer Status button.



Control a Printer
1. Select a Printer object.
2. From the Object menu, choose Details.
3. Choose the Printer Status button.
4.  When you have modified everything you want, choose OK to return to the browser.



Create a Print Queue
1. Select a context from the browser.
2. From the Object menu, choose Create.
3. From the Object class list, choose Queue.
4. Choose OK.
5.  When you have modified everything you want, choose OK to return to the browser.



Create a Print Server
1. Select a context from the browser.
2. From the Object menu, choose Create.
3. From the Object class list, choose Print Server.
4. Choose OK.
5.  When you have modified everything you want, choose OK to return to the browser.



Create a Printer
1. Select a context from the browser.
2. From the Object menu, choose Create.
3. From the Object class list, choose Printer.
4. Choose OK.
5.  When you have modified everything you want, choose OK to return to the browser.



Search
Search for an Object or Property
Search Object Classes



Security
Allow Users to Change Passwords
Change the IRF of a Directory or File
Change the Attributes of a Directory or File
Create or Change a Password
Limit the Number of Workstations a User Can Log In To
Prevent a User from Logging In
Set Login Restrictions
Set Password Restrictions
View an Intruder's Address



View an Intruder's Address
If a user's account is locked because an intruder attempted to access it, you can see the address of the 
intruder.
1. Select the User object.
2. From the Object menu, choose Details.
3. Choose the Intruder Lockout page button.

The information is in the Intruder Address field.



Prevent a User from Logging In
1. Select the User object.
2. From the Object menu, choose Details.
3. Choose the Login Restrictions page button.
4. Check the Account Disabled box.
5. Choose OK.

The user won't be able to log in again until you reset the Account Disabled box.



Trustees
Add or Delete a Trustee of a File or Directory
Add or Delete a Trustee of an Object
Modify a Trustee's Rights to a File or Directory
Modify the Object Rights of a Trustee
Modify the Property Rights of a Trustee



Add or Delete a Trustee of a File or Directory

To add a trustee to this file or directory
1. Select the directory or file that you want to grant the trustee access to.
2. From the Object menu, choose Details.
3. Choose the Trustees of this <File/Directory> page.
4. Choose Add Trustee.
5. Select an object to be the trustee.
6. Choose OK.

The object that you chose is added as a trustee.
7. Grant rights to the new trustee by selecting the check boxes below the Trustee list.
8. To save all changes, choose OK.
To delete a trustee
1. Select the directory or file whose trustees you want to view.
2. From the Object menu, choose Details.
3. Choose the Trustees of this <Directory/File> page.
4. Select the trustee you want to delete.
5. Choose Delete Trustee.

This trustee no longer has explicit rights to this object.
6. (Optional) If a confirmation box appears, choose Yes.
7. To save all changes, choose OK.



Add or Delete a Trustee of an Object

To add a trustee
1. Select the object that you want to give another object rights to.
2. From the Object menu, choose Trustees of this Object.
3. Choose Add Trustee.
4. Select the object you want to add as a trustee.
5. Choose OK.

The trustee appears in the Trustees list.
6. Select check boxes for the rights you want to grant to that object.
7. Choose OK.
To delete a trustee
1. Select the object for which you want to delete a trustee.
2. From the Object menu, choose Trustees of this Object.
3. Select the trustee you want to delete.
4. Choose Delete Trustee; then choose Yes.

The deleted trustee no longer has explicit rights to this object.



Change a Trustee's Rights to a File or Directory

To change a trustee's rights to a file
1. Select the file for which you want to change a trustee's rights.
2. From the Object menu, choose Details.
3. Choose Trustees of This File.
4. From the Trustees list, select the trustee whose rights you want to change.
5. To grant or revoke rights for this trustee, select the check boxes in the Access Rights field.

Boxes that are checked show rights that this trustee has to this file.
6. Choose OK.

The new rights you assigned to the trustee now take effect.
To change a trustee's rights to a directory
1. Select the directory for which you want to change a trustee's rights.
2. From the Object menu, choose Details.
3. Choose Trustees of This Directory.
4. From the Trustees list, select the trustee whose rights you want to change.
5. To grant or revoke rights for this trustee, select the check boxes in the Access Rights field.

Boxes that are checked show rights that this trustee has to this directory.
6. Choose OK.

The new rights you assigned to the trustee now take effect.



Modify the Object Rights of a Trustee
1. Select the object for which you want to change the trustee's rights.
2. From the Object menu, choose Trustees of this Object.
3. Select the trustee whose rights you want to change from the Trustees list.
4. To grant or revoke object rights for this trustee, select the check boxes in the Object Rights field.
5. Choose OK.

The new rights you assigned to the trustee now take effect.



Modify the Property Rights of a Trustee
1. Select the object for which you want to change the trustee's rights.
2. From the Object menu, choose Trustees of this Object.
3. From the Trustees list, select the trustee whose rights you want to change.
4. To grant or revoke object rights for this trustee, select the check boxes in the Property Rights field.

To change specific property rights of a trustee, choose the Specific Property button and then select a 
property from the Properties list.

5. Choose OK.
The new rights you assigned to the trustee now take effect.



Users and Groups
Change a User's Account Balance
Change a User's Network Address
Create or Modify a User's Login Script
Prevent a User from Logging In
Find Objects Affiliated with a User
Limit the Number of Workstations a User Can Log In To
Add a User to a Group
Delete a User from a Group
Set an Expiration Date for a User Account
Set Login Restrictions
Create a User Template



Limit the Number of Workstations A User Can Log In To
1. Select the User object.
2. From the Object menu, choose Details.
3. Choose the Login Restrictions page button.
4. Select Limit Concurrent Connections.
5. Enter the number of workstations (up to 999) that a user can log in to simultaneously in Maximum 

Connections.
6. Choose OK.



Add a User to a Group
1. Select the User object.
2. From the Object menu, choose Details.
3. Choose the Group Membership page.
4. Choose Add. . .
5. Select the Group that you want to add this user to.
6. Choose OK to close the Select Object dialog.
7. Choose OK.



Delete a User From a Group
1. Select the User object.
2. From the Object menu, choose Details.
3. Choose the Group Membership page button.
4. Select the Group from which you want to delete this user.
5. Choose Delete.
6. Choose OK.



Set Login Restrictions
1. Select the User object.
2. From the Object menu, choose Details.
3. Choose the Login Restrictions page.
4. To prevent a user from logging in, select Account Disabled.
5. To make the account expire at a certain time, select Account Has Expiration Date.

5a. To change the day the account expires, highlight the month, day, or year, then use the arrows 
next to the field to change that part of the date.

5b. To change the time the account expires, highlight the hour, minute, or second, then use the 
arrows next to the field to change that part of the time.

6. To limit the number of workstations a user can log in to simultaneously, select Limit Concurrent 
Connections; then enter the number in the Maximum Connections box.



Set an Expiration for a User Account
1. Select the User object.
2. From the Object menu, choose Details.
3. Choose the Login Restrictions page button.
4. Select Account Has Expiration Date.
5. To change the day the account expires, highlight the month, day, or year, then use the arrows next to 

the field to change that part of the date.
6. To change the time the account expires, highlight the hour, minute, or second, then use the arrows 

next to the field to change that part of the time.
7. Choose OK.



Using Partition Manager
Partition Manager allows you to manage NetWare Directory partitions and replicas. You can divide your 
Directory tree into partitions and manage various replicas of these partitions.
Upon installation of NetWare, NetWare Directory Services (NDS) creates the [Root] object as your default
partition. An object can reside in only one partition, but through distributed operations (creating partitions 
and replicas of those partitions, the object can be accessed from any point on the network.
To optimize access to different areas of the Directory, each partition can be replicated and stored at many 
locations. Partition replication improves access to Directory information and provides the Directory with 
fault tolerance.
If a partition is replicated at several locations, damage to one replica doesn't need to interrupt access to 
the partition information.
Using the Partition Manager browser
The Partition Manager main window is a browser window. Only container objects and NetWare Server 
objects are shown.
You can navigate through the browser by choosing containers to move down levels and choosing the Up-
arrow to move back up towards the [Root].
Containers that are the root of a partition are red and show the partition icon to the left. NetWare Server 
objects are blue. Different buttons are active when different objects are selected in the main window.

Procedures
Create a New Partition
Merge Partitions
View or Modify Replicas
View Partitions on a Server
Abort Partition Operation
Delete a NetWare Server Object
Move a Partition

Screen regions and buttons
Context shows your current context in the Directory tree.

Replica Being Read shows the name of the replica (the complete name of the server the replica 
resides on) that Partition Manager is searching for Directory Services information.

Partitions lists partitions in the current context and allows you to view other partitions. Objects that are
partition roots are marked with the partition icon.

Create As New Partition divides an existing partition to create a new partition. The selected container 
object becomes the root of the new partition, and a master replica of the new partition is created 
on the server where the master replica of its parent partition is located.

Merge Partitions merges a partition with its parent partition, leaving a single partition. All replicas are 
merged as well. You must select a partition below the [Root] of the tree to choose this option.

Replicas allows you to add, delete, view, or modify the existing replica types for the selected partition.

Server Partitions lists replicas stored on the selected NetWare server. You must select a NetWare 
Server object before this option is available.

Abort Partition Operation stops the operation you have started (you have either started to create a 
new partition or merge a partition with its parent partition).

Delete Server deletes a NetWare Server object and all its associated information, including its 
partitions and replicas. You delete a NetWare Server object only if the server is down.

Move Partition moves a partition to a different context in the tree. You can move a container object 
only if it is the root of a partition. You can move only partitions that don't have subordinate 



partitions.

Close closes this dialog. Any changes you made are saved.



Create a New Partition
A partition can consist of one or more container objects and their associated leaf objects. A partition 
cannot contain only leaf objects. The container at the top of the partition is called the root of the partition.
When you create a new partition, you split the parent partition and end up with two partitions. The new 
partition becomes a child partition.
For example, if you select an Organizational Unit and choose to create it as a new partition, you are 
choosing to split the Organizational Unit from its parent partition ([Root], for example, which is always a 
partition). The Organizational Unit you selected becomes the root of a new partition.
The replicas of the parent partition will remain on the same servers, and information for the new partition 
will migrate from the parent partition's replicas to the new partition's replicas.
The master replica of the new partition will be stored on the same server as the master replica of the 
parent partition.
Creating a partition may take some time, since all of the replicas need to be synchronized with the new 
partition information.
When you create a new partition, the utility you use will inform you that the partition is created 
successfully, but the actual creation of the partition is still completing on the servers. If you attempt 
another partition operation while the partition is being created, you will receive a message telling you to 
wait a few minutes before attempting another partition operation.

To create a new partition
1. To locate the container object that you want to create as a partition, browse the "Partition Manager" 

screen.
If the container object does not appear in the window, browse the tree by choosing an object to see its
subordinates, or by choosing the arrow to move toward the [Root]. Your current context appears in the
upper-left corner of the screen.
For information about moving around in the "Partition Manager" screen and selecting objects, choose 
"Help."

2. Select a container object.
3. Choose "Create as New Partition."
4. To confirm the creation of a new partition, choose "Yes."

The new partition is created when the process is completed on the servers. To see the partition icon 
that signifies that a container is the root object of a partition, refresh the screen by choosing the Up-
arrow and then expanding the parent container.
A master replica of the newly-created partition is stored on the server where the parent partition's 
master replica resides.



View or Modify Replicas
From the Partition Replicas dialog, you can view existing replicas of the selected partition. You can 
change the type of any replica, add new replicas to other NetWare servers, or delete replicas.

Procedures
Add a Replica
Delete a Replica
Change the Type of an Existing Replica
Send Updates
Receive Updates

Screen regions and buttons
Partition lists the current partition whose replicas you are viewing. If you are viewing replicas of the 

[Root] partition, the Partition field will be blank.

Replica Being Read shows the name of the replica (which is the complete name of the server the 
replica resides on) that Partition Manager is searching for Directory Services information.

Master Replica lists the NetWare Server object where the master replica of this partition is stored.

Server lists the other NetWare servers on which replicas of this partition are stored.

Type lists the replica type of each of the existing replicas of this partition.

Synchronized Up To lists the time stamp of the last time the replica was synchronized with all other 
replicas of the partition.

Add Replica allows you to add a replica of this partition and store it on a NetWare server that does not
already have a replica of this partition.

Delete Replica deletes the selected replica. You cannot delete the replica that is the master replica.

Change Type changes the replica type of the selected replica.

Send Updates sends updated information from the replica you select to all the other replicas of the 
partition.

Receive Updates allows the replica you select to receive updated information from all the replicas of 
the partition.

Close saves changes and returns to the list of partitions.



Add a Replica
Right needed: The Supervisor object right to the container object at the root of the partition.
When you create a partition, a master replica is automatically created and stored on the server where the 
parent partition's master replica resides. You can add additional replicas of the partition, within these 
guidelines:

 You can have only one master replica. Additional replicas must be read/write or read-only.
 You can store only one replica of a partition on a server.

To Add a Replica
1. Choose "Add Replica."
2. From the browser, select the NetWare Server object that you want this replica to be stored on.

The partition for which you are creating the replica appears at the top of the screen. The context and 
server information changes as you move through the Directory tree structure.

3. Choose the replica type you want to create.
For most replicas, read/write should be used. Read/write replicas can be written to. They send out 
information for synchronization when a change has been made. Read-only replicas cannot be written 
to. However, they are updated when the replicas synchronize.

4. To create the replica, choose "OK."
The new replica is created on the server you selected.



Change the Replica Type
Note: You cannot use this procedure to change the type of the master replica. To specify a new master 
replica, change the type of an existing read/write replica to master, and the master replica is automatically
changed to read/write.
1. Select the replica whose type you want to change.
2. Choose "Change Type."
3. Select a replica type.

For most replicas, read/write should be used. Read/write replicas can be written to. They send out 
information for synchronization when a change has been made. Read-only replicas cannot be written 
to. However, they are updated when the replicas synchronize.

4. Choose "OK."
The replica type is changed. You return to the list of replicas of this partition.



Delete a Replica
Right needed: The Supervisor object right to the object at the root of the partition whose replica you 
want to delete.
When you delete replicas, keep the following guidelines in mind:

 If a master replica becomes corrupted, change a read/write or read-only replica on another server to 
the master replica. This automatically changes the old master replica to a read/write replica.

 For fault tolerance, you should maintain at least one replica of the master partition on different servers.
 Deleting a replica deletes a copy of part of the Directory database. The database can still be accessed 

on other servers in the network, and the server that the replica was on still functions in NetWare Directory 
Services.
To delete a replica
1. Select the replica you want to delete.
2. Choose "Delete Replica."

You cannot delete a master replica. If the replica you want to delete is a master, go to a server with 
another replica of the master and make it the new master replica. This automatically changes the old 
master replica to a read/write replica, which you can then delete.

3. Choose "OK."



Merge a Partition
When you merge a partition, the selected partition is combined with its parent partition. You might want to 
merge two partitions if the Directory information in the two partitions is closely related.
In other words, you merge a partition with its parent partition when you want to delete the partition without
deleting the objects in the partition. Consider keeping partitions separate if the partitions are large, 
because large partitions slow down response time.
You do not delete partitions. You only merge and create partitions to define how the Directory tree is split 
into parts.
The partition is merged when the process is completed on the servers. Merging a partition with its parent 
partition might take some time, since the replicas need to be deleted and the parent replicas updated with
the merging partition information. The replicas of the partitions are also merged.
A partition with no parent partition will merge with the [Root] partition.

To merge a partition
1. To locate the container object that you want to merge with the parent partition, browse the "Partition 

Manager" screen.
If the partition does not appear in the window, browse the tree by selecting an object to see its 
subordinates, or by choosing the arrow to move toward the [Root]. Your current context appears in the
upper-left corner of the screen.
For information about moving around in the "Partition Manager" screen and selecting objects, choose 
the "Help" button.

2. Select the partition you want to merge.
You must select a container object that has the partition icon to its left. [Root] cannot be merged 
because it is the top partition; it has no parent to merge with.

3. Choose "Merge Partition."
To merge the partition with its parent, choose "Yes."
The partition is merged when the process is completed on the servers. To see that the icon of the 
partition you merged is gone (which signifies that the merge is complete), you need to refresh the 
screen by choosing the Up-arrow and then expanding the container again.



View Server Partitions
This dialog displays partitions that have replicas stored on this NetWare server and the type of replica of 
each partition. Each partition is specified by the complete name of its root object.
This information allows you to see how many of this NetWare server's resources are used by partition 
replicas, and how far across the network users might need to go to find certain parts of the Directory 
database.
The data in this dialog cannot be changed. To change replicas, choose "Close" and select a server; then 
from the Partition Manager dialog, choose "Replicas."

Screen regions and buttons
Partitions on Server shows the complete name of the server that contains replicas of the partitions 

listed in the Partition field.

Replica Being Read shows the name of the replica (the complete name of the server the replica 
resides on) that Partition Manager is searching for Directory Services information.

Partition lists the root object of each partition that has a replica on the server specified by the 
Partitions on Server field.

Type lists the replica type of the replicas of each partition.

Close saves changes and returns to the Partition Manager browser.



Delete a NetWare Server Object
Right needed: The Supervisor object right to the container of the NetWare Server object you want to 
delete.
Warning
Deleting a NetWare Server object permanently removes it from your network. It also permanently 
removes its data and resources from the network.
Deleting a NetWare Server object may corrupt your NDS database, especially if the Server object 
provides NDS database services (such as storing partition replicas).
Use Partition Manager to move the replicas on the NetWare server to avoid deleting a NetWare server 
that stores the only replica of a part of the Directory tree.

You must bring a NetWare server down before you can delete its object. If you delete a NetWare Server 
object, the only way to get it back is to reinstall the server using the INSTALL.NLM program at the server 
console, or to re-create the object after bringing the server back up.
Before deleting the NetWare Server object with the Partition Manager tool, consider these alternatives:

 Change the master replicas stored on this server to read/write replicas and then delete all replicas on 
the NetWare server. Once all the processes are complete, you can delete the NetWare Server object.

 Remove NDS from the server with the INSTALL.NLM. This procedure protects your NDS database 
from losing services.

 Move the NetWare Server object to another context. (You do not need to delete the NetWare Server 
object and recreate it in another context.)
To Delete a NetWare Server Object
1. At the server console, bring down the server by typing

DOWN <Enter>

For more information, see "Bringing Down a Server" in Chapter 7 of Supervising the Network.
2. From the MS Windows Program Manager at your workstation, choose the "NetWare Administrator" 

icon.
3. From the "Tools" menu, choose "Partition Manager."
4. Browse the "Partition Manager" screen to locate the NetWare Server object that you want to delete.

If the NetWare Server object does not appear in the window, browse the tree by choosing an object to
see its subordinates, or by choosing the arrow to move toward the [Root]. Your current context 
appears in the upper-left corner of the screen.
For information about moving around in the "Partition Manager" screen and selecting objects, choose 
the "Help" button.

5. Select the NetWare Server object and choose "Delete Server."
The NetWare Server object is deleted from the NDS database.



Abort Partition Operation?
You have either started to create a new partition, merge a partition with its parent partition, or move a 
partition, and you have chosen to abort the partition operation in progress.
If you choose Yes, the operation you have started is aborted.
If you choose No, the operation you have started continues, and you are returned to the "Partition 
Management" menu.



Send Updates
Right needed: The Supervisor object right to the object at the root of the partition whose replicas you 
want to send updates to.
This operation sends updated Directory Services information from the selected replica to all the other 
replicas of the partition.
Although NetWare Directory Services automatically synchronizes the Directory data of replicas (so that 
each replica contains recently updated data), you can manually synchronize (update) the directory data of
replicas, if necessary.
You should use the DSREPAIR utility to discover if the data in some replicas is out of sync with the master
replica. If the data is out of sync, you should manually send updates to those replicas from the master 
replica. The data in the other replicas will be synchronized.
Choose "Send Updates" if one or more of the other replicas has lost information, or if you updated the 
selected partition and want to transfer that information to all the other replicas.
Note: This operation may create a lot of network traffic, so it is best to run this operation during a period 
of light network traffic.



Receive Updates
If you choose this operation, the selected replica will receive updated information from the master replica 
of the partition. Choose "Yes" if the selected replica has lost information or has not received updated 
information for an extended period of time.
Although NetWare Directory Services (NDS) automatically synchronizes the Directory data of replicas (so 
that each replica contains the most recently updated data), you can manually synchronize (update) the 
directory data of replicas if they get out of sync.
Use the DSREPAIR utility to discover if the data in some replicas is out of sync with the master replica. If 
the data is out of sync, you should receive updates from the master replica.
You cannot choose "Receive Updates From Other Replicas" from a master replica. The master is 
assumed to be the most current and accurate copy of the partition. If it's not, assign one of the other 
replicas to be the master.
If you choose "Receive Updates From Other Replica" from any replica, that replica will receive NDS 
information from the master.
Note: This operation may create a lot of network traffic, so it is best to run this operation during a period 
of light network traffic.



Create a New Partition?
You have chosen to create a new partition.
When you create a new partition, you divide an existing partition into two separate partitions. No object in 
the tree can be part of more than one partition at the same time.
For example, if you select an Organizational Unit from the browser and choose "Create as New Partition,"
you are choosing to split the Organizational Unit from its parent partition ([Root] for example, which is 
always a partition).
The selected object becomes the root of the new partition, and a master replica of the new partition is 
created on the server where the master replica of its parent partition is located.
Creating a new partition may take several minutes, depending on the location of and number of replicas 
of the parent partition.
To continue and create the object you selected as a new partition, choose "Yes." To cancel the operation 
and return to the browser, choose "No."



Merge a Partition?
You have chosen to merge a partition with its parent partition. When you merge a partition, the selected 
partition is merged, or grafted in, with its parent partition. Any replicas of the selected partition will be 
merged with the parent partition.
When you merge a partition with its parent partition, you are not deleting the container object. No object in
the Directory tree can be part of more than one partition at the same time.
Merging a partition with its parent partition may take several minutes, depending on the location and 
number of replicas of both the selected partition and the parent partition.
To continue and merge the partition you selected with its parent partition, choose "Yes." To cancel the 
operation and return to the browser, choose "No."



Replica Status/Abort Operation
The "Replica Status" dialog displays the replicas of the selected partition (replicas are defined by the 
server they reside on), the type of each replica, and the state of each replica.
There are many different states that a replica can be in. For example, it may be in the process of creating 
or merging. You can choose to abort a partition operation while it's in progress.
Once a partition operation is complete, you cannot abort or undo the operation.

Screen regions and buttons
Partition shows the complete name of the root object of the partition you selected from the browser.

Replica Being Read shows the name of the replica (which is the complete name of the server the 
replica resides on) that Partition Manager is searching for Directory Services information.

Server lists the name of each replica (which is the complete name of the server the replica resides 
on) of the partition you selected from the browser.

Type lists the replica type of each replica of the partition you selected from the browser.

State lists the state of each replica.

Close returns you to the Partition Manager browser.

Abort stops any partition operation in process.



Move Partition
Right needed: The Create object right for the container to which you want to move an object.
Note: You can move a container object only if it is the root of a Directory Services partition that has no 
subordinate partitions. So, moving a container is really moving a partition.
When you move a container object, NetWare Directory Services (NDS) changes all references to the 
container. Although the object's common name remains unchanged, the context name of the container 
(and of all its subordinates) changes.

Important: When you move a partition, create an Alias object that points to the partition you're moving. 
Doing so allows users to continue logging into the network and finding objects in their original Directory 
location.
If you move a partition and do not create an Alias object in place of the moved partition, users who are 
unaware of the partition's new location will not easily find objects in the Directory tree, since they will look 
for them in their original Directory location.
This might also cause client workstations to fail at login if the NAME CONTEXT parameter in the 
NET.CFG file is set to the original location in the Directory tree.

Because the context of an object changes when you move it, users whose name context in their 
NET.CFG file references the moved object need to update their NET.CFG so that it references the 
object's new name.
To automatically update users' NET.CFG file with a new name context after moving an object, use the 
NCUPDATE utility. For instructions, see "NCUPDATE" in Utilities Reference.

To Move a Partition
1. From the "Partition Manager" browser, select the partition that you want to move.

In Partition Manager, the partition icon appears to the left of the object icon. If the container you want 
to move is not a partition, select the container and choose "Create as New Partition." Then refresh the
screen so that the partition icon appears, and go to the next step.
If there are subordinate partitions in the container you want to move, you can merge those partitions 
with their parent partition by selecting them one at a time and choosing "Merge Partitions"; then select
the container you want to move and continue with the next step.

2. From the "Object" menu, choose "Move Partition."
3. Choose the browser button to the right of the "Destination" box.

Use the browser in the "Directory Context" box to view the Directory tree's containers.
The "Objects" box that appears in the lower left corner shows the containers that you select in the 
"Directory Context" box.

4. From the "Objects" box, select a container object (an Organization or Organizational Unit) as the 
place to move the listed objects to; then choose "OK."

5. Select "Create Alias in Place of Moved Container."
To automatically update users' NET.CFG file with a new name context after moving an object, use the
NCUPDATE utility. For instructions, see "NCUPDATE" in Utilities Reference.

6. In the "Move" dialog box, choose "OK."
If you chose to create an alias in place of the moved container, NetWare Administrator polls for the 
creation of the Alias object before it moves the selected partition.
If you don't want the partition you just moved to remain a partition, merge it with its parent partition.
After moving a partition, you need to wait for processes throughout the Directory to be complete 
before you can perform a partition operation with this object again.



Abort Partition Operation
Right needed: The Supervisor object right to the object at the root of the partition.
If you have begun the process of creating, merging, or moving a partition, or changing a replica type, you 
can still abort the process since partition operations take time. You can abort a partition operation only 
before the operation is in its final stages, and only before the replicas of the partition are in their final 
states.
Use this feature if you begin a partition operation and find that your database will not synchronize. If 
NetWare Directory Services (NDS) cannot synchronize replica information in your database because it is 
corrupted, or because a server in your Directory tree is down, you should abort any partition operation in 
progress.

To Abort a Partition Operation
1. To locate the partition that is executing a partition operation, browse the "Partition Manager" screen.

If the container object does not appear in the window, browse the tree by selecting an object to see its
subordinates, or by selecting the Up-arrow to move toward the [Root]. Your current context appears in
the upper-left corner of the screen.
For information about moving around in the "Partition Manager" screen and selecting objects, choose 
the "Help" button.

2. Select the partition that is executing a partition operation and choose "Abort Partition Operation."
As long as at least one of the replicas has not yet completed the operation (as shown in the "State" 
box), you can still abort the operation.

3. To abort the partition operation, choose "Abort," and then choose "Yes."
The partition operation is aborted, and any replicas that have been merged, created, or moved 
(depending on the operation you had begun) are returned to their original Directory location.





Dialog Index

Menu items
Browser
Partition Manager
Salvage
Search

Object dialogs
User Details
File Details
NetWare Server Details
Volume Details
Profile Details
Directory Map Details
Alias Details
Directory Details
Computer Details
Organizational Role Details
Group Details
Country Details
Distribution List Details
External Entity Details
Message Routing Group Details
Messaging Server Details

Create
Create User
Create Volume
Create NetWare Server
Create Directory Map
Create Alias
Create Profile
Create Directory
Create Computer
Create Organization
Create Organizational Role
Create Organizational Unit
Create Group
Create Country
Create Distribution List
Create External Entity
Create Message Routing Group

Access Control (Trustees)
Trustees of Container Objects
Trustees of Leaf objects
Rights to Other Objects
Trustees of Files and Directories



View or Change Trustees of this Object
The Trustees of this Object dialog lists trustees of this container object and their explicitly granted rights. 
When you select a trustee from the list, that trustee's rights to this object appear in the Object Rights field.
Note: The Trustees list does not list User objects, or other objects who inherit rights to this object. To 
check for those objects, choose Effective Rights.
To close the Trustees of this Object dialog and save changes, choose OK.
To close the Trustees of this Object dialog without saving changes, choose Cancel.

Procedures
Add a Trustee
Delete a Trustee
See the Effective Rights of an Object
View or Change the Inherited Rights Filter
Change the Object Rights of a Trustee
Change the Property Rights of a Trustee

Screen regions and buttons
Trustees lists all trustees of this object.

Effective rights are the explicit rights that any object has to this object.

Add trustee adds a new trustee to the Trustees list.

Delete trustee deletes a trustee from the Trustees list.

Object Rights lets you view or change a trustee's object rights.

Property Rights lets you view or change a trustee's property rights.

Clear resets all rights to selected properties in the list to undefined for the selected trustee.

Inherited Rights Filter lets you view or change this object's Inherited Rights Filter

OK saves changes and closes the dialog.

Cancel closes the dialog without saving changes.

Related topics
Trustees of this Object and Rights to Other Objects
Trustees of the [Root] Object in the Directory Tree



View or Change Trustees of this Object
The Trustees of this Object dialog lists trustees of this object and their explicitly granted rights. When you 
select a trustee from the list, that trustee's rights to this object appear below the list.
Note: The Trustees list does not list User objects or other objects who inherit rights to this object.

 To check for those objects, choose Effective Rights. 
 To close the Trustees of this Object dialog and save changes, choose OK.
 To close the Trustees of this Object dialog without saving changes, choose Cancel.

Procedures
Add a Trustee to this Object
Delete a Trustee of this Object
See the Effective Rights of an Object
View or Change the Inherited Rights Filter
Change the Object Rights of a Trustee
Change the Property Rights of a Trustee

Screen regions and buttons
Trustees lists all trustees of this object.

Effective rights are the explicit rights that any object has to this object.

Add trustee adds a new trustee to the Trustees list.

Delete trustee deletes a trustee from the Trustees list.

Object Rights lets you see or change a trustee's object rights.

Property Rights lets you see or change a trustee's property rights.

Clear resets all rights in the list to undefined for the selected trustee.

Inherited Rights Filter lets you view or change this object's Inherited Rights Filter.

OK saves changes and closes the dialog.

Cancel closes the dialog without saving changes.

Related topics
Trustees of this Object and Rights to Other Objects
Trustees of the [Root] Object in the Directory Tree



Add a Trustee to this Object
To add trustees other than yourself, you need the Read and Write property rights to the Object 
Trustees (ACL) property of an object.

1. Choose Add Trustee.
2. Select the objects you want to add to the list of trustees for this object.

If you have only the Add Self property right to the ACL property, only your User object will be added as
a trustee; the Select Object dialog will not appear.

3. Choose OK.
The objects that you selected are added to the Trustees list. By default, the new trustees are granted 
the Browse object right and the Read and Compare property rights to all properties of the object.

Note: To grant rights to the trustee to work with this object, select the check boxes below the Trustees list.



Delete a Trustee of this Object
You cannot delete a trustee from the list if

 It is the only trustee of this object with Supervisor object right
 The object's Inherited Rights Filter blocks the Supervisor object right

You must first grant another trustee the Supervisor object right, or make sure the Inherited Rights Filter 
doesn't block the Supervisor object right. This attempts to prevent you from cutting off Supervisor-level 
access to part of the Directory tree.
Note: You can delete the User object that is the only trustee listed as supervisor for an area. This will 

effectively cut off Supervisor-level access to that part of the Directory tree. Be careful when deleting 
User objects that have Supervisor rights.

You need the Read and Write property rights to the Object Trustees (ACL) property of an object to 
delete trustees.
If you have only the Add Self property right to the ACL property of this object, Delete trustee is only 
available when your User object is the only object selected from the list of trustees.

To Delete a Trustee of this Object
1. From the Trustees list, select the trustee that you want to delete.
2. Choose Delete trustee.
3. Choose Yes.

The User object that you deleted from the Trustees list can still have rights to this object by inheriting 
them from container objects above it in the Directory tree that have been granted trustee rights, or by 
assuming security equivalence (for example, as a member of a Group that is a trustee of this object).



View or Change the Inherited Rights Filter of this Object
You need the Read and Write property rights to the Object Trustees (ACL) property of an object to 
change its Inherited Rights Filter (IRF).

1. To remove the IRF so that all rights can be inherited, select each of the Object Rights boxes and the 
All Properties circle in the Property Rights box.
You will notice that left of each of the Object Rights and Property Rights boxes is an arrow pointing 
down, which means that the right will flow down. If there is a line underneath an arrow, you need to 
select the box to enable the right to flow down.

2. To change the IRF for all properties that have no IRF in this container object, select All Properties.
You can also set an IRF for a specific property. Properties that have an IRF set are checked; others 
are unchecked.

3. To change the Inherited Rights Filter for certain properties only, select Selected Properties and then 
the individual property to modify.
Note: Although you can't inherit rights for specific properties, you can filter rights for properties. The 
IRF filters rights that were set for all properties.

4. Select the check box next to any object right or property right that you want to change.
 If the boxes are grayed, no Inherited Rights Filter exists for this object or the selected set of property 

rights. All rights can be inherited by any trustee.
 If a box is white (not checked), that right is filtered and cannot be inherited by a trustee with a trustee 

assignment above this level. An arrow with a line beneath it appears to the left of the checkbox to indicate
that this right does not flow down.

 If a box is marked (X), that right is not filtered and can be inherited. An arrow appears to the left of the 
checkbox to indicate that this right flows down.

Note: You cannot leave the Supervisor object right unmarked unless a trustee of this object has the 
Supervisor right.

5. Choose OK.
You return to the Trustees of This Object dialog.

More about the Inherited Rights Filter



View or Change the Inherited Rights Filter of this Object
You need the Read and Write property rights to the Object Trustees (ACL) property of an object to 
change its Inherited Rights Filter (IRF).

1. To remove the IRF so that all rights can be inherited, select each of the Object Rights boxes and the 
All Properties circle in the Property Rights box.
You will notice that left of each of the Object Rights and Property Rights boxes is an arrow pointing 
down, which means that the right flows down. If there is a line underneath an arrow, you need to 
select the box to enable the right to flow down.

2. To change the Inherited Rights Filter for all properties of this container object that have no IRFs, 
select All Properties.
You can also set an IRF for a specific property.

3. To change the Inherited Rights Filter for certain properties only, select Selected Properties and then 
the individual property to modify.

4. Select the check box next to any object right or property right that you want to change.
 If the boxes are gray, no Inherited Rights Filter exists for this object or the selected set of property 

rights. All rights can be inherited by any trustee.
 If a box is white (not checked), that right is filtered and cannot be inherited by a trustee with a trustee 

assignment above this level.
 If a box is marked (X), that right is not filtered and can be inherited.

Note: You cannot leave the Supervisor object right unmarked unless a trustee of this object has the 
Supervisor right.

5. Choose OK.
You return to the Trustees of this Object dialog.

More about the Inherited Rights Filter



See Another Object's Effective Rights to this Object

For another object that is a trustee of this object
1. From the Trustees list, select one trustee.
2. Choose Effective Rights

The effective rights of the trustee are shown below the Object name field in the Object Rights and 
Property Rights areas. Effective rights are bold. Rights not available to the trustee are grayed.

3. (Optional) To see effective rights to specific properties, choose Selected Properties and select a 
property from the list.

4. Choose Close.
You return to the Trustees of this Object dialog.

For another object that is not a trustee of this object
1. Choose Effective Rights

2. Choose the Browser icon.
3. Select an object and choose OK.

Note: To see an object's effective rights to this object, you must be the manager of the object (have 
the Read right to this object's ACL property.)
The effective rights of the object you selected are shown below the Object Name field. Effective rights
are bold. Rights not available to the trustee are gray.

4. (Optional) To see effective rights to specific properties, choose Selected Properties and select a 
property from the list.

5. Choose Close.
You return to the Trustees of This Object dialog.

Note: If you make changes to the Trustees of This Object dialog, they will not be reflected in Effective 
Rights until you have exited the Trustees of this Object dialog with OK. When you return to the Trustees of
This Object dialog, any previous changes are reflected in Effective Rights.
More about Effective Rights



See another Object's Effective Rights to this Object

For another object that is a trustee of this object
1. From the Trustees list, select one trustee.
2. Choose Effective rights.

The effective rights of the trustee are shown below the Object name field in the Object Rights and 
Property Rights areas. Effective rights are bold. Rights not available to the trustee are gray.

3. (Optional) To see effective rights to specific properties, choose Selected Properties and select a 
property from the list.

4. Choose Close.
You return to the Trustees of this Object dialog.

For another object that is not a trustee of this object
1. Choose Effective rights.

2. Choose the Browser icon.
3. Select an object and choose OK.

Note: To see an object's effective rights to this object, you must be the manager of the object (have 
the Read right to this object's ACL property.)
The effective rights of the object you selected are shown below the Object Name field. Effective rights
are bold. Rights not available to the trustee are gray.

4. (Optional) To see effective rights to specific properties, choose Selected Properties and select a 
property from the list.

5. Choose Close.
You return to the Trustees of this Object dialog.

Note: If you make changes to the Trustees of this Object dialog, they will not be reflected in Effective 
Rights until you have exited the Trustees of this Object dialog with OK. When you return to the Trustees of
this Object dialog, any previous changes are reflected in Effective Rights.
More about Effective Rights



Change A Trustee's Object Rights to this Object
1. From the Trustees list, select a trustee.

Note: You can select multiple trustees by holding down the <Ctrl> or <Shift> key while making 
selections. Any rights that you change will affect all selected trustees.
Object Rights marked (X) are granted to the trustee.

2. Select the check box next to any object right that you want to change.
 If a box is gray, see possible reasons below.
 If a box is not checked, that right is not granted to the selected trustee.
 If a box is marked (X), that right is granted to the selected trustee.

Note: If a trustee is the only trustee of this object with the Supervisor object right and the Inherited Rights 
Filter blocks others from the Supervisor object right, the trustee cannot be deleted. This prevents cutting 
off supervisor-level access to part of the Directory tree.
3. To reset all object rights to undefined (not granted), choose Clear.

If you clear these rights, and no other rights are granted, the selected trustee is deleted from the list of
trustees.
Note: Although rights in the list are granted, they can be inherited if the Inherited Rights Filter does 
not block them.

4. Choose OK.
You return to the Browser.

If a check box is gray, one of the following conditions exists:
 No trustee is selected. Select a trustee from the list.
 Rights are undefined. No rights are granted.
 Two or more trustees with different rights have been selected. Select only one trustee, or change the 

check box to change that right for all selected trustees.



Change A Trustee's Object Rights to this Object
1. From the Trustees list, select a trustee.

Note: You can select multiple trustees by holding down the <Ctrl> or <Shift> keys while making 
selections; any rights that you change will affect all selected trustees.
Object Rights marked (X) are granted to the trustee.

2. Select the check box next to any object right that you want to change.
 If a box is gray, see possible reasons below.
 If a box is not checked, that right is not granted to the selected trustee.
 If a box is marked (X), that right is granted to the selected trustee.

Note: If a trustee is the only trustee of this object with the Supervisor object right and the Inherited Rights 
Filter blocks others from the Supervisor object right, the trustee cannot be deleted. This prevents cutting 
off supervisor-level access to part of the Directory tree.
3. To reset all object rights to undefined (not granted), choose Clear.

If you clear these rights, and no other rights are granted, the selected trustee is deleted from the list of
trustees.
Note: Although rights in the list are granted, they can be inherited if the Inherited Rights Filter does 
not block them.

4. Choose OK.
You return to the Browser.

If a check box is gray, one of the following conditions exists:
 No trustee is selected. Select a trustee from the list.
 Rights are undefined. No rights are granted.
 Two or more trustees with different rights have been selected. Select only one trustee, or change the 

check box to change that right for all selected trustees.



Change A Trustee's Property Rights to this Object
You can define property rights for a trustee in two ways:

 All Properties defines rights for this trustee that are the same for every property of this object. These 
rights control all properties unless rights are granted for a specific property as well.

 Specific     Properties   defines rights for this trustee for one property of an object. These rights, if assigned,
override the All Properties rights of the trustee for only that specific property. Specific property rights 
cannot be inherited.
Example: If user Joe has the Read and Compare Property rights to a Printer object (which are the default
rights that users are assigned to most objects), and if user Joe needs to be able to modify the printer 
configuration, the supervisor, or a user with supervisor rights, needs to grant User Joe the Read right and 
the Write right for the Printer Configuration property.

Property rights
Supervisor
Compare
Read
Write
Add (or Delete) Self



Change a Trustee's All Property Rights to this Object
1. From the Trustees list, select a trustee.

Note: You can select multiple trustees by holding down the <Ctrl> or <Shift> key while making 
selections while making selections.
Property Rights marked (X) denote rights that are granted to the trustee.

2. Choose All Properties.
The properties listed in the Selected Properties list box become gray.

 If a box is gray, see possible reasons below.
 If a box is not checked, that right is not granted to the selected trustee.
 If a box is marked (X), that right is granted to the selected trustee.

3. Select the check box next to any property right that you want to change.
The property rights you choose apply to every property of this object that does not have specific rights
defined.

4. To reset all Property rights to undefined, choose Clear.
Note: Although no rights in the list are granted, they can be inherited if the Inherited Rights Filter does
not block them.
If you clear these rights, and no other rights are granted, the selected trustee is deleted from the list of
trustees.

5. Choose OK.
You return to the Browser.

Note: In most cases, a trustee will be granted the Read right to all properties. This allows the trustee to 
see the values in all properties of an object. 

If a check box is gray, one of the following conditions exists:
 No trustee is selected. Select a trustee from the list.
 Rights are undefined. No rights are granted.
 Two or more trustees with different rights have been selected. Select only one trustee or change the 

check box to change that right for all selected trustees.



Change a Trustee's Selected Property Rights to this Object
1. From the Trustees list, select a trustee.

Note: You can select multiple trustees by holding down the <Ctrl> or <Shift> key while making 
selections.

2. Choose Selected Properties.
3. Select a property from the Properties box.

Note: You can select multiple properties by holding down the <Ctrl> or <Shift> key while making 
selections.
Properties in the list that have rights granted are checked; others are not checked.
The Property Rights box shows rights that are granted to the selected trustee for this property.

4. Select the check box next to a property right that you want to change.
 If a box is gray, see possible reasons below.
 If a box is not checked, that right is not granted to the selected trustee.
 If a box is marked (X), that right is granted to the selected trustee.

5. To reset selected property rights for the selected property to undefined, choose Clear.
Selected rights are not granted to the specific property that you have selected; the All Properties 
rights of this trustee apply to the selected property.
If you clear these rights and no other rights are granted, the selected trustee is deleted from the list of 
trustees.

6. Choose OK.
You return to the Browser.

Example: A user has Read rights to all properties of a Directory Map object that points to an application. 
The user needs to change the location of the application in the Directory Map, so the user is also granted 
the Supervisor property right to the Path property of the Directory Map.
If a check box is gray, one of the following conditions exists:

 No property is selected. Select a property from the list.
 Rights are undefined. No rights are granted.
 Two or more properties with different rights have been selected. Select only one property, or change 

the check box to change that right for all selected properties.



Trustees List box
Lists all trustees that have rights granted to this object.
Objects that are not listed in the Trustees list can still have effective rights to this object by

 Inheritance
 Being security equal to another object

You see what rights make up a trustee's assignment by selecting that trustee in the list.
Note: You can select multiple trustees by holding down the <Ctrl> or <Shift> key while making changes. 
Changes you make affect all selected trustees.
You can select the check boxes to change that trustee's rights.
If an object does not have a trustee with the Supervisor object right, it's Inherited Rights Filter cannot 
block the Supervisor object right.

More about Effective Rights
More about the Inherited Rights Filter

Example: Organizational Units SALES and RESEARCH are subordinate to Organization BOSTON. 
SALES is a trustee of BOSTON and has explicit Browse and Create object rights to BOSTON. Any user in
SALES inherits the right to create objects in BOSTON and in any container subordinate to BOSTON, 
including RESEARCH.
RESEARCH doesn't want anyone to create objects in their part of the Directory tree. RESEARCH adds 
an Inherited Rights Filter that includes only the Browse right. This means that no one (including SALES) 
can inherit the Create right in RESEARCH, but SALES still inherits the Browse right.
User ANDREW is a trustee of server CentralStation under RESEARCH and has the Supervisor right. This
trustee assignment bypasses the Inherited Rights Filter and gives ANDREW the Create right.



Add Trustee button
Adds a new trustee to the Trustees list for this object. You choose the new trustee is chosen from the 
Select Object dialog. You can give the trustee specific rights.
You can add as many trustees as you need. You must have at least the Read and Write property rights on
the object's Object Trustees (ACL) property to add trustees.
Define trustees as high as possible in the Directory tree. The fewer trustee assignments you use, the 
easier it is to determine where an object's inherited rights came from.
Example: users in the SEATTLE Organizational Unit need rights to a Profile. Rather than make each user
a trustee of the Profile, make SEATTLE a trustee of the Profile. Each user will have the same rights as 
SEATTLE. (If a user needs more rights to manage the Profile, that user can be listed as a separate 
trustee of the Profile.)

To Add a Trustee
1. Choose Add Trustee.

The Select Object dialog appears.
2. From the Select Object dialog's browser, select the objects you want to assign as trustees.
3. From the Select Object dialog, choose OK.

Any objects you selected are added to the object's Trustees list.
4. To accept the objects you selected as trustees, choose OK.

You're returned to the browser.



Delete Trustee Button
Deletes a trustee from the Trustees list. You must have at least the Read and Write property rights on the 
object's Object Trustees (ACL) property to delete its trustees.
Objects that are not listed in the Trustees list can still have effective rights to this object by

 Inheritance
 Being security equal to another object

You see what rights make up a trustee's assignment by selecting that trustee in the list.
Note: If a trustee is the only trustee of this object with the Supervisor object right and the Inherited Rights 
Filter blocks others from the Supervisor object right, the trustee cannot be deleted. This prevents cutting 
off supervisor-level access to part of the Directory tree.



Object Rights of a Container Object
Object rights determine what a trustee can do to an object. They affect the object as a whole in the 
Browser. But, with the exception of the Supervisor object right, they do not grant any rights to see or 
change the properties of the object. 
Any object granted the Supervisor object right assumes all property rights as well.
Example: With the Delete object right, a user can remove an object from the Directory database so that it 
no longer exists.

Object rights of container objects
Supervisor
Browse
Create
Delete
Rename



Object Rights of a Leaf Object
Object rights determine what a trustee can do to an object. They affect the object as a whole in the 
Browser. But, with the exception of the Supervisor object right,    they do not grant any rights to see or 
change the properties of the object.
Note: The Create object right is not used for leaf objects because you cannot create an object under a 
leaf object.
Example: With the Delete object right, a user can remove an object from the Directory database so that it 
no longer exists.

Object rights of leaf objects
Supervisor
Browse
Delete
Rename



Property rights
Property rights determine what a trustee can do with the properties of an object.
There are two ways to assign property rights:
All Properties defines rights for this trustee that are the same for every property of the selected object. 
These rights control all properties unless rights are granted for a selected property.
Selected Properties defines rights for this trustee for one property of an object. These rights, if assigned, 
override the All Properties rights of the object for only that selected property. Selected property rights 
cannot be inherited.
Example: A user has the Read right to all properties of a Directory Map object that points to an 
application. The user needs to change the location of the application in the Directory Map. Therefore the 
user is granted the Supervisor property right to the Path property of the Directory Map.

Property rights
Supervisor
Compare
Read
Write
Add (or Delete) Self



Trustees of this File or Directory
Important: If you are viewing the Trustees of the Root Directory page for a Volume object, you are seeing
the trustees of the top level of the file system for the selected volume. You can change directory rights 
here. To change object rights for the Volume object, choose Trustees of this Object from the Object menu.
The Trustees of this File and Trustees of this Directory pages list trustees of this file or directory and their 
rights. When you select a trustee from the list, that trustee's rights to this file or directory appear.
Note: The Trustees list does not list objects that are trustees of directories above this level that inherit 
rights to this file or directory. To check for those objects, choose Effective Rights.

 To close the Trustees of this File [Directory] dialog and save changes, choose OK.
 To close the Trustees of this File [Directory] dialog without saving changes, choose Cancel.

Procedures
Add a Trustee
Delete a Trustee
View or Change the File and Directory Rights of a Trustee
See the Effective Rights of a Trustee
View or Change the Inherited Rights Filter

Screen regions and buttons
Trustees lists all trustees for the file or directory.

Add Trustee allows you to add a new trustee.

Delete Trustee deletes the selected trustee.

Access rights allows you to see and change a trustee's access rights.

Effective rights shows the rights that any object can use to access this file or directory.

Inherited Rights Filter allows you to see and change the Inherited Rights Filter of this file or directory.

OK saves changes and closes the dialog.

Cancel closes the dialog without saving changes.

Related topic
Trustees of this Object and Rights to Other Objects



Trustees of this File or Directory
The Trustees of this File and Trustees of this Directory pages show trustees of the file or directory you 
selected. You can

 See who is a trustee of this file or directory
 Change a trustee's rights to this file or directory

Note: The Trustees list does not show users who are trustees of directories above this level and inherit 
rights to this file or directory. To check for those objects, choose Effective Rights.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
Using this Dialog
Add a Trustee
Delete a Trustee
View or Change the File and Directory Rights of a Trustee
See the Effective Rights of a Trustee
View or Change the Inherited Rights Filter

Screen regions and buttons
Trustees lists all trustees for the file or directory.

Add Trustee allows you to add a new trustee.

Delete Trustee deletes a trustee.

Access rights allows you to see and change a trustee's access rights.

Effective rights shows the rights that any object can use to access this file or directory.

Inherited Rights Filter allows you to view or change the Inherited Rights Filter of this file or directory.

OK saves changes and closes the dialog.

Cancel closes the dialog without saving changes.



Add a Trustee to a File or Directory
You must have the Access Control right to the file or directory to add a trustee.

1. Choose Add Trustee.
2. From the Select Object dialog, select the objects you want to add to the list of trustees for this file or 

directory.
You can select multiple trustees by holding down the <Ctrl> key while making selections.

3. Choose OK.
The objects that you selected are added to the Trustees list.

Note: To grant rights to the trustee to work with this file or directory, use the Access Rights check boxes 
below the Trustees list.



Delete a Trustee of a File or Directory
You must have the Access Control right to the file or directory to delete a trustee.

1. From the Trustees list, select the trustees you want to delete.
2. Choose Delete Trustee.
3. Choose Yes.
Note: The object that you deleted from the Trustees list only has    rights to this directory or file by 
inheriting them from a directory above this directory or file, or by being a member of a group that is a 
trustee of this directory or file.



View or Change the Inherited Rights Filter of a File or Directory
1. Select the check box next to each access right that you want to change in the Inheritance Filter list.

 If the boxes are grayed, no Inherited Rights Filter exists for this file or directory. All rights can be 
inherited.

 If a box is not marked, that right cannot be inherited. An arrow with a line beneath it appears to the left 
of the checkbox to indicate that this right does not flow down.

 If a box is marked (X), that right can be inherited. An arrow appears to the left of the checkbox to 
indicate that this right flows down.
2. Choose OK.

You return to the Browser.
Related topic

More about the Inherited Rights Filter



View or Change a Trustee's File or Directory Rights
1. From the Trustees list, select a trustee.

Note: You can select multiple trustees by holding down the <Ctrl> or <Shift> key while making 
selections.
Access rights marked (X) have been granted to the trustee.

2. Select the box next to any access right that you want to change.
3. Choose OK.

If any check boxes are gray, one of the following conditions exists:
 No trustee is selected. Select a trustee from the list.
 Rights are undefined. No rights are granted.
 Two or more trustees with different rights have been selected. Select only one trustee, or change the 

check box to change that right for all selected trustees.



See an Object's Effective Rights to This File or Directory
You can see an object's effective rights to this file or directory only if:

 You have the Access Control right on the file or directory
 The file or directory is on a volume that uses NetWare 4

For an object that is a trustee of this directory or file
1. From the Trustees list, select a trustee.
2. Choose Effective Rights.
3. The effective rights of the trustee that you selected are shown below the Trustees list.

Effective rights are bold. Rights not available to the trustee are gray.
4. Choose Close.

You return to the Trustees of this File [Directory] dialog.

Note: If you make changes to the Trustees of this File [Directory] dialog, they will not be effective until you
return to the Browser. When you return to the Trustees of this File [Directory] dialog, any previous 
changes are reflected in Effective Rights.

For an object that is not a trustee of this directory or file
1. Choose Effective Rights.
2. Choose the Browser icon. 
3. Select an object.

Note: To see a user's effective rights, you must have at least the Write property right to that user's 
Object Trustees (ACL) property.
The effective rights of the object that you selected are shown below the Trustees list.
Effective rights are bold. Rights not available to the trustee are gray.

4. Choose Close.
You return to the Trustees of this File [Directory] dialog.

Related topic
More about Effective Rights



Trustees List Box for Files and Directories
Lists all objects that have rights granted to this file or directory.
Objects that are not on the Trustees list can still have effective rights to this file or directory by:

 Inheritance
 Equivalence to another object (such as a Group) that is a trustee
 Membership in a group that is a trustee

Related topic
More about the Inherited Rights Filter
More about Effective Rights



Add Trustee Button
You must have the Access Control right to a file or directory to add trustees.
Adds a new trustee to the Trustees list for this file or directory. The new trustee is given specific rights that
override the Inherited Rights Filter.
You can add as many trustees as you need. 
Note: Define trustees as close to the root directory as possible. The fewer trustee assignments you use, 
the easier it is to determine where someone's inherited rights come from.
Example: users in the SEATTLE Organizational Unit need rights to the REPORTS directory. Rather than 
make each user a trustee of REPORTS, make SEATTLE a trustee of it. Each user will have the same 
rights as SEATTLE. (If a user needs more rights to work in REPORTS, that user can be listed as a 
separate trustee of the directory.)
To grant a set of rights to a group of users who don't share a common container, create a Group object 
and give it a trustee assignment. The users assigned to the Group object are security equivalent to (have 
the same rights as) the Group object.



Delete a File or Directory Trustee Button
You must have the Access Control right to a file or directory to delete its trustees.
Deletes a trustee from the Trustees list.
This object can still have rights to an object that does not appear in the Assigned Object list by

 Inheriting them from objects higher in the Directory tree
 Security equivalence (for User objects only)
 Membership in a group that is a trustee of this object

Note: To determine if you have Access Control rights, select the file or directory and choose Details from 
the Object menu. Choose Trustees of this File and then Effective Rights. Select your user object to see 
your effective rights to the file or directory.



File and Directory Rights
File and Directory rights determine what a trustee can do with a file or directory. Each right can be 
assigned separately to each trustee.

Supervisor
Read
Write
Create
Erase
Modify
File Scan
Access Control



Rights to Other Objects
The Rights to Other Objects dialog shows

 Objects that this object is a trustee of
 Rights this object has to those objects

When you select an object from the Assigned Objects list, the rights included in the trustee assignment to 
that object appear below the list box.
Note: The Assigned Objects list only lists objects for which an explicit trustee assignment exists for the 
object you selected. It does not list all objects that the object inherits rights to. To see all of this object's 
rights to other objects, choose Effective Rights.

 To close the Rights to Other Objects dialog and save changes, choose OK.
 To close the Rights to Other Objects dialog without saving changes, choose Cancel.

Procedures
Add a Trustee Assignment
Delete a Trustee Assignment
See the Effective Rights to Any Object
Change the Object Rights to an Object
Change the Property Rights to an Object

Screen regions and buttons
Assigned Objects lists all objects that this object has a trustee assignment to.

Effective rights are the actual rights that this object has to any object. You can also use this button to 
view the effective rights of other objects on the current object.

Add Assignment grants this object a new trustee assignment to another object.

Delete Assignment deletes a trustee assignment to another object from the Assigned Objects list.

Object Rights let you see and change the object rights to the object selected in the Assigned Objects 
list.

Property Rights let you see and change the property rights to the object selected in the Assigned 
Objects list.

Clear resets all rights in the list to undefined (gray) for the selected object. Checked boxes show 
rights that are granted; Unchecked boxes show rights that are not granted.

OK saves changes and closes the dialog.

Cancel closes the dialog without saving changes.

Related Topics
Trustees of this Object and Rights to Other Objects

Trustees of the [Root] Object in the Directory Tree



Set the Search Context for the Rights to Other Objects Dialog
Use this Search Context dialog to limit the part of the Directory tree for which this object's trustee 
assignments are shown.
Every object under the container that you select is searched to find this object's rights to other objects 
(trustee assignments). The smaller the section of the Directory tree you select, the quicker the dialog will 
appear.
If you select Search Entire Subtree, this object's trustee assignments will be shown for all objects in the 
Directory tree which you have rights to browse.



Add a Trustee Assignment
You must have at least the Write property right to the Object Trustees (ACL) property of the object 
that you want to add to the Assigned Objects list.

1. Choose Add Assignment..
2. Select which objects you want to grant trustee assignments.

Example: To allow User JOHN to use a Profile during login, view the Rights to Other Objects for User
JOHN, and add Profile to the Assigned Objects list. Then grant the Browse object right and Read All 
Properties right. JOHN can now use the Profile.

3. Choose OK.
The objects that you selected are added to the Assigned Objects list.
To grant rights to the newly assigned object, select the check boxes below the Assigned Objects list.



Delete a Trustee Assignment
You need the Write property right to the Object Trustees (ACL) property of the object that you want to 
remove from the Assigned Objects list. (If the icon next to the object has an X through it and the name is 
grayed, you do not have rights to delete the assignment.)
1. From the Assigned Objects list, select the object that you want to delete.
2. Choose Delete assignment.
3. Choose Yes.

Any trustee assignments that this object had on the object that you deleted from the Assigned Objects
list are deleted. However, this object may still have rights to the object you deleted from the Assigned 
Objects list by inheriting rights from other objects.

For example, if this object is a member of a group that has a trustee assignment to the object you deleted 
from the Assigned Objects list, this object inherits those group rights.

You must not delete a trustee assignment to an object if
 It is the only trustee of this object with Supervisor object right
 The object's Inherited Rights Filter blocks the Supervisor object right

You should first grant another trustee the Supervisor object right, or make sure the Inherited Rights Filter 
doesn't block the Supervisor object right. This attempts to prevent you from cutting off Supervisor-level 
access to part of the Directory tree.



See this Object's Effective Rights to another Object

To an object that is listed in the Assigned Objects list box
1. Select one object from the Assigned Objects list.
2. Choose Effective rights.

This object's effective rights to the object you selected appear below the Object Name field.
Effective rights are bold. Rights not available to this object are gray.
Choose a property from the Properties list to see effective rights to specific properties.

3. Choose Close.
You return to the Rights to Other Objects dialog.

To an object that is not listed in the Assigned Objects list box
1. Choose Effective rights.
2. Choose the Browser icon.
3. Select an object.
4. Choose OK.

This object's effective rights to the object you selected appear below the Object Name field.
Effective rights are bold. Rights not available to this object are gray.
Choose a property from the Properties list to see effective rights to specific properties.

5. Choose Close.
You return to the Rights to Other Objects dialog.

Note: If you make changes to the Rights to Other Objects dialog, they are not reflected in Effective Rights
until you have exited the Rights to Other Objects dialog with OK. When you return to the Rights to Other 
Objects dialog, any previous changes are reflected in Effective Rights.

More about Effective Rights



Change this Object's Rights to an Object
1. From the Assigned Objects list, select an object.

Note: You can select multiple objects by holding down the <Ctrl> or <Shift> key while making 
selections. If an object is gray, you do not have rights to change its trustee assignment.
Object Rights marked (X) are granted to the objects.

2. Select the check box next to any object right that you want to change.
Note: If a trustee is the only trustee of this object with the Supervisor object right and the Inherited Rights 
Filter blocks others from the Supervisor object right, you should not remove its assignment. This prevents 
cutting off supervisor-level access to part of the Directory tree.
3. To reset all object rights to undefined, choose Clear.

If you clear these rights, and no other rights are granted, the selected trustee's icon is marked with an
X and the object is no longer considered a trustee.
Note: Although no rights in the list are granted, they can be inherited if the Inherited Rights Filter of 
the object does not block them.

4. Choose OK.
You return to the Browser.

If any check boxes are gray, one of the following conditions exists:
 No object is selected. Select an object from the list
 Rights are undefined. These rights are not granted to this object
 Two or more objects have been selected, and this object has different rights to each. Select only one 

object.



Change this Object's Property Rights to an Object
You can define property rights to an object in two ways:
All Properties defines rights to the assigned object that are the same for every property of the object. 
These rights control all properties unless rights are granted for a specific property as well.
Selected     Properties   defines rights to the assigned object for one property of an object. These rights, if 
granted, override the All Properties rights to the object for only that specific property.
Example: All the properties of a Printer object are Read only, but this object needs to update the 
Cartridges property. To allow this object to update the Cartridges property, select Selected Properties; 
then grant the Write right for the Cartridge property.

Property Rights
Supervisor
Compare
Read
Write
Add (or Delete) Self



Change All Property Rights to an Object
1. From the Assigned Objects list, select an object.

Note: You can select multiple objects by holding down the <Ctrl> or <Shift> key while making 
selections while making selections.
Property Rights marked (X) are rights that the object selected in the Browser is granted to the object 
in the Assigned objects list.

2. Choose All Properties.
The properties listed in the Properties list box are gray. The rights you choose apply to all properties 
that do not have specific rights defined (see Change Specific Property Rights).

3. Select the check box next to any property right that you want to change.
These rights apply to every property of this object that does not have specific rights defined.

4. To reset All Property rights to undefined, choose Clear.
Rights can still be inherited if the Inherited Rights Filter of the object does not block them.
If you clear these rights, and no other rights are granted, the selected trustee is deleted from the list of
trustees.

5. Choose OK.
You return to the Browser.

Note: In most cases, this object will have the All Property Read right to the assigned object. This allows 
this object to see the values in all properties of the assigned object.

If any check boxes are gray, one of the following conditions exists:
 No assigned object is selected. Select an object from the list.
 Rights are undefined. No rights are granted.
 Two or more objects have been selected, and this object has different rights granted for each. Select 

only one object or change the check box to change that right for the trustee assignment to all selected 
objects.



Change Selected Property Rights to an Object
1. From the Assigned Object list, select an object.

Note: You can select multiple objects by holding down the <Ctrl> or <Shift> key while making 
selections.

2. Choose Selected Properties.
3. From the Properties list, select a property.

Note: You can select multiple properties by holding down the <Ctrl> or <Shift> key while making 
selections.
The list box shows all possible properties. Properties in the list that have rights granted are checked; 
others are unchecked. If you select a property that is not a part of the assigned object, the rights 
shown have no meaning.
The Property Rights box shows rights granted to the assigned object for this property.

4. Select the check box next to any property right that you want to change.
5. To reset selected property rights for the selected property to undefined, choose Clear.

Rights will not be granted to the selected property. All property rights to the assigned object will apply 
to the selected property.
If you clear these rights, and no other rights are granted, the selected trustee is deleted from the list of
trustees.

6. Choose OK.
You return to the Browser.

Example: A user has Read rights to all properties of a Directory Map object that points to an application. 
The user needs to change the location of the application in the Directory Map, and is granted the 
Supervisor property right to the Path property of the Directory Map.

If any check boxes are gray, one of the following conditions exists:
 No property is selected. Select a property from the list.
 Rights are undefined. No rights are granted.
 Two or more properties with different rights have been selected. Select only one property or change the

check box to change that right for all selected properties.



Assigned Objects List Box
Lists all objects that this object has a trustee assignment to. If an object is gray, this object does not have 
rights to change the trustee assignment.
This object can still have effective rights to objects that are not listed in the Assigned Objects list. These 
rights come from

 Inheritance
 Equivalence to another object that is a trustee of this object
 Membership in a Group that is a trustee of this object

To see what rights make up this object's trustee assignment to the assigned object, select that object in 
the list. You can change the check boxes to change the rights to that object.
More about Effective Rights
More about The Inherited Rights Filter



Add Assignment Button
Grants a new trustee assignment to an object and adds that object to the Assigned Objects list.
You must have at least the Write property right to the Object Trustees (ACL) property of any object that 
you want to add to the Assigned Objects list. You can add as many trustee assignments as you need.
Define trustee assignments as high as possible in the Directory tree. The fewer trustee assignments you 
use, the easier it is to determine where an object's inherited rights come from.
Example: Users in the SEATTLE Organizational Unit need rights to the printer. Rather than make each 
user a trustee of the printer, make SEATTLE a trustee of the printer. Each user now has the same rights 
as SEATTLE. If a user needs more rights to manage the printer, that user can be listed as a separate 
trustee of the printer.
To grant a set of rights to a group of users who don't share a common container, create a Group object 
and give it a trustee assignment. The users assigned to the Group object are security equivalent to (have 
the same rights as) the Group object.



Delete Assignment Button
Deletes an object from the Assigned Objects list. You must have at least the Write property right to the 
Object Trustees (ACL) property of any object that you want to remove from the Assigned Objects list. (If 
the icon next to the object has an X through it and the name of the object is grayed, you do not have 
rights to delete this object.)
You should not delete a trustee from the list if

 It is the only trustee of this object with Supervisor object right
 The object's Inherited Rights Filter blocks the Supervisor object right

You must first grant another trustee the Supervisor object right, or make sure the Inherited Rights Filter 
doesn't block the Supervisor object right. This attempts to prevent you from cutting off Supervisor-level 
access to part of the Directory tree.
This object can still have rights to an object that does not appear in the Assigned Object list by

 Inheriting them from objects higher in the Directory tree
 Security equivalence (for User objects only)
 Membership in a group that is a trustee of this object



Object Rights to an Object in the Assigned Objects List
Object rights determine what a trustee can do to an object. They do not grant any rights to see or change 
the properties of the object.
When you select an object in the Assigned Objects list, this object's rights to the object that you selected 
are shown as checked in the list of object rights.
Example: With the Delete object right, a user can remove an object from the Directory tree so that it no 
longer exists.

Object rights to container objects
Browse
Create
Delete
Rename
Supervisor

Object rights to leaf objects
Browse
Delete
Rename
Supervisor



Property Rights to an Object
Property rights determine what a trustee can do with the properties of an object.
Example: With the Write right for all properties, a user can add or change the values of any property.
When you select an object in the Assigned Objects list, this object's property rights are shown as checked
in the list of property rights.
There are two ways to assign property rights
All Properties defines rights for this object to the assigned object that are the same for every property of 
the object. These rights control all properties unless rights are granted for a specific property as well.
Selected Properties defines this object's rights to the assigned object for one property of the object. These
rights, if assigned, override the all property rights to the object for only that specific property.
Example: A user has the Read right to all properties of a Directory Map object that points to an 
application. The user needs to change the location of the application in the Directory Map, and is granted 
the Supervisor property right to the Path property of the Directory Map.

Property rights
Supervisor
Compare
Read
Write
Add (or Delete) Self



Manage a Bindery Object
This object was created in the Directory tree by an upgrade or migration utility. It can't be converted to a 
standard NetWare Directory Services object.
You can delete this object from the Directory tree.
You can't view or change information about this object. To manage this object, refer to the utility that 
created it.
If this object was upgraded from a previous version of NetWare, you may be able to manage this object 
using utilities from that version of NetWare if you set the bindery services context to include this object.



View or Change a User Object 
The Identification page describes this User object. On this page, you can store information such as

 Additional names for this User object
 Where the User object is located

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Enter a Title for This User
Enter a Fax or Telephone Number for This User
Enter a Description of This User

Screen regions and buttons
Login Name shows the name the user enters to log in to the network.

 opens a dialog where you can enter more values for a field.
Given Name shows the user's first name. For example, for John Jacob's given name is John.
Last Name shows the user's last name.
Full Name displays or allows you to enter the user's full name.
Generational Qualifier is like Jr., Sr., II, III., etc. For example, Billy Bob Jr, or James Earl III.
Middle Initial shows the user's middle initial, if one exists.
Other name lists other identification information for    this user. (Maximum length of each is 60 characters.)
Title shows the position or function of the user. (Maximum length of each is 60 characters.)
Description describes the function of this user performs. (Up to 30 lines of 37 characters each can be 
entered.)

Location shows the user's physical location (such as a mail stop).

Department shows the user's department or division.

Telephone lists the user's telephone numbers.

Fax Number lists the telephone numbers of fax machines available to the user.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Using Other Names for a User
The Other Name field can contain identification information that helps you search for and identify specific 
users.
Example: You frequently need to search for employees who have been hired after a certain date. To 
facilitate the search, include the employee's date of hire in the Other Name field.



View or Change Security Equivalences
The Security Equal To page shows objects that this User object is security equal to. This means that any 
rights granted to the objects listed on this page are also granted to this User object. On this page, you can

 See which objects this User object is security equal to
 Add or delete objects from the list of security equal objects

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add an Object to the List of Security Equals
Delete an Object from the List of Security Equals
See which Objects This User is Security Equivalent to That Are Not Listed

Screen regions and buttons
Security Equals shows all objects that this User object is security equal to.

Add lets you add the selected object to the list of security equal objects.

Delete lets you delete the selected object from the list of security equals objects.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add an Object to the List of Security Equals To
Rights needed: Write or Supervisor right to the Security Equals property of a User object (even your own)
Add an object to the Security Equal To list to

 Grant that object effective rights to other objects in the list
 Gain temporary access to another user's file

To Add an Object to The Security Equal To List
1. From the Security Equals page, choose Add.
2. Select each object that you want this user to be security equal to.
3. Choose OK.
Any object you selected is added to this user's Security Equal To list and all effective rights for every 
object in the Security Equal To list are added to the effective rights of this User object.
Some objects are automatically placed in this list because of other actions that you perform.
Example: When you add a user to the membership list of a Group object, the name of that Group is 
automatically placed in the Security Equal To list of that user.



Delete an Object from the Security Equal To List
1. From the Security Equal To list, select an object.
2. Choose Delete.

The object is deleted from the list of security equal objects.
Note: This user no longer automatically has the same effective rights as the object that was deleted. The 
user might still have the same rights, but they must come from the user's own trustee assignments or 
from a security equivalent object that was not deleted.
Note: Every object is security equal to all of the objects in its complete name (that is, all of the objects 
directly above it to the root of the Directory tree). However, none of these objects appear in the Security 
Equal To list of the object. These security equals cannot be changed.



See Which Objects This User Is Security Equal to That Are Not Listed
Every object is security equal to all the objects in its complete name (that is, all of the objects directly 
above it to the root of the Directory tree). For example, user JIM in WRITERS.PUBLICATIONS.ACME is 
security equal to all three of the containers above him. This means that if the container WRITERS has the
supervisor object right to SALES, so does Jim.
However, these objects are not listed in the Security Equal To list.
To see a User object's complete name, complete the following steps
1. From the Security Equals page, choose Add.
2. From the Select Object dialog box, select the User object.

The context of the User object appears at the top of the Select Object dialog. The User object is 
security equal to every Container object listed.



Security Equal To list
This lists objects that this User object is security equal to.
Every object is security equal to all the objects in its complete name (that is, all of the objects directly 
above it to the root of the Directory tree). For example, user JIM in WRITERS.PUBLICATIONS.ACME is 
security equal to all three of the containers above him. This means that if the container WRITERS has the
supervisor object right to SALES, so does Jim.
The Security Equal To list can contain objects of different types. A User object might be security equal to 

 A Group object as part of a group 
 A server for access to a certain print queue
 Another User object

Some objects are added to the Security Equal To list automatically when you perform other actions.
Example: When you add a User object to the membership list of a Group object, the name of that Group 
object is automatically put in the Security Equal To list of that User object.



Set a User's Network Address Restrictions
The Network Address Restrictions page determines which workstations a user can log in from. On this 
page, you can

 Specify addresses the user can log in from
 Add or delete addresses from the list

If no addresses are listed, there are no restrictions and the user can log in from any workstation.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Network Address
Delete a Network Address

Screen regions and buttons
Network Protocol lists the protocol you selected for the new address. Complete the fields with values 

appropriate for the protocol you use.

Add lets you add another network address to the list. If you leave the protocol fields filled with F's or 
255's, this user can log in from any address using that protocol.

Delete removes the network address from the list.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Set Login Restrictions
The Login Restrictions page allows you to restrict how this user can use the network. On this page, you 
can

 Disable this user's account
 Set a date for this user's account to expire
 Limit the number of workstations that the user can log in from simultaneously

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Disable This User's Account
Set an Expiration Date for This User's Account
See when This User Last Logged In
Limit This User's Concurrent Connections (Logins)

Screen regions and buttons
Account Disabled prevents the user from logging in.

Account Has Expiration Date allows you to set an expiration date for this account.

Expiration Date and Time sets the date and time this user's account expires.

Limit Concurrent Connections allows you to limit the number of workstations that the user can log in 
from simultaneously.

Maximum Connections defines the maximum number of workstations that this user can log in to 
simultaneously.

Last Login shows the date and time the user last logged in.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Disable this User's Account
Select the Account Disabled check box.
This user cannot log in until the check box has been cleared.
Note: Other conditions can cause the user's account to be disabled, such as when the account expires, 
when an intruder is detected, or when the user's account balance drops below the allowable credit limit.



Set an Expiration Date for this User's Account
1. Select the Account Has Expiration Date check box.

You can't modify the other fields until you select this check box.
2. Use the arrows next to the date and time sections of the Expiration Date and Time fields to set the 

date and time that this user's account expires.
At this date and time, the user is logged out, and the account is locked. The user can't log in again 
until a network administrator unlocks the account and resets the expiration date.

To remove the expiration date from a user's account, select the Account Has Expiration check box.



Limit This User's Concurrent Connections (Logins)
1. Select the Limit Concurrent Connections check box.

The Maximum Connections field can not be modified until you select this check box.
2. In the Maximum Connections field, enter the maximum number of workstations that you want this 

user to be able to log in from at the same time.
3. Choose OK.

The information is not saved to NetWare Directory Services until you choose OK.

To allow unlimited concurrent connections to this user, select the Limit Concurrent Connections check box
and choose OK.



See When This User Last Logged In
To see when this user last logged, look at the Last Login field. 
This field cannot be modified; it is for information only.



Set Password Restrictions
The Password Restrictions page controls how passwords for this user are handled. On this page, you can
specify 

 Whether the user can change his or her own password
 How many grace logins are allowed after the user's password expires

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Change This User's Password
Require a Password for This User
Limit This User's Grace Logins
Set a Minimum Password Length
Force Periodic Password Changes

Screen regions and buttons
Allow User to Change Password lets this user change his or her own password.

Require a Password requires a user to enter a password.

Minimum Password Length specifies the minimum number of characters required for the password.

Force Periodic Password Changes requires that passwords be changed at regular intervals.

Days Between Forced Changes specifies the number of days a password can be used.

Date Password Expires displays the password expiration.

Require Unique Passwords prevents the user from using the same password again.

Limit Grace Logins allows you to limit the number of times an expired password can be used.

Grace Logins Allowed specifies the number of times an expired password can be used.

Remaining Grace Logins shows how many grace logins are left.

Change Password changes this user's password. If the Login Disabled box on the Login Restrictions 
page is activated, the user's account is disabled and the Change Password button is disabled.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Change a Password
Note: If the Login Disabled field on the Login Restrictions page is activated, the user's account is disabled
and the Change Password button is disabled.
Make sure a password exists for objects like User objects and Print Server objects. Security could be 
compromised if someone gains unauthorized access as a User or Print Server object and takes 
advantage of their security equivalences.
The following are suggestions for passwords that improve network security:

 Don't use common dictionary words
 Don't use the names of family members or pets
 Don't use birthdays
 Use combinations of words
 Combine alpha and numeric characters in the password

To change a password
1. In the Old Password field, type the old password.
2. In the New Password field, type the new password.

The password is not case sensitive.
3. In the Retype New Password field, type the new password again.
Screen regions and buttons

Old Password is where you enter the current password.

New Password is where you enter the new password.

Retype New Password is where you enter the new password a second time.

OK changes the password.

Cancel closes this dialog without changing the password.



Require a Password for this User
Select the Require a Password check box.
All of the password restriction options below the check box turn from gray to black. A password must now 
be entered by this user when logging in.



Set this User's Grace Logins
The Require a Password and Force Periodic Password Changes check boxes must be selected to 
perform this task.
1. Select the Limit Grace Logins check box.
2. In the Grace Logins Allowed field, enter the number of grace logins.

Use a number from zero to 50.

One grace login is used each time that the user logs in using a password that has expired without 
entering a new password.
The user's account is locked if all grace logins are used without changing the expired password.
The number of unused grace logins is shown in the Remaining Grace Logins field.
You cannot change this field.



Set a Minimum Password Length for This User
The Require a Password check box must be selected to perform this task.
1. In the Minimum Password Length field, enter a value.

You can enter values from 0 to 999 in the Minimum Password Length field. If you enter a value above 
11, users cannot log in from Macintosh workstations.
To improve network security, set minimum password length to no less than 5.

2. Choose OK.



Force Periodic Password Changes for this User
The Require a Password check box must be selected to perform this task.
1. Select the Force Periodic Password Changes check box.
2. In the Days Between Forced Changes field, enter the number of days that each new password should

last.
After this many days, a new password must be entered or the account is disabled after grace logins 
are used.
If you have previously selected the Force Periodic Password Changes check box, the Expiration Date
and Time field shows when the current password must be changed.

3. (Optional) If you want to require that the new password be unique, select the Require Unique 
Password check box. 
This user's previous passwords are saved and cannot be used again. This can improve network 
security.



Set a User's Login Time Restrictions
The Login Time Restrictions page allows you to limit the times when this user can be logged in.
You can restrict a user's login time in half-hour segments.

 White cells indicate times that this user can be logged in. 
 Dark cells indicate times that this user can't be logged in. 

The default is no restrictions (all white cells).
Important: If users are logged in and reach a restricted time, the system will give them a five-minute 
warning that they need to log out. If users are still logged in after five minutes, the system will log them 
out, and any unsaved information will be lost.

Note: NetWare Directory Services (NDS) uses a time standard based on Greenich Mean Time (GMT) 
which adjusts for time zone differences. However, login restrictions do not account for time zone 
differences.
Example 1: If login time restrictions are set in California while on Pacific daylight time, they will be off by 
one hour when California moves back to Pacific standard time. For example, if you originally denied users
network access from 5 a.m. to 8 a.m., they can log in when they arrive for work at 8 a.m. When California 
returns to Pacific standard time, NetWare server time is adjusted back one hour, but login time restrictions
are not adjusted. This means that users will not be able to log in until 9 a.m., even though the Login Time 
Restrictions screen is set to allow users to log in at 8 a.m.
Suggestion: To compensate for time differences within a time zone, set login time restrictions with a 
buffer of one hour before and after normal login time restrictions. The problem in the example above 
could be solved by setting the login time restrictions from 7 a.m. to 6 p.m.

Example 2: If you originally denied network access to Jean in Toronto (Canada) from 5 a.m. to 8 a.m., 
and Jean travels to London (UK), her login time restrictions will be off by five hours. While Jean could be 
logged in to the network from 8 a.m. to 5 p.m. in Toronto, her authorized access time in London will be 3 
a.m. to noon.
Suggestion: For NetWare users who travel, avoid using login time restrictions.

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Restrict Login Times Using a Mouse
Restrict Login Times Using the Keyboard

Screen regions and buttons
Login Time Restrictions shows the times the user can log in.

Reset resets the grid to the default (no login restrictions).

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Restrict Login Times Using a Mouse
1. Move the mouse pointer to the cell that represents the beginning of the time period you want to 

restrict.
The day and time that the pointer is on is displayed above the Reset button.

2. Click the left mouse button and drag the pointer to select the times you want to restrict.
You can select rectangular regions only. You may need to repeat these steps several times to select 
the times that you want to restrict.
Dark cells represent times this user can't log in. If you select an area that is already restricted, it 
becomes unrestricted.

3. Release the mouse button.



Restrict Login Times Using the Keyboard
1. Hold down the <Shift> key and press <Tab> until the cursor appears in the grid.
2. Use the arrow keys to move the cursor to the cell that represents the beginning of the time period that

you want to restrict.
3. While holding down the <Shift> key, use the arrow keys to select the times that you want to restrict.

You can select rectangular regions only. You may need to repeat these steps several times to select 
the times that you want to restrict.
Dark cells represent the times the user can't log in. If you select an area that is already restricted, it 
becomes unrestricted.

4. Release the <Shift> key.



Create or Change a User's Login Script
The Login Script page lists commands that are executed when this user logs in to the network. For 
example, you can set commands to

 Map drives
 Assign printers to this user

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Copy a Login Script from another Location
Edit the Login Script
Select a Profile Object for This User

Screen regions and buttons
Edit holds login script commands.

Profile accepts the complete name of a Profile object. The login script in this Profile object is executed
before this user's login script.

 lets you select a Profile object.
OK saves changes in all pages of this dialog.
Cancel closes this dialog without saving changes in any page.
Related topics

Login Script Commands



Select a Profile Script to be Used by This User
Each User object can list one Profile object with its login script. 
If a Profile object is listed, the login script in the Profile object is executed before the user's login script. 
This allows several users to share common login commands that are not included in the container system
login script.

To select a Profile object for this User:
1. In a user's object dialog, select the Login Script page.
2. Select the browser icon to the right of the Profile field below the user's login script commands.

The Select Object dialog appears.
3. Select the Profile object whose script you want to be executed when this user logs in.

The Profile object can be anywhere in the Directory tree.
4. Choose OK.

The Profile object is listed in the Profile field of the user's Login Script page.
Only one Profile can be specified for each user.



Copy a Login Script from Another Location
This procedure allows you to use commands entered in another login script, or in an MS Windows text 
editor, in this login script without typing them again.

1. While editing any login script with NetWare Administrator, or any MS Windows text editor, such as 
Notepad, use the mouse or hold down the <Shift> key and use the arrow keys to select the area of 
text that you want to copy into this login script.

2. When the text you want is selected, hold down the <Ctrl> key and press the <Insert> key.
3. Return to the Login Script page where you want to insert the commands that you selected in Step 1.
4. Place the cursor within the login script where you want the commands inserted.
5. Hold down the <Shift> key and press the <Insert> key.

The text that you selected is copied into the login script.
6. Make any other changes to the commands, as if you had typed them in at this point.
7. Choose OK.

The login script is saved to NetWare Directory Services when you choose OK.



Edit a Login Script
1. Place the cursor in the login script at the point where you want to make changes to the login script 

commands.
2. Use the arrow keys, the <Delete> key, and the <Insert> key to move and erase text.
3. Type new text wherever it is needed. 

Existing text will move to make room for it.
4. Choose OK.

Changes are saved to NetWare Directory Services when you choose OK.



View or Reset Intruder Lockout
The Intruder Lockout page displays the status of a user's account after it has been locked.
Note: An account is locked when someone enters the wrong password too many times consecutively. 
(The limit for incorrect login attempts is set from the Intruder Detection page of the user's container 
object.)
This page shows

 The number of incorrect login attempts
 When a user's account was locked
 The network address of the workstation used when a person exceeded the allowed login attempts

If a user can't log in, check the information on this page. If the Account Locked field isn't checked, the 
login problem is caused by something else.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Unlock This User's Account
View When and Why This User's Account was Locked

Screen regions and buttons
Account Locked indicates whether the account is locked because an incorrect password was used 

too many times.

Incorrect Login Count shows the number of incorrect passwords entered.

Account Reset Time shows the time when the account will be reactivated if this account is locked. If it 
is not locked, this field shows when the Incorrect Login Count is reset.

Last Intruder Address shows the network address of the workstation from which the last wrong 
password was entered.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Unlock this User's Account
To unlock the user's account, select the Account Locked check box. 
The user can now log in normally.
Note: The account lock resets automatically after the time specified in the Intruder Lockout Reset Interval,
which you can set in the object dialog for the container above this object.



View When and Why This User's Account Was Locked
1. See the Incorrect Login Count field.

This is the number of times that someone entered the wrong password for this user before being 
locked out.

2. See the Account Reset Time field.
This is the time of day when the account is unlocked. It is calculated from the Intruder Lockout Reset 
Interval that you set for the container of this object.

3. See the Last Intruder Address field.
This is the network node address of the workstation that the person who last entered the incorrect 
passwords when trying to log in as this user.



List the Group Memberships of a User
The Group Membership page shows the groups that this user is a member of.
You can change the groups a user is a member of in the

 Group Membership page of the User object dialog
 Members page of the Group object dialog

Changes to Group memberships that you make in either dialog appear automatically in both dialogs. 
You need appropriate property rights in both dialogs to view or change Group memberships.

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Add this User as a Member of a Group
Delete this User as a Member of a Group

Screen regions and buttons
Memberships shows the groups that this user is a member of.

Add lets you select a Group object that you want this user to be a member of.

Delete removes this user from the Groups listed in the Memberships list box.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add This User as a Member of a Group
Right needed: The Supervisor object right to the Group object

1. Choose Add.
2. Select the Group object that you want to make this user a member of.
3. Choose OK.

The Group object is added to the list of groups that this user is a member of. This user has the same 
rights that are assigned to the Group object.
Note: The Group object is automatically listed in the Security Equal To list of each User object that 
you add to the membership list.



Delete This User as a Member of a Group
1. From the Memberships list, select a Group object.
2. Choose Delete.

The Group object is deleted from the list of groups that this user belongs to.
Note: When you delete a Group object from the Group Memberships list of a user, the Group object is
automatically removed from the Security Equal To list of the user.



Set a User's Account Balance
Use the Account Balance page to manage the credit on a user's account. On this page, you can

 See how much credit this user has
 Allow unlimited credit for this user

To install or remove accounting, or to change the rate charged for particular services, go to the NetWare 
Server object dialog and choose Accounting.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Set This User's Account Balance
Set a Lower Limit on This User's Credit Balance

Screen regions and buttons
Account Balance shows the credit that this user has remaining.

Allow Unlimited Credit allows this user unlimited use of network services. Account Balance is ignored.

Low Balance Limit shows the balance at which this user is denied access to network services.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Set This User's Account Balance
1. In the Account Balance field, enter a value.

This balance is depleted each time this user uses a network resource for which an accounting charge 
has been established. However, this balance only affects the user's account if the Allow Unlimited 
Credit field is not selected.

2. In the Low Balance Limit field, enter a value. (Default: 0)
If the Allow Unlimited Credit field is not selected, the user's account is locked when the account 
balance drops below the value in the Low Balance Limit field.

3. Choose OK.
The change is recorded when you choose OK.



Set a Lower Limit on This User's Credit Balance
1. Select again the Allow Unlimited Credit check box, if it is already selected.

If this check box is selected, the Account Balance and Low Balance Limit fields have no effect.
2. In the Low Balance Limit field, enter a value.

The user's account is locked when the account balance drops below the Low Balance Limit. The 
account balance is depleted each time this user uses a network resource for which an accounting 
charge has been established.



View Environment Information about a User Object
Use the Environment page to see other properties of this user object. On this page, you can

 View property information not included in other pages of this dialog, such as the Bindery property and 
the Network Address

 See which properties did not migrate when this user was upgraded to NetWare 4
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Set This User's Language
See Which Workstations This User is Logged in From
Set This User's Default Server
Set Up a Home Directory for This User

Screen regions and buttons
Language determines the language that messages are displayed in.

Network Address lists the addresses of the network workstations that the user is currently logged in 
from.

Default Server displays or allows you to specify the NetWare server that you will receive messages 
from when a message is sent using the SEND utility. Normally you would set the default server to 
be the same as the server specified in the Preferred Server field in your NET.CFG. The Default 
Server field is also the name of the server that your workstation is going to authenticate to (make 
a connection to) when you log in to NetWare Directory Services.

Home Directory shows the volume object and directory path of this user's home directory. You can 
change this directory, but you cannot create a new directory from here.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Set This User's Language
1. In the Language field, enter a language.

This is the language in which all NetWare utilities and prompts appear when this user is logged in and
runs a NetWare utility.
The language that you choose must be installed on the network.

2. (Optional) To add other languages, select the more button to the right of the Language text box.
2. Choose OK.

Your entry is recorded when you choose OK.



See Which Workstations This User is Logged in From
See the Network Addresses field.
The network addresses of all workstations that this user is currently logged in from are listed. If you have 
a Computer object in NetWare Directory Services for each workstation, you can see each workstation's 
address to determine where the user is logged in.
This field can not be modified.



Set This User's Default Server
Default Server is the NetWare server that you will receive messages from when a message is sent using 
the SEND utility. Normally you would set your default server to be the same as the server specified in the 
Preferred Server field in your NET.CFG.
The Default Server field is also the name of the server that your workstation is going to authenticate to 
(make a connection to) when you log in to NetWare Directory Services.
Note: If you specify a NetWare 2 or 3 server (a bindery server) as your default server, users on that 
server must use the /B (bindery) option with the SEND utility for you to receive a message.

To Set This User's Default Server
1. Choose the browser button to the right of the Default Server field.
2. From the Select Object dialog, select a NetWare server.
3. Choose OK.

The NetWare server that you select is inserted into the Default Server field.



Set Up a Home Directory for This User
Note: You can't create new directories in this context. You can either create the directory (path) prior to 

assigning the user to the directory, or do it after making the assignment.

1. Choose the browser button to the right of the Home Directory field.
2. From the Select Object dialog where this user's home directory should be located, select a volume 

and path.
3. Choose OK.

The path that you selected is inserted into the Home Directory field.



View or Change a Computer Object 
The Identification page describes the Computer object. On this page, you can

 Keep a record of the department and person responsible (owner) for the Computer object
 Record information such as the computer's serial number and location

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for This Computer
Enter a Serial Number for This Computer
Enter Another Name for This Computer
Specify One or More Servers for This Computer

Screen regions and buttons
Name displays the name of this Computer object.

Other Names lists other names of this Computer object (such as names previously used for this 
computer).

Owner shows the name of the person who uses the computer represented by this Computer object.

Description contains information that helps identify the computer.

Serial number shows the computer's serial number.

Location shows the physical location of the computer.

Department shows the group the computer belongs to.

Organization shows the organization that the computer belongs to.

Server shows the NetWare server most commonly used by the computer.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Specify One or More Servers for This Computer
1. Choose the browser button to the right of the field.
2. From the Select Object dialog, select one or more NetWare Server objects.
3. Choose OK.

The NetWare servers you selected are listed as servers that this computer regularly accesses to 
retrieve data about logins and NetWare Directory Services.



View or Change a Country Object 
The Identification page describes a Country object. On this page, you can 

 Enter the full name of this Country object 
 Record a information about your organization in this country

Procedures
How to Use the Object Dialog
Enter a Description for This Country

Screen regions and buttons
Name displays the two-letter country code for this country.

Description displays or allows you to enter information such as the full name of the country and a 
description of your organization in that country.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Enter a Description for This Country
The Description field of a Country object can be used to record any pertinent information about the object.
The name of the Country object is a two-letter country code. You should include the complete name of the
country in the Description field. Placing the complete name in the Description field decreases confusion.

To enter a description for this Country
1. Choose the Description field.
2. Type the information you want recorded for this object.
3. Choose OK.

The information is saved to NetWare Directory Services when you choose OK.



View or Change a Group Object    
The Identification page describes this Group object. On this page, you can you store information such as

 Other names this Group object is known by
 The person responsible for this Group object

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for This Group
Add another Name for This Group
Enter an Owner for This Group

Screen regions and buttons
Name displays the name of this Group object.

Other name specifies other identification information for the group.

Owner specifies the person who is responsible for this group.

Description contains information that helps identify this group.

Location shows where the group is located.

Department displays the department this group reports to.

Organization shows the organization that this group reports to.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Enter an Owner for This Group
The Owner field displays or allows you to enter the name of the person who is responsible for maintaining
this group of users.
1. Choose the Owner field.
2. Type the name of the person that you want recorded as the owner of this Group object.
3. (Optional) To add other users to the list of owners, select the more button to the right of the Owner 

field and select other users.
4. Choose OK.

The information is saved to NetWare Directory Services when you choose OK.



View or Change the Members of a Group Object
The Members page lists the users who are members of this Group object.
This Group object appears in the Group Membership page of each user listed on this page.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Member to This Group
Delete a Member from This Group

Screen regions and buttons
Group Members lists the complete context of each User object that is a member of this group.

Add lets you select User objects to add as members of this group.

Delete removes the selected users from the Group Members list.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add a Member to This Group
Rights needed: Write property right to the Membership property of the Group object

Write property right to the Object Trustees (ACL) property of the Group object
The Supervisor object right fulfills these requirements.
1. Choose Add.
2. Select users you want to add to the list of members.
3. Choose OK.

The user is added to the membership list. This user has the same rights that are assigned to the 
Group object.
Note: The Group object is automatically listed in the Security Equal To list of each user that you add 
to the membership list.



Delete a Member From This Group
1. From the Group Members list, select a user.
2. Choose Delete.

The user is deleted from the list of members.
Note: When you delete a user from the membership list of a Group, the Group is automatically 
removed from the Security Equal To list of the user.



View or Change an Organizational Role Object 
The Identification page describes this Organizational Role object. On this page, you can

 Specify which users currently occupy the role named by this object
 Record information about the occupants of this position, such as their telephone and fax numbers

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for This Organizational Role
Add Another Name for This Organizational Role
Add a Fax or Phone Number for This Organizational Role

Screen regions and buttons
Name displays the complete name of this Organizational Role.

Other Name lists other names that this Organizational Role is known by.

Occupant shows the users that currently occupy this role.

Description describes this Organizational Role.

Location describes the location of this occupant (such as room number or office).

Department shows the department or division that the occupant belongs to.

Telephone lists the occupant's telephone numbers.

Fax Number lists fax numbers of this occupant.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



View or Change an Organizational Unit Object 
The Identification page describes this Organizational Unit object. For example, you can

 Record other names this Organizational Unit is known by
 Add a description of the Organizational Unit

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for This Organizational Unit
Enter Another Name for This Organizational Unit

Screen regions and buttons
Name displays the complete name of this Organizational Unit.

Other Name shows other identification information for this Organizational Unit.

Description describes this Organizational Unit.

Location gives the location of this Organizational Unit.

Telephone lists telephone numbers of people in this Organizational Unit.

Fax Number stores the fax numbers of people responsible for this Organizational Unit.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



View or Change Intruder Detection
The Intruder Detection page allows you to set tolerance limits and intruder protection for this container 
object. If a specified number of incorrect login attempts are detected, NetWare assumes that an intruder 
is trying to log in.
On this page, you can decide

 The number of consecutive, invalid logins that are accepted before activating intruder detection
 Whether to lock a user's account after detecting an intruder

These limits apply to all User objects in this container. 
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Detect Intruders for Users in This Container
Lock a User's Account When an Intruder Is Detected
Set How Many Incorrect Login Attempts Are Allowed

Screen regions and buttons
Detect Intruders allows you to track intruder login attempts and lock a user's account.

Incorrect Login Attempts sets the number of incorrect login attempts allowed for all User objects in 
this container.

Intruder Attempt Reset Interval allows you to set the length of time you want to record incorrect login 
attempts before resetting the counter back to zero. You set the time in the Days, Hours, and 
Minutes fields located directly beneath this field.

Lock Account After Detection locks the user's account when the specified number of incorrect login 
attempts occurs in the time designated in the Days, Hours, and Minutes fields.

Intruder Lockout Reset Interval allows you to set how long a user's account remains locked after an 
intruder is detected (the incorrect login attempts number is exceeded). You set the time in the 
Days, Hours, and Minutes fields located directly beneath this field.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Detect Intruders for Users in This Container
1. Select the Detect Intruders check box.

You can't modify this page until this check box is selected. All users who log in to this context now 
have the Intruder Detection feature, meaning that if too many incorrect login attempts are made, the 
account can be locked.

2. Set the number of incorrect login attempts allowed and the length of time to track the number of 
incorrect login attempts.
Example: Set the length of time for 30 minutes and the value in the Incorrect Login Attempts field to 
5. If the Lock Account After Detection box is checked, the account is locked if more than five incorrect 
login attempts are made within 30 minutes. The account remains locked for the duration specified in 
the Intruder Lockout Reset Interval time fields.

3. Choose OK.
The changes are recorded when you choose OK.



Lock a User's Account When an Intruder Is Detected
1. Select the Lock Account After Detection check box.

You must select the Detect Intruders check box before you can select this check box.
If too many incorrect login attempts are made for any user in this container, the user's account is 
locked.

2. Set the Intruder Lockout Reset Interval for the length of time that you want the user's account to 
remain locked.

3. Choose OK.
The changes are not recorded until you choose OK.



Set How Many Incorrect Login Attempts Are Allowed
1. Select the Detect Intruders check box.

All users who log in to this context now have the Intruder Detection feature, meaning that if too many 
incorrect login attempts are made, the account can be locked.

2. In the Number of Incorrect Login Attempts field, enter a number.
The default value is seven. You can allow up to 999 incorrect login attempts.

3. Choose OK.
The changes are recorded when you choose OK.



View or Change an Organization Object 
The Identification page describes this Organization object.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for This Organization
Enter another Name for This Organization

Screen regions and buttons
Name displays the name of this Organization.

Other Name lists other names of this object.

Description describes this Organization.

Location specifies the location of this Organization.

Telephone lists telephone numbers of people in this Organization.

Fax Number stores the Fax numbers of people in this Organization.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



View or Change a Profile Object 
A Profile object contains a login script that several users who are not in the same container can use in 
order to execute a common set of commands. (Objects in the same container do not need to use a Profile
object because the container login script executes for all objects within a container.)
The Identification page describes the Profile object. On this page, you can

 List other names that this Profile object is called
 View or change the description of this Profile object
 View or change the organization where this Profile object resides

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for This Profile
Enter another Name for This Profile

Screen regions and buttons
Name displays the name of this Profile.

Other Name lists additional information for this Profile.

Description describes how this Profile is used.

Location specifies the location of the department or users of this Profile.

Department shows the department or Group that uses this Profile.

Organization shows the organization that uses this Profile.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.

Related topics
The [Root] Object



Profile Object - Other Names
These names are for your use only and do not appear anywhere but in this dialog.
Use the Other Name field to list names that you can use to search for the Profile.

To add or remove names from the list, choose the More button. 



View or Change an Alias Object 
The only information stored in an Alias object is the name of the object that the Alias object refers to.
You can't change information about an Alias object after it has been created. You must delete the Alias 
object and create it again if you need to make any changes.



View or Change a Directory Map Object 
The Identification page describes the Directory Map object. On this page, you can

 View or change the description of what this Directory Map is used for
 View or change the volume and path that this Directory Map points to

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
How to Use a Directory Map with the MAP Command
Change the Path of this Directory Map Object

Screen regions and buttons
Name displays the name of this Directory Map.

Other Name lists additional identification information for this Directory Map.

Path shows the complete path that this Directory Map refers to.

Description describes how this Directory Map is used.

Location shows the physical location of the volume referred to in the Path field.

Department shows the department that uses this Directory Map.

Organization shows the organization that uses this Directory Map.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.

Related topic
The [Root] Object



How to Use a Directory Map with the MAP Command
You can map a Directory Map object to an application instead of mapping to a specific volume and path 
on the network where an application is located.
When the application is moved to a new location on the network, the network administrator only has to 
change the volume and path in the Directory Map object. Users can still reference the Directory Map and 
find the application. No login scripts need to be changed.
A Directory Map object can be used with the MAP command in 

 Container login scripts
 Profile login scripts
 User login scripts

If the user is not in the same context as the Directory Map, use the complete name of the Directory Map 
in the MAP command.
Example: To reference a Directory Map for a word processing application in the login script, type the 
following command: MAP s16:=.WordPerfMap.Accounting.Novell



Change the Path of This Directory Map Object 
1. Choose the browser button to the right of the Path text box. 

Use the browser button to search the Directory tree for the directory you want this Directory Map 
object to point to.

2 Select a directory; then choose OK.
The volume and path fields will both be filled in.

5. Choose OK.
The path of this Directory Map object is updated.



Directory Map - Other Names
These names are for your convenience and do not appear in the browser. You can use these other names
to search for this Directory Map.

To add or remove names from the list, choose the More button. 



Directory Map Path 
The Path dialog shows the location of the directory path of this Directory Map.

Procedures
Change the Path of this Directory Map Object

Screen regions and buttons
Volume shows the volume that this Directory Map points to. This field is required.

Path shows the path that this Directory Map points to. This field is required.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



View or Change a NetWare Server 
The Identification page describes the NetWare Server object you selected. On this page, you can

 View or change the description of what this NetWare server is used for.
 View the version of NetWare that this NetWare server uses.

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
See What Operating System This Server Is Using
See the Network Addresses Used by This Server
Enter a Description for This NetWare Server
Enter another Name for This NetWare Server
Enter a Location for This NetWare Server

Screen regions and buttons
Name shows the name of this NetWare server.

Other Name lists other ways of referring to this NetWare server. 

Description describes this NetWare server.

Location specifies the physical location of this NetWare server.

Department shows the department or group that use this NetWare server.

Organization shows the organization that uses this NetWare server.

Net Address shows the network address of this NetWare server.

Status specifies whether this NetWare server is up or down.

Version shows the version of NetWare that is installed on this NetWare server.

Accounting installs or removes the accounting function from this NetWare server.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.

Related topic
The [Root] Object



See What Operating System This Server Is Using
The Version field on the Identification page shows which version of the NetWare network operating 
system this server is running.
You cannot change this field. NetWare Directory Services determines the value of this field by examining 
the server when the object was created.



See the Network Addresses Used by This Server
To see the network addresses used by this server, scroll through the Net Address field on the 
Identification page.
NetWare Directory Services can only access the server on network addresses that are included in this 
list.
Using different network addresses allows this server to function as a router between different networking 
systems, such as TCP/IP and IPX/SPX. The protocol being used is listed before each address.
You cannot change these addresses; they are determined from the network routers.



View or Change an AFP Server    
The Identification page describes the AFP server you selected. On this page, you can

 View or change the description of what this AFP server is used for.
 View the version of AppleTalk that this AFP server uses.

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Serial Number for This AFP Server
See the Number of Connections Allowed on This AFP Server
Enter a Description for This AFP Server
Enter Another Name for This AFP Server

Screen regions and buttons
Name shows the name of this AFP Server.

Other Name lists additional identification information for this AFP server.

Description describes this AFP server.

Location specifies the physical location of this AFP server.

Department shows the department that uses this AFP server.

Organization shows the organization that uses this AFP server.

Version shows the version of the Apple Operating System that is installed on this AFP server.

Serial # shows the serial number of the NetWare product that the AFP server is using.

Connections shows the number of connections allowed by NetWare on this AFP server.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.

Related topic
The [Root] Object



See the Number of Connections Allowed on This AFP Server
The Connections field on the Identification page of the object dialog shows the number of connections 
allowed on this AFP server.
You cannot modify this field; the number of connections is determined by the software running on the AFP
server.



NetWare, AFP, or Messaging Server Object - Other Names
This field shows all names by which this Server object is known. These names are for your information 
only and don't appear in the browser. You can use these other names to search for the Server object.

To add or remove names from the list, choose the More button. 



Accounting for NetWare Servers
To activate accounting on a server on which accounting is not active, choose Accounting.
To remove accounting on a server on which accounting is active, choose Accounting.
Accounting lets you define charge rates for five services:

 Disk block reads
 Disk block writes
 Time connected to the server
 Amount of disk storage used
 Requests for services

Charge rates for each service can be set separately.
When accounting is active, any service that a user uses is charged to that user's account. If the user's 
account balance is depleted, the user can't log in to the network.



View or Change the List of Supported Services of a Server
The Supported Services page lists services provided by the NetWare server you selected. On this page, 
you can

 View which services this server supports (such as print services or bindery services)
 Track available services
 Add or delete from the list of services.

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a New Service
Delete an Existing Service

Screen regions and buttons
Supported Services lists all services available on this server. Since the server doesn't automatically 

update this property, this list has no operational effect on the network.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add a Supported Service
1. Choose Add (located below the Services box).
2. Enter the name of the service.
3. Choose OK.

The new service is added to the list.



Delete A Supported Service
1. From the list in the Services box, select a service.
2. Choose Delete.

The selected service is deleted from the list.



View or Change the List of Resources of a Server
The Resources page describes resources available on this server, such as volumes or printers. On this 
page, you can

 View which resources this server provides
 Add or delete a resource

This list has no operational effect on the network, but can be used by a network supervisor to track and 
record information about this server.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a New Resource
Delete an Existing Resource

Screen regions and buttons
Resources lists the complete name of all objects that are resources supported by this server.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add a Resource
1. Choose Add (located below the Resources box).
2. Choose the object that you want to add as a resource.

Because this list is for your information only, you can add any object to the list.
Note: You can use the <CTRL> and <Shift> keys to select multiple objects. For example, press the 
<CTRL> key while selecting objects with the left mouse button.
3. Choose OK.

The new object is listed as a resource.



Delete A Resource
1. From the Resources list box, select a resource.
2. Choose Delete.

The resource is deleted from the list.



View or Change the List of Users for a Server
The Users page lists users of this resource. This list is created and maintained by the network supervisor. 
For example, you can

 View users who access this resource
 Add or delete a user of this resource

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a New User
Delete an Existing User

Screen regions and buttons
Users lists all User objects that have accounts on this server. This list has no operational effect on the

network, but can be used by a supervisor to record information about this network resource.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add a User to a Messaging Server
Rights needed: Write property right to the Messaging server
The Supervisor object right to the Messaging server fulfills this right.
1. Choose Add (located below the Users list box).
2. Select any users that you want to add to the Messaging Server.
3. Choose OK.

The new object is displayed.



Delete a User
Rights needed: The Write property right to the User property of the Messaging server
The Supervisor object right to the Messaging server fulfills this requirement.
1. From the Users list box, select a user.
2. Choose Delete.

The user is deleted from the list.



View the Server Error Log
The server error log records all errors that occur during this server's operations. The errors remain in the 
error log until it is cleared.
The types of errors in the error log can include

 Directory Services is unable to communicate with a server that is represented by a Server object in 
your tree

 A file cannot be migrated
 An NLM requested memory but none was available
 A section of a mirrored hard disk becomes inoperable

Many errors are automatically fixed by NetWare. Study this error log to see where problems are 
occurring, and check or modify your network so that future problems do not become more serious.

Procedures
How to Use the Object Dialog
Clear the Server Error Log



Clear the Server Error Log
The server error log is displayed in the edit window as soon as you select the Error Log page. It is a 
record of activity on the server. Because the error log is created by the server from its own operations, 
you cannot change the server error log; however, you can clear it.
To clear the Error Log, choose Clear Error Log.
The error log is erased and a new log is begun when the server encounters the next error. Since the error 
log can get very large, you should periodically clear the server error log to free up disk space.
Note: You can use the Copy (<Ctrl><Insert>) and Paste (<Shift><Insert>) functions of MS Windows to 
copy any portion of the error log to another MS Windows application before clearing it.



Accounting for Blocks Read
The Blocks Read page lists rates charged by accounting services for blocks read on this NetWare server. 
For each block a user reads from the hard disk, the user is charged the corresponding rate shown on this 
page. Charge rates can be set for specific days and hours.
On this page, you can

 View times when each charge rate is in effect
 Change the formula used to calculate any charge rate

You can't generate reports from the object dialog. You must use the AUDITCON menu utility to generate 
an accounting report.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Charge Rate
Delete a Charge Rate
Change a Charge Rate
Find What Rate Is Charged on a Certain Day and Time
Change What Rate Is Charged on a Certain Day and Time

Screen regions and buttons
Day and Time Grid
Reset
Time and Charge Rate Fields
Charge Rates List Box
Add Charge Rate
Delete Charge Rate

Related topics
Determining Charge Rate Multipliers and Divisors
What to Charge For
How Charge Rates Affect a User's Account Balance



Accounting for Blocks Written
The Blocks Written page lists rates charged for blocks written on this server. For each block the user 
writes to the hard disk, the user is charged the corresponding rate shown on this page. Charge rates can 
be set for specific days and hours.
On this page, you can

 View times when each charge rate is in effect
 Change the formula used to calculate any charge rate

No reports can be generated.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Charge Rate
Delete a Charge Rate
Change a Charge Rate
Find What Rate Is Charged on a Certain Day and Time
Change What Rate Is Charged on a Certain Day and Time

Screen regions and buttons
Day and Time Grid
Reset
Time and Charge Rate Fields
Charge Rates List Box
Add Charge Rate
Delete Charge Rate

Related topics
Determining Charge Rate Multipliers and Divisors
What to Charge For
How Charge Rates Affect a User's Account Balance



Accounting for Connect Time
The Connect Time page lists rates charged for connecting to this NetWare Server. For each minute that a 
user is connected to this NetWare server, the user is charged the corresponding rate shown on this page. 
Charge rates can be set for specific days and hours.
On this page, you can

 View times when each charge rate is in effect
 Change the formula used to calculate any charge rate

No reports can be generated.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Charge Rate
Delete a Charge Rate
Change a Charge Rate
Find the Charge Rate for a Certain Day and Time
Change the Charge Rate for a Certain Day and Time

Screen regions and buttons
Day and Time Grid
Reset
Time and Charge Rate Text
Charge Rates List Box
Add Charge Rate
Delete Charge Rate

Related topics
Determining Charge Rate Multipliers and Divisors
What to Charge For
How Charge Rates Affect a User's Account Balance



Accounting for Disk Storage
The Disk Storage page lists rates charged by accounting services for storing data on this server. For each
block on the hard disk occupied by a file or directory the user owns, the user is charged the 
corresponding rate shown on this page. Charge rates can be set for specific days and hours. 
On this page, you can

 View times when each charge rate is in effect
 Change the formula used to calculate any charge rate

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Charge Rate
Delete a Charge Rate
Change a Charge Rate
Find the Charge Rate for a Certain Day and Time
Change the Charge Rate for a Certain Day and Time

Screen regions and buttons
Day and Time Grid
Reset
Time and Charge Rate Text
Charge Rates List Box
Add Charge Rate
Delete Charge Rate

Related topics
Determining Charge Rate Multipliers and Divisors
What to Charge For
How Charge Rates Affect a User's Account Balance



Accounting for Service Requests
The Service Requests page lists rates charged for requesting services on this NetWare server. Each time 
a user requests a service, the user is charged the corresponding rate shown on this page. Service 
requests are anything that requires communication with the server (authenticating, printing, etc.). Charge 
rates can be set for specific days and hours.
On this page, you can

 View times when each charge rate is in effect
 Change the formula used to calculate any charge rate

Each time a workstation requests a service, that user is charged the corresponding rate shown on this 
page.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Charge Rate
Delete a Charge Rate
Change a Charge Rate
Find the Charge Rate for a Certain Day and Time
Change the Charge Rate for a Certain Day and Time

Screen regions and buttons
Day and Time Grid
Reset
Time and Charge Rate Text
Charge Rates List Box
Add Charge Rate Button
Delete Charge Rate Button

Related topics
Determine Charge Rate Multipliers and Divisors
What to Charge For
How Charge Rates Affect a User's Account Balance



Add a Charge Rate
You can have up to 20 different charge rates for each of the 5 accounting categories on this NetWare 
Server. If you enter a new charge rate, but do not specify in the day and time grid when it is in effect, it is 
not saved in the list of charge rates when you close the object dialog.
Before you begin, you must determine the multiplier and divisor used to compute charges.

To add a charge rate
1. Choose Add Charge Rate.
2. In the Multiplier field, enter a value.
3. In the Divisor field, enter a value.
4. Choose OK.



Delete a Charge Rate
1. From the box in the middle of the page that lists all charge rates, select a charge rate.
2. Change the day and time grid so that the charge you're deleting does not appear in the grid.

You can't delete a charge rate if it still appears in the day and time grid.
3. Choose Delete Charge Rate.

The selected charge rate is deleted from the list



Change a Charge Rate
To change a charge rate, you must delete it and re-enter it with new values. You must also update all days
and times that use the rate.

To change a charge rate
1. From the list of charge rates in the middle of the page, select the charge rate that you want to change.
2. Change the day and time grid so that the charge rate you are changing does not appear in the grid.

You can't change a charge rate if it still appears in the day and time grid.
3. Choose Delete Charge Rate.

The charge rate is deleted from the list.
4. Choose Add Charge Rate.
5. Enter values for the new charge rate.

Note: You must determine the multiplier and divisor for the new rate.
6. Choose OK to return to the page showing all charge rates.
7. In the Charge rate box, select the new charge rate.
8. Block out the days and times that the charge rate should apply to.



Find the Charge Rate for a Certain Day and Time

If you use a mouse
Put the pointer on the cell that represents the day and time for which you want to know the charge rate. 
The charge rate is shown in the Charge Rate field.

If you use a keyboard
Hold the <Shift> key down while pressing the <Tab> key until the cursor appears in the day and time grid. 
Then use the arrow keys to move the cursor to the day and time for which you want to know the effective 
charge rate. 
The day and time that you are pointing to are shown below the day and time grid in the Time field. 
The charge rate is shown in the Charge Rate field.



Change the Charge Rate for a Certain Day and Time

If you use a mouse
1. Select the charge rate that you want to make effective.
2. Select the cell representing the day and time that you want that charge rate to apply. 

(The Time field located under the grid changes as you move the pointer around.)
The cell changes to the color representing the selected charge rate. You can click and drag to cover a
larger area of the grid.

If you use a keyboard
1. Select the charge rate that you want to use from the list of charge rates by using the <Tab> key and 

the arrow keys.
2. Use the <Tab> key to move to the day and time grid. Then use the arrow keys to move the cursor in 

the grid to the cell representing the day and time you want the charge rate to apply. (The Time field 
located under the grid changes as you move the cursor around.)

3. Select the cell by pressing the <Spacebar>.
The cell changes to the color representing the selected charge rate.

4. Repeat this process for each cell that you want the selected charge rate to apply to.



Day and Time Grid
Use the day and time grid to specify when charge rates are effective.
In the day and time grid

 Each cell represents one half hour of one day of the week
 Each row of cells is one 24-hour day

The Time field indicates the day and time that you are pointing to.
You can have 20 charge rates for each of the five accounting categories. You can specify a different 
charge rate for each half hour of each day of the week.
Example: To set a charge rate for blocks read during work hours, first choose Add Charge Rate and 
specify a multiplier and divisor. Then select all cells from Monday at 8 a.m. to Friday at 5 p.m. and fill it 
with one charge rate (shown by that charge rate's color).
Note: If you enter a new charge rate, but do not use it in the day and time grid, it will not be saved in the 
list of charge rates.



Reset Button
To correct any mistakes you make in the day and time grid, choose Reset. The grid will clear so you can 
select new blocks of time with the mouse or cursor.
Note: The Reset button does not undo a deletion of a charge rate after you choose Delete Charge Rate.



Time and Charge Rate Fields
Two fields are under the day and time grid to help you assign charge rates:

 Time shows the day and time of day represented by the cell you are pointing to
 Charge Rate shows the charge rate in effect for that day and time

Watch these fields when you work in the grid to make sure you are assigning charge rates for the correct 
days and hours.



Charge Rates List Box
This box lists all charge rates that can be assigned to this resource on this server. Each charge rate is 
made up of a multiplier and a divisor.
You can have 20 charge rates for each of the five accounting categories.
A color is assigned to each charge rate and is used to indicate the days and times the charge rate is in 
effect.
Note: If you enter a new charge rate, but do not use it in the day and time grid, it is not saved in the list of 
charge rates when you close the object dialog.



Add Charge Rate
1. Choose Add Charge Rate.
2. Enter a multiplier and divisor for the new charge rate.

The new charge rate is added to the list of charge rates.
You can have 20 charge rates for each of the five accounting categories.
Note: If you enter a new charge rate, but do not use it in the day and time grid, it will not be saved in the 
list of charge rates when you close the object dialog.



Delete Charge Rate
This button deletes the selected charge rate from the list of charge rates.
You can delete only charge rates that are not used in the day and time grid. To delete a charge rate that is
still in use, you must change the charge rate for those days and times.
Once you delete a charge rate, it can't be undone. You must re-enter the deleted values using Add 
Charge Rate.



Determine Charge Rates
A user's account is defined in cents. We recommend that you use cents or an equivalent value.
There are two ways to determine charge rates:

If you know how much to charge per resource unit
If you know how much you want to charge for the entire resource



Determine a Charge Rate
You can set a charge rate for the amount you want. For example, perhaps you want to charge 1 cent for 
each block read.
Note: A user's balance is defined in cents.
1. Convert the amount you want to charge into a fraction.

If the amount is a whole cent amount, like 2 cents, then change the amount into a fraction by putting 
that whole cent amount over 1. For example, 2/1 would mean that for every block read, charge two 
cents.
In this example, the multiplier, or top number, is 2; the divisor, or bottom number, is 1.

If the amount is a fraction, like 1.75 cents, then multiply it by 10 enough times to get rid of the decimal
(this is the value for the multiplier field). Then put a 10 underneath the multiplier (this is the value for 
the divisor field). 
For example, 1.75 times 10 equals 17.5, with one 10 underneath. So our first fraction is 17.5/10. 
Since the multiplier, or top number, is still a fraction, repeat the process: 17.5 times 10 equals 175. 
with another 10 underneath. So the new fraction is 175 over 10 times 10, or 175/100. This means that
for every 175 blocks read, charge 100 cents.
In this example, the multiplier, or top number, is 175; the divisor, or bottom number, is 100.

2. Enter the top number of the fraction as the multiplier.

3. Enter the bottom number of the fraction as the divisor.



Charge for a Resource
You can charge for an entire resource used. For example, assume you want to charge $50 per week for 
disk storage to cover operating costs, and there are usually 100,000 4K blocks used on your 500Mb hard 
drive.
1. Enter the total amount charged as the multiplier.

This is 5000 in our example, or $50 in cents.
2. Enter the total amount of the resource used as the divisor.

This is 100,000 in our example or the total amount of the disk space to charge for.
The charge-rate equation comes out to 1/20 of one cent for each 4K block stored. So, if a user had 1Mb 
of word processing and spreadsheet files stored on the hard disk, the user would be charged 12.5 cents 
per week.

To Charge for Disk Storage
Note: There are two methods that you can use to set this up, single cell for the week or a daily charge 
each day of the week.
The day and time grid on the Disk Storage page allows charge rates to be set only in a single column of 
the grid; you can not span different time periods of the day.

To Charge The User Weekly
1. Choose the Disk Storage page.
2. Choose one cell, (say Saturday 4am).
3. Choose Add Charge Rate.
4. Enter 1 in the Multiplier field.
5. Enter 20 in the Divisor field.
6. Choose OK.
7. Apply this charge rate to the cell you selected.
8. Click OK.

Every Saturday morning at 4:00 a.m. the system will check the users' directories and determine how 
much disk space they are using. In our example, if the user is using 1 MB of disk space, the user will 
be charged 12.5 cents. If the user's account balance was 1000 prior to the rate charge, the new 
account balance will be 987.

To Charge The User Daily
1. Choose a vertical block of time crossing 7 days. (Sunday through Saturday at 4 a.m.)
2. Choose Add Charge Rate.
3. Enter 1 in the Multiplier field.
4. Enter 140 in the Divisor field (7 * 20 = 140).
5. Choose OK.
6. Apply this charge rate to the cells you selected.
7. Choose OK.
Everyday at 4:00 am the system will check the users' directories and determine the amount of disk space 
they are using. In our example, if the user is using 1 MB of disk space, the user will be charged 
approximately 1.8 cents (1.78 * 7 = 12.5). If the user's account balance was 1000 prior to the rate charge, 
the new balance will be 998.



What to Charge For
As a general rule, charge users for server resources that are scarce or that you want to limit use of. For 
example,

 If disk storage space is scarce, charge for disk storage space so that users do not keep old files on the 
hard disk.

 If network traffic is heavy, charge for service requests so that users limit their overall use.
 If you run out of NetWare connections regularly, charge for connect time so that users log in only when 

they really need the network.
You can charge for more than one resource. If no charge rates are entered in the day and time grid for a 
resource, then users are not charged for that resource.



How Charge Rates Affect a User's Account Balance
Each user can have an account balance that determines the amount of network resources that the user 
can use. If you check the Allow Unlimited Credit check box in the user's object dialog Account Balance 
page, then accounting and charge rates have no effect.
If a user does have an account limit and uses a service for which an accounting charge rate has been 
specified, the amount of that service is deducted from the user's account balance. 
When the user's credit limit is reached or the account balance is zero, the user can not log in to the 
network until the account balance is changed by the network administrator.
Example: User GINA pays $50 to use the network, so her account balance is set to 5000. You charge 2 
cents for each block read and 1 cent for each minute of connect time. Each time GINA reads a block of 
information from a volume attached to that NetWare Server, her account balance is reduced by 2 cents. 
Each minute that GINA is attached to that NetWare Server, her account balance is reduced by 1 cent. 
After several weeks, GINA's account balance is zero. She is logged out and can't log in again until the 
network supervisor updates her account balance.



View or Change a Volume Object 
Volume is a leaf object. However, directories and files (the file system of the physical volume) are shown 
under it, just like leaf objects are shown under container objects.
A Volume object provides a place in the NetWare Directory Services database to record and view 
information about a physical volume that was installed on a NetWare Server.
By pointing a Volume object to a physical volume, you can see the directories and files on the volume.
The Identification page describes this Volume object. For example, you can

 View the name of the physical volume
 View or change the department that this volume is used in.

Important: OK and Cancel affect the entire Object dialog, not just this page. Do not choose OK until 
you've entered all changes you need to this page and other pages. If you choose Cancel, you will lose all 
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
List the Files on This Volume
See the Physical Name of This Volume
See Which Server This Volume Is Attached To
Enter Another Name for this Volume
Enter a Location for This Volume

Screen regions and buttons
Name shows the context name of this Volume object.

Host Server shows the name of the NetWare server on which this volume is physically located. This 
field can't be changed.

Version shows the version of the NetWare operating system running on the host server.

Host Volume shows the physical volume name. This field can't be changed.

Other name lists other identification information for this object.

Location shows the physical location of the NetWare server that contains this Volume object.

Department shows the department that uses this volume.

Organization shows the organization that uses this volume.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.

Related topics
The [Root] Object
Trustees and Trustee Paths
The Root Directory of a Volume - Assigning Rights



List the Files on This Volume
In NetWare Administrator, you can manage files and directories on a NetWare volume. Files and 
directories are displayed below the Volume object as a continuation of the Directory structure, even 
though they are actually a part of a file system and not the NetWare Directory Services database.
You can select and expand a Volume object, if you have these rights:

 Browse object right to the Volume object
 Read property right to the Host Server and Host Volume properties of the Volume object (These are 

granted to every object by default when the Volume object is created.)
 File Scan directory right to the [Root] directory of the volume

You must have rights to the ACL property to change object or property rights, and you must have the 
Access Control directory right to change rights to the [Root] directory.
Note: Supervisor rights to the file system on the volume are granted through the NetWare Server object 
on which this volume is installed.



See the Physical Name of this Volume
The physical name of the volume that this Volume object refers to is shown in the Host Volume field on 
the Identification page of the Volume object dialog. The physical volume name is also referred to as the 
host resource name.
Volume SYS: must exist for every NetWare server, but other volumes on the server can have any name 
that follows volume naming conventions. A physical volume name is assigned when a volume is installed. 
The physical volume name cannot be changed by NetWare Directory Services. You can use 
INSTALL.NLM to change the physical volume name, but INSTALL.NLM does not change the old Volume 
object's name.



See Which Server this Volume is Attached To
The physical NetWare server that this volume is attached to is shown in the Host Server field of the 
Identification page of the object dialog for this volume. The Host server was specified when the Volume 
object was created and cannot be changed. 
The Host server provides NetWare Directory Services an address to find the volume on the network.
For more information about the Host server, you can view the object dialog for the NetWare Server object 
representing it.



Volume Object - Other Names
This field shows all names by which this Volume object is known. These names are for your convenience 
only and do not appear in the browser. 
Use the Other Name field to record information that you want to use to search for this volume.

To add or delete names, choose the More button. 



View Statistics About a Volume Object 
The Statistics page describes how the Volume object you selected is used. On this page, you can

 View how space on this volume is used
 See which name spaces and features are installed on this volume

You can't change the information on this page.
A Volume object provides a place in the Directory database to record and view information about a 
physical volume that was installed on a NetWare server.
By creating a Volume object and pointing it to a physical volume, you can see the directories and files on 
the volume from within NetWare Administrator and other utilities. 
Volume is a leaf object. However, directories and files are shown under it like leaf objects are shown 
under container objects.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you will lose all changes 
in every page of this dialog.

Procedures
How to Use the Object Dialog
See How Much Disk Space Is Available
See How Many Directory Entries Are Available
See the Block Size Used on This Volume
See if This Volume is Removeable or Not
See How Much Space is Used by Deleted Files
See How Much Space is Saved by Compression
See How Many Files Have Been Migrated
See Which Name Spaces Are Installed on this Volume
See Which Features Are Installed on this Volume
List the Files on This Volume

Screen regions and buttons
Block size shows the block size used by files on this volume.

[Non-]removeable volume indicates if this is a permanent or removeable volume.

Disk Space shows the percentage of the volume used.

Directory Entries shows how many directory entries are used.

Deleted Files shows the number and size of files that have been deleted but not purged from the 
volume.

Migrated Files shows the number and size of files that have been migrated to a secondary storage 
device.

Compressed Files shows the number and size of files that have been compressed.

Name Spaces lists which name spaces are loaded on this volume.

Installable Features lists features installed on this volume, such as compression or auditing.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Block Size
This field indicates the block size used by this volume. The block size was determined when the volume 
was installed. Block size can't be changed without re-installing the volume.
Space on a volume is allocated to files in blocks. The minimum amount of disk space that a file can use is
one disk block. Subsequent space allocations are also a multiple of the block size.
Considerations when determining block size

 The minimum amount of disk space that a file can use is one disk block.
 A smaller block size saves disk space, but make access to larger files less efficient.
 A larger block size makes access to very large files much quicker, but will waste disk space for small 

files.
 Block suballocation allows several files to share one disk block.

See Concepts for more information.



[Non-]Removeable Volume Flag
This flag is set automatically when a volume is installed.
Non-removeable volumes include hard drives.
Removeable volumes come on cartridges or optical disks that can be taken out of the drive.



Disk Space Chart
This chart shows how much of this volume is in use. The total size of the volume and the remaining free 
space are shown numerically below the graphic representation.
Colored areas indicate the space that is used. The percentage used space is shown at the right of the 
chart.
You can't change this information here. To change the amount of space used, you must create or delete 
files, add or remove name spaces, or perform similar actions.

Screen regions and buttons
Total shows the total size of the volume in bytes.

Available shows the amount of space available on the volume in bytes. (This is indicated by white 
areas.)



Directory Entries Chart
This chart shows how many directory entries are used on this volume. The total number of directory 
entries and the entries that are still available are shown numerically below the chart.
Note: You can't change this information. The number of directory entries available on each volume is 
determined by the block size used on the volume, which must be set when the volume is installed. Each 
directory entry uses 128 bytes, and a maximum of 65,536 disk blocks can be used for directory entries. 
So, the maximum number of directory entries on a volume is the block size (in KB) times 524,288.

Screen regions and buttons
Total shows the total number of directory entries that can be on the volume.

Available shows the number of directory entries still available on the volume. It is indicated by white 
areas.



Migrated Files
This box shows how many files on this volume have been migrated to a secondary storage device, and 
how much disk space was saved by migrating them.
Note: If this box is grayed, you do not have the Data Migration feature    installed on this volume.

Screen regions and buttons
Count shows the number of files on this volume that are currently migrated to a secondary storage 

device.

Actual size shows the total size of all files that have been migrated to a secondary storage device. To 
bring all migrated files back to the volume, you would need this much disk space. This number 
can be larger than your entire volume because the secondary storage device can be larger than 
the volume.



Compressed Files
This box shows how many files on this volume have been compressed, and how much disk space was 
saved by compressing them.
Note: If this box is grayed, you do not have the Compression feature installed on this volume.

Screen regions and buttons
Count shows the number of files on this volume that have been compressed.

Uncompressed Size shows the space that all files in the Count field would use if they were not 
compressed.

Compressed Size shows the space that all of the files in the Count field are actually using while they 
are compressed.

Average Compression shows the average amount of space saved by compressing a file, as a 
percentage of its original size. The formula used to calculate this for each file is uncompressed 
size minus compressed size, divided by uncompressed size.



Name Spaces Box
This box lists name spaces that are installed on this physical volume.
Name spaces can be added to the volume at any time by the network supervisor using the LOAD 
command at the server console prompt. Each name space uses another directory entry for every file or 
directory on the volume.
See Concepts for more information.



Installed Features Box
This lists features installed on the volume. A feature must be installed on a volume for the files on that 
volume to use it.
Some features can be installed or removed at the server console. Other features must be chosen when 
the volume is installed and can't be changed.
Possible features are

 Block Suballocation: Allows disk blocks to be shared by several files to prevent wasted disk space
 Compression: Compresses files that have not been used recently
 Data Migration: Moves files that have not been used recently to a secondary storage device until they 

are requested
 Auditing: Allows a network auditor to track file and NetWare Directory Services transactions
 Read Only: Indicates that this volume can be read but not written to (such as a CD-ROM drive)



Deleted Files
This lists the space used on this volume by files that have been deleted but are still stored on the volume.
NetWare saves all deleted files for a time in case they need to be salvaged and reused after they have 
been deleted.
You can set (at the server console) the amount of time the system waits before purging deleted files 
(permanently erasing them), or you can have them purged immediately after they are deleted. If a volume
is full, the oldest deleted files are purged first to make space for current files to be stored.

Screen regions and buttons
Count shows how many deleted files are stored on this volume. All deleted files referred to in this 

number are listed as unpurgeable or purgeable in the two fields below.

Unpurgeable Size indicates the total size of all deleted files that can't be purged yet. This refers to the
Minimum Delay to Purge Files parameter in the NetWare server console. Files that have been 
deleted less than that amount of time can't be purged.

Purgeable size indicates the total size of all deleted files that can be purged. These files have been 
deleted at least the Minimum Delay to Purge Files time, but they have not been purged yet.



View or Change Dates and Times Related to a Volume 
The Dates and Times page describes the way this Volume object has been used. On this page, you can

 View the owner of this volume
 View the last user to archive the volume
 View the date of creation or archive for this volume

A Volume object provides a place in the Directory database to record and view information about a 
physical volume that was installed on a NetWare Server.
By creating a Volume object and pointing it to a physical volume, you can see the directories and files on 
the volume from within NetWare Administrator and other utilities.
Volume is a leaf object. Directories and files (the file system of the physical volume) are shown under it 
like leaf objects are shown under container objects.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
List the Files on This Volume
Change the Owner
Change the Archived Last Date or Time
Change the Archived Last By

Screen regions and buttons
Created On shows the date and time that this volume was installed.

Owner shows the User object that installed this volume.

Modified last on shows the date and time when the information on this screen was last updated. You 
cannot change this information.

Archived Last On shows the date and time when this Volume was partially or completely backed up. 
This field is set when the Archive attribute of the Volume's [Root] directory is reset by a backup 
application.

Archived Last By shows the User object that was operating the backup application when this volume 
was most recently backed up (all or part). This field is set when the Archive attribute of the 
Volume's [Root] directory is reset by a backup application.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.

Related topics
The [Root] Object
Trustees and Trustee Paths
The [Root] Directory of a Volume - Assigning Rights



Change the Owner of a Volume
1. Select the Owner field.
2. Enter the name of the user who owns this volume. You can choose a user object by choosing the icon

to the right of the field. 
3. Choose OK.



Change the Last Archived Date and Time of a Volume
1. Select the section of the Last Archived date or time field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. Advance the date or time using the Up-arrow button.
2b. Turn back the date or time using the Down-arrow button.

3. Choose OK.



Change Who Archived a Volume
1. Select the Archived Last By field.
2. Enter the name of the user who last archived (backed up) this volume. You can choose a user object 

by choosing the icon to the right of the field. 
3. Choose OK.



View or Change User Space Limits on a Volume 
This volume is located on a NetWare 2 or 3 server, or is being viewed on a different Directory tree through
bindery services. The User Space Limits page describes all users' space limitations on this Volume 
object. On this page, you can

 View a user's space restrictions
 Change a user's space restriction for this volume

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
List the Files on This Volume
See a User's Space Restrictions on This Volume
Change a User's Space Restrictions on This Volume

Screen regions and buttons
User list shows all users who are using space on this volume, and details about their usage.

Display Number of Files and Directories shows how many files and directories this user owns on this 
volume.

Modify button opens a dialog for the selected user that lets you change or remove the users' space 
limits for this volume.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.

Related topics
The [Root] Object
Trustees and Trustee Paths
The [Root] Directory of a Volume - Assigning Rights



View or Change User Space Limits on a Volume 
The User Space Limits page describes all users' space limitations on this Volume object. On this page, 
you can

 Select which area of the Directory tree you want to see users from
 View a user's space restrictions
 Change a user's space restriction for this volume

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes you need to this page and other pages. If you choose Cancel, you lose all 
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
List Files on This Volume
Select Which Section of the Directory Tree You See Users From
See a User's Space Restrictions on this Volume
Change a User's Space Restrictions on this Volume

Screen regions and buttons
Search Context tells which container to begin searching for users to list here. Listing users from only 

part of the Directory tree is much faster.

Search Entire Subtree determines whether everything below the Context is searched for users, or 
only those leaf objects directly below the container object are searched.

User's Name shows all users who are using space on this volume.

Limit shows the space limits that the user has on this volume.

Space in Use shows the amount of space (in Kilobytes) that this user is occupying on this volume by 
storing files and directories.

Space Available shows the amount of space (in Kilobytes) that this user can occupy by storing files 
and directories.

Modify opens a dialog for the selected user that lets you change or remove its space limits for this 
volume.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.

Related topics
The [Root] Object
Trustees and Trustee Paths
The [Root] Directory of a Volume - Assigning Rights



Select Which Section of the Directory Tree You See Users From
Use this dialog to limit the section of the Directory tree in which users are searched for.
The smaller the section of the Directory tree you select, the more quickly the dialog appears.

To select a section of the Directory tree
1. Select the browser button to the right of the Search Context field.
2. Select a container object.

This page lists the space limitations for all users under this container.
3. Select the Search Entire Subtree check box.

If you do not select this check box, only leaf objects directly below the container that you selected are 
included in the list of users. This is faster if you know exactly where the user that you want is located.



See a User's Space Limits
1. Select the user whose space limits you want to view.
2. Look in the Limit field to see how much space this user is allowed on this volume.

Each fiile or directory the user owns on the volume occupies a portion of the user's alloted space.
Access is denied if the user tries to create new files or increase the size of existing files after the 
space limits are exceeded.



Change a User's Space Limits
1. Select the user whose space restrictions you want to change.
2. Choose Modify.

The User field shows the name of the user.
The Volume Space Used by User field shows the amount of space (in thousands of bytes) taken by 
this user.

3. (Optional) To remove the user's space restrictions, select the Limit Volume Space check box so that it 
is empty.
When the Limit Volume Space check box is empty, the user can use any free space on the Volume.

4. (Optional) To change the user's space limits:
4a. Make certain that the Limit Volume Space check box is selected.
4b. Enter a value in the Volume Space Limit field.
This value is in KB. If you enter 5000, the user can use a maximum of 5,000,000 bytes, or 5 
megabytes of volume space.
Each file or directory thuse owns occupies a portion of the user's alloted space..
Access is denied if the user tries to create new files or increase the size of existing files after the 
space limit is exceeded.

5. To return to the User Space Limits page, choose OK.



Volume User Space Limits - Modify Button
The Modify button opens a dialog that lets you change a user's volume space restriction. You can also 
remove the space restriction for the user.
The dialog that appears shows the user you selected and lets you enter a new value for the space 
restriction, or check a box to indicate that this user has no space restriction.



View a Directory Name 
The Identification page describes the directory you selected. On this page, you can

 View    the name of the directory
 View which name spaces are available on the volume in which this directory is located

Note: Use the Rename option on the Object menu to rename this directory.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
See What Name Spaces Are Used on this Volume
See What This Directory Is Called in Each Available Name Space

Description of name space formats
DOS is used by IBM PC and compatibles, including MSWindows.

Macintosh is used by all Apple Macintosh computers.

FTAM is a standard file system used by many mainframe and minicomputers.

NFS (Network Filing System) is used by Unix and RISC workstations.

OS/2 is used by the IBM OS/2 Operating System on IBM PC and compatibles for OS/2 High 
Performance File System. Files and directories can have long names and properties similar to 
those used by NetWare Directory Services objects.

Related topics
Trustees and Trustee Paths
The [Root] Directory of a Volume - Assigning Rights



View or Change a File or Directory Name
This file or directory is located in a volume that is on a server running NetWare earlier than 3.11. This 
volume does not support name spaces for different file formats. The Identification page describes the file 
or directory.
On this page, you can 

 View the name of a file or directory
 Rename a file or directory

Important: OK and Cancel affect the entire Object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Rename a File or Directory

Related topics
Trustees and Trustee Paths
The [Root] Directory of a Volume - Assigning Rights



Rename a File or Directory
1. Select the New Name field.
2. Enter a new name for the file or directory.
3. Choose OK.



Directory Facts 
The Facts page shows statistical information about this directory. On this page, you can

 View the date and time this directory was created
 Change the owner of the directory

Important: OK and Cancel affect the entire Object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Restrict the Size of a Directory
Change the Owner of the Directory
Change the Date or Time the Directory Was Last Modified
Change the Date or Time the Directory Was Last Archived
Change Who Last Archived the Directory

Screen regions and buttons
KB Available to Directory shows the number of kilobytes available to the directory.

Restrict Size shows whether the directory is restricted in size.

Limit shows the directory's maximum number of 4K blocks (if directory size is restricted).

Created shows when the directory was first created.

Owner shows the owner of this directory.

Last Modified shows the last time the directory was modified.

Last Archived shows the last time the directory was archived. This field and the Archiver field are set 
when the Archive attribute of this directory is reset by a backup application.

Archiver shows who last archived the directory.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.

Related topics
Trustees and Trustee Paths
The [Root] Directory of a Volume - Assigning Rights



Restrict the Size of a Directory
1. Select the Restrict Size check box.
2. Select the Limit field.
3. Enter the number of 16 KB blocks this directory is limited to.

Any value up to the number of free blocks on the volume can be entered.
4. Choose OK.



Change the Owner of a Directory
1. Select the browser button to the right of the Owner field.
2. Select a user that should be the owner of this directory.
3. Choose OK.



Change the Last Modified Date or Time of a Directory
1. Select the section of the Modified date or time field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. Advance the date or time using the Up-arrow.
2b. Turn back the date or time using the Down-arrow.

3. Choose OK.



Change the Last Archived Date or Time of a Directory
1. Select the section of the Last Archived date or time field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. Advance the date or time using the Up-arrow.
2b. Turn back the date or time using the Down-arrow.

3. Choose OK.



Change Who Last Archived a Directory
1. Select the browser button to the right of the Archiver field.
2. Select the user that last archived (backed up) this directory.
3. Choose OK.



Directory Attributes - NetWare 2 and 3 Directories    
The Attributes page shows attribute information about this directory or volume. On this page, you can

 See which attributes are assigned to this directory
 Change attributes of this directory

If you select a volume, the attributes are for the [Root] directory of that volume. Any attribute that is 
checked is in effect for this directory.
Important: OK and Cancel affect the entire Object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Change the Directory Attributes

Screen regions and buttons
Directory Attributes shows the attributes of this directory.



Directory Attributes 
The Attributes page shows attribute information about this directory or volume. On this page, you can

 See which attributes are assigned to this directory
 Change attributes of this directory

If you selected a volume, the attributes are for the [Root] directory of that volume. Any attribute that is 
checked is in effect for this directory.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Change the Directory Attributes

Screen regions and buttons
Directory Attributes shows the attributes of this directory.



Change the Directory Attributes
Directory attributes describe how users can use a directory and how NetWare treats a directory. You can 
set the attributes to suit your working environment.

To change directory attributes
1. Select the check box for the attribute you want to change.
2. Choose OK.



Directory Attributes List

Directory attributes
Delete Inhibit
Hidden
Purge
Rename Inhibit
System
Don't Migrate
Immediate Compress
Don't Compress



Directory Attributes List - v2.x and v3.x directories

Directory Attributes
Delete Inhibit
Hidden
Purge
Rename Inhibit
System



View a Filename 
The Identification page describes this file. On this page, you can

 View the name of the file
 View which name spaces are available on the volume where this file is located

Note: Use the Rename option on the Object menu to rename this file.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
See What Name Spaces Are Used on this Volume
See What this File is Called in Each Available Name Space

Description of name space formats
DOS is used by IBM PC and compatibles, including MSWindows.

Macintosh is used by all Apple Macintosh computers.

FTAM is used by many mainframe and minicomputers.

NFS (Network Filing System) is used by Unix and RISC workstations.

OS/2 is used by the IBM OS/2 Operating System on IBM PC and compatibles for OS/2 High 
Performance File System. Files and directories can have long names and properties similar to 
those used by NetWare Directory Services objects.

Related topics
Trustees and Trustee Paths



File Facts 
The Facts page shows statistical information about this file.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Change the Owner of a File
Change the Date or Time a File Was Last Modified
Change the Date or Time a File Was Last Archived
Change Who Last Archived a File
Change the Search Mode for a File

Screen regions and buttons
Size shows the space used by this file in bytes.

Created shows when the file was first created.

Owner shows the owner of this file.

Last Modified Date and Time shows when the file was last modified.

Modifier shows who last modified the file.

Last Accessed Date and Time shows when the file was last accessed.

Last Archived Date and Time shows when the this file was last archived. This field is set whenever the
Archive attribute of this file is reset by a backup application.

Archiver field shows who last archived the file. This field is set whenever the archive attribute of this 
file is reset by a backup.

Search Mode shows how this file is treated by using the Search feature. This field only appears if you 
are viewing information for an executable (.EXE) file.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Search Mode
Search modes determine how NetWare looks for files, such as data files or auxiliary program files. Search
modes can be defined for any file, but only application files (files with an .EXE or .COM extension in DOS)
really use them.
A NET.CFG file can contain a search mode that applies to all files unless a different search mode is 
specified for a particular file
When an application requests a file, it can include a path with the filename, or just the filename. It can 
also specify that the file is to be read, but not written to. This is called a Read Only open.
Note: The Search Mode field only appears on Facts if you are viewing information for an executable 
(.EXE) file.

Screen regions and buttons
Shell Default uses the search mode defined in the user's NET.CFG file. (Equivalent to value 0 in the 

text utilities.)

Search on All Opens with No Path looks for the file first in the default directory, and then in each 
search drive. (Equivalent to value 5 in the text utilities.)

Do Not Search looks for the file only in the path included with the filename and in the default directory.
Search drives are not checked. (Equivalent to value 2 in the text utilities.)

Search on Read Only with No Path looks for the file first in the default directory, and then, if the file is 
to be opened for Read Only, in each search drive. (Equivalent to value 7 in the text utilities.)

Search on All Opens looks for the file first in the path specified with the file, then in the default 
directory, and then in each search drive. (Equivalent to value 1 in the text utilities.)

Search on All Read Only Opens looks for the file first in the path included with the filename, then in 
the default directory, and then, if the file is to be opened for Read Only, in each search drive. 
(Equivalent to value 3 in the text utilities.)



Change the Owner of a File
Note: You must have the supervisor right to the file in order to change the owner.
1. Select the Owner field.
2. Choose the browser icon to the right of the Owner field and select the user that should own this file.
3. Choose OK.



Change the Last Modified Date of a File
1. Select the section of the Last Modified date or time field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. Advance the date or time using the Up-arrow.
2b. Turn back the date or time using the Down-arrow.

3. Choose OK.



Change the Last Archived Date and Time of a File
1. Select the section of the Last Archived date or time field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. Advance the date or time using the Up-arrow.
2b. Turn back the date or time using the Down-arrow.

3. Choose OK.



Change Who Last Archived a File
1. Select the Archiver field.
2. Enter the name of the user that last archived this file. Or, you can select a User object by choosing 

the icon to the right of the Archiver field.
3. Choose OK.



Change the Search Mode of a File
Note: The Search Mode field only appears on Facts if you are viewing information for an executable 
(.EXE) file.
1. Select the Down-arrow on the right side of the Search Mode field.

A drop box appears listing options.
2. Select a search mode option.

The option you selected is displayed.



File Attributes for NetWare v2.x and v3.x Files    
The Attributes page shows attribute information about this file. On this page, you can

 See which attributes are assigned to this file
 Change attributes of this file

Any attribute that is checked is in effect for this file.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Change the File Attributes

Screen regions and buttons
File Attributes shows the attributes of this file.



File Attributes 
The Attributes page shows attribute information about this file. On this page, you can

 See which attributes are assigned to this file
 Change attributes of this file

Any attribute that is checked is in effect for this file.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Change the File Attributes

Screen regions and buttons
File Attributes shows the attributes of this file.
File Status shows the flags that NetWare has set for this file. You can't modify the file status.



Change the File Attributes
File attributes describe how users can use a file and how NetWare treats a file. You can set the attributes 
to suit your working environment.

To change the file attributes
1. Choose the attribute you want to change.

If the attribute was checked, it will be cleared. If the attribute was clear, it will be checked. Any 
attribute that is checked is in effect for this file.

2. Choose OK.



File Attributes List

File attributes
Archive Needed
Execute Only
Read Only
Shareable
Hidden
System
Transactional
Purge [Immediate]
Read Audit
Write Audit
Copy Inhibit
Delete Inhibit
Rename Inhibit
Don't Migrate
Immediate Compress
Don't Compress



File Status
File status flags are like file attributes, but you cannot set them. They are set automatically to indicate the 
current state of the file.

File status flags
Can't Compress
File Compressed
File Migrated



File Attributes List - v2.x and v3.x files

File attributes
Archive Needed
Execute Only
Read Only
Shareable
Hidden
System
Transactional
Purge [Immediate]
Read Audit
Write Audit
Copy Inhibit
Delete Inhibit
Rename Inhibit



View or Change a Distribution List Object    
The Identification page describes this Distribution List object On this page, you can

 Enter the full name of this Distribution List
 Specify the person responsible for this Distribution List

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Full Name for This Distribution List
Enter an Owner for This Distribution List
Enter a Description for This Distribution List

Screen regions and buttons
Name displays the complete name of this Distribution List.

Full Name displays another name (a common name) this Distribution List is known by.

Owner displays the person who is responsible for administrating this Distribution List.

Description displays information that helps identify this Distribution List.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



View or Change an External Entity Object    
The Identification page describes this External Entity object. On this page, you can

 Specify the External Name of this External Entity
 Enter a description of this External Entity

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Add an External Name for This External Entity
Enter a Description for This External Entity

Screen regions and buttons
Name displays the complete name of this External Entity.

External Name displays the name this External Entity is known by in its native messaging 
environment.

Description displays information that helps identify this External Entity.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



View or Change a Message Routing Group Object    
The Identification page describes this Message Routing Group object. On this page, you can

 Add another name this Message Routing Group is known by
 Specify users who are administrators of this Message Routing Group

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for This Message Routing Group
Add Another Name for This Message Routing Group
Add a Postmaster General to This Message Routing Group

Screen regions and buttons
Name displays the complete name of this Message Routing Group.

Other Name displays other names this Message Routing Group is known by.

Postmaster General displays the users who can administer this Message Routing Group.

Description displays information that helps identify this Message Routing Group.

Location displays where this Message Routing Group is located.

Department displays the department this Message Routing Group reports to.

Organization displays the organization that this Message Routing Group reports to.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



View or Change a Messaging Server Object 
The Identification page describes this Messaging server object. On this page, you can

 View the name of the NetWare server that this Messaging server resides on
 View the location of this Messaging server in the MHS Database
 View or change the description of what this Messaging server is used for

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Add Another Name for This Messaging Server
Enter a Description for This Messaging Server
Enter a Location for This Messaging Server
Enter a Department for This Messaging Server
Enter an Organization for This Messaging Server

Screen regions and buttons
Name displays the complete name of this Messaging server.

NetWare Server displays the path to the NetWare server where this Messaging server resides.

MHS Database Location displays the location where the MHS Database directory was installed and 
currently resides.

Other name displays other names that refer to this Messaging server.

Description displays information that helps identify this Messaging server.

Location displays the physical location of this Messaging server.

Department displays the department that uses this Messaging server.

Organization displays the organization that uses this Messaging server.

Status displays the current status of your Messaging server. If you have a messaging application 
installed, the Status field displays Up, which means the Messaging server is able to handle 
messages. If you have no messaging application installed, the Status field displays Down.

Version displays the version of NetWare MHS Services installed on this Messaging server.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Enter an External Name for This External Entity
The purpose of the External Name text box is to record the name this object is known by in its native 
messaging environment. This name is the object's common Email name, not a complete name like the 
one displayed in the Name text box 
The External Name property is unique to an External Entity object.

To enter an External Name
1. Select the External Name text box.
2. Type the name that this object is known by in its native messaging environment. The information 

scrolls to the right if you continue to type once you've reached the right margin of the text box. You 
can enter up to 256 characters.

3. Choose OK.
The information is saved to NetWare Directory Services when you choose OK.



View or Change the Messaging Servers
The Messaging Servers page displays the Messaging servers that are members of the selected Message 

Routing Group. The Messaging servers in a Message Routing Group can send and receive 
messages directly among each other.

On this page, you can add or delete Messaging servers.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Add a New Messaging Server
Delete an Existing Messaging Server

Screen regions and buttons
Add lets you add Messaging servers to the selected Message Routing Group.

Delete removes from the Message Routing Group the Messaging server that you select.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



View or Change the Message Routing Groups
The Message Routing Groups page displays the Message Routing Groups that the selected Messaging 
server belongs to. On this page, you can

 Add a Message Routing Group that the selected Messaging server belongs to.
 Delete a Message Routing Group that the selected Messaging server currently belongs to.

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Add a New Message Routing Group
Delete an Existing Message Routing Group

Screen regions and buttons
Add lets you add Message Routing Groups that the selected Messaging server belongs to.

Delete removes Message Routing Groups that the selected Messaging server currently belongs to.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



View or Change the List of Supported Gateways
The Supported Gateways page displays the protocols that are supported by the selected Messaging 
server. On this page, you can add or delete Supported Gateways.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Add a New Supported Gateway
Delete an Existing Supported Gateway

Screen regions and buttons
Add lets you add a Supported Gateway to this Messaging server.

Delete removes from the Messaging server the Supported Gateway that you select.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add a Message Routing Group to this Messaging Server
1. From the Message Routing Groups page, choose Add.
2. Select the Message Routing Groups you want to add to the Messaging server.
3. Choose OK.

Any Message Routing Group you selected is added to the Messaging server's Message Routing 
Groups list.
Note: The Messaging server object is automatically placed in the Messaging servers list of each 
Message Routing Group that you add.



Delete a Message Routing Group from this Messaging Server
1. From the Message Routing Groups list, select a Message Routing Group.
2. Choose Delete.

The Message Routing Group is deleted from the list.



Add a Supported Gateway to this Messaging Server
1. From the Supported Gateways page, choose Add.
2. In the Name text box, type the name of the Supported Gateway.
3. In the Protocol text box, type the name of the messaging protocol; or, select the list box to the right of 

the Protocol text box and then select the appropriate messaging protocol from the list.
The Supported Gateway provides messaging connectivity between the messaging protocol you select
and your MHS services.

4. Choose OK.
A Supported Gateway is added to the Supported Gateways list.

5. (Optional) To add another Supported Gateway, repeat this procedure.



Delete a Supported Gateway from this Messaging Server
1. From the Supported Gateways list, select a Supported Gateway.
2. Choose Delete.

The Supported Gateway is deleted from the list. The selected Messaging server can no longer send 
mail to or receive mail from an entity that is using the messaging protocol of the deleted Supported 
Gateway.



View or Change the List of Postmasters
The Postmasters page displays the postmasters of this Messaging server. Postmasters have the right to 
manage the Messaging server they reside on. For example, they can add or delete users (whose 
mailboxes reside on the Messaging server) from the Messaging server. On this page, you can

 View the current postmasters of this Messaging server
 Add or delete postmasters

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Add a New Postmaster
Delete an Existing Postmaster

Screen regions and buttons
Postmasters lists the complete name of each object that has rights to manage this Messaging server.

Add lets you add a Postmaster to this Messaging server.

Delete removes (from this Messaging server) the Postmaster you select.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



View or Change the List of Users
The Users page displays the list of users whose mailboxes reside on this Messaging server. On this page,
you can add or delete users.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Add a New User
Delete an Existing User

Screen regions and buttons
Add lets you add a user to this Messaging server.

Delete removes from this Messaging server the user that you select.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add a Postmaster to this Messaging Server
Rights needed: the write property right to the Postmaster property of the Messaging server. If you 
have the Supervisor object right to the Messaging server, this requirement is filled.

1. From the Postmasters page, choose Add 
2. Select each object that you want to add as a postmaster on this Messaging server.
3. Choose OK.

Any object you selected is added as a postmaster on this Messaging server and appears on the 
Messaging server's Postmasters list.



Delete a Postmaster from this Messaging Server
Rights needed: The delete object right to the Messaging server.
If you have the Supervisor object right to the Messaging server, this requirement is filled.
1. From the Postmasters list, select a postmaster .
2. Choose Delete.

The postmaster you selected is deleted from the list.



View or Change an Object's Foreign Email Address and Aliases
The Foreign Email Address page allows you to view or change address information about this object. On 
this page, you can

 View the foreign Email address and foreign Email aliases of the object
 Set or clear a foreign Email address
 Add or delete foreign Email aliases

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
How to Use the Object Dialog
Set a Foreign Email Address
Add a Foreign Email Alias
Delete a Foreign Email Alias

Screen regions and buttons
Foreign Email Address specifies a NetWare Directory Services object's mailbox that resides in a 

foreign Email system. For example, an NDS user can choose to have Email delivered to a UNIX 
machine which supports SMTP messaging protocol. This user's SMTP address in the UNIX 
machine--the SMTP native name--is the user's foreign Email address. An NDS object can have 
only one foreign Email address.

Set lets you add a foreign Email address for this object.

Clear deletes the Foreign Email address in the Foreign Email Address text box.

Foreign Email Aliases specifies an object's aliases as known in a foreign messaging system. For 
example, an MHS user (a user whose mailbox is in an MHS messaging server) can have an 
X400 alias--with an X400 native name--so that X400 users can use this alias to send mail to the 
MHS user. An object can have several Foreign Email Aliases, one for each type of foreign Email 
system.

Add lets you add a Foreign Email Alias.

Delete removes the Foreign Email Aliases that you select.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Set a Foreign Email Address
1. In the Foreign Email Address text box, choose Set.
2. In the Name text box, type the name of the foreign address.

Use the native naming conventions for whatever messaging protocol the selected object uses to 
receive mail.

3. In the type text box, type the name of the messaging protocol that the selected object uses to receive 
mail; or, select the drop-down arrow button to the right of the Type text box, and then select the 
appropriate messaging protocol from the list.

4. Choose OK.
A foreign Email address is added to the Foreign Email Address text box.



Add a Foreign Email Alias
1. In the Foreign Email Aliases text box, choose Add.
2. In the Name text box, type the name of a foreign address.

Use the native naming conventions for whatever messaging protocols the selected object uses to 
receive mail.

3. In the type text box, type the name of the messaging protocol that the selected object uses to receive 
mail; or, select the drop-down arrow button to the right of the Type text box and then select the 
appropriate messaging protocol from the list.

4. Choose OK.
A Foreign Email Alias is added to the Foreign Email Address text box.

5. (Optional) To add another Foreign Email Alias for this object, repeat this procedure.



Delete a Foreign Email Alias
1. From the Foreign Email Aliases list, select a Foreign Email Alias.
2. Choose Delete.

The Foreign Email Alias is deleted from the list. This object can no longer receive mail from a sender 
who is using the messaging protocol of the deleted alias.



Add a Messaging Server
1. From the Messaging Servers page, choose Add.
2. Select any Messaging servers that you want to add to the Message Routing Group.
3. Choose OK.

Any Messaging server you selected is added to the Message Routing Group and appears in the 
Messaging Servers list.
Note: The Messaging server object is automatically placed in the Message Routing Groups list of 
each Messaging server that you add.



Delete a Messaging Server
1. From the Messaging Servers list, select a Messaging server.
2. Choose Delete.

The Messaging server is deleted from the list.



Enter a Full Name for this Distribution List Object
The Full Name text box can record any common name that you think is useful for this Distribution List 
object. You can add only one alternative name for this object. You can use this name to search for this 
object.

To enter a full name for this object
1. Select the Full Name text box.
2. Type the full (common) name you want recorded as a property of this object.
3. Choose OK.

The information is saved to NetWare Directory Services when you choose OK.



View or Change the Members of a Distribution List Object
The Members page lists all of the members of the Distribution List. When the Distribution List is used as a
recipient in a message, each object in this list receives a copy of the message. Objects may be added to 
or deleted from the list using this dialog.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Member to This Distribution List
Delete a Member from This Distribution List

Screen regions and buttons
List Members lists the complete name of each object that is a member of this Distribution List.

Add lets you select objects to add as members of this Distribution List.

Delete removes (from this Distribution List) the objects you select.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add a Member to this Distribution List Object
Rights needed: The write property to the Members property of the Distribution List.

If you have the Supervisor object right to the Distribution List, this requirement is filled.
1. From the List Members Page, choose Add.
2. Select each object that you want to add as a member of this Distribution List.
3. Choose OK.

Any object you selected is added as a member of this Distribution List and appears on the List 
Members list.



Delete a Member from this Distribution List Object
Rights needed: The Delete object right to the Distribution List.
If you have the Supervisor object right to the Distribution List, this requirement is filled.
1. From the List Members list, select an object.
2. Choose Delete.

The object you selected is deleted from the list.



View Mailbox Information about an Object
Use the Mailbox page to see Mailbox Location and Mailbox ID for Organization, Organizational Role, 
Organizational Unit, Group, and User objects.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedure
Set a Mailbox Location
Set a Mailbox ID

Screen regions and buttons
Mailbox Location specifies the Messaging server where this object's mailbox resides.

Mailbox ID displays a unique name that allows this object's mailbox to be located in the messaging 
database.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Set a Mailbox Location for this Object
The Mailbox Location text box can record the name of the Messaging server where this object's mailbox 
is physically located.
Mailbox Location is a property of Organization, Organizational Role, Organizational Unit, Distribution List, 
Group, and User objects in NetWare Directory Services.

To set a mailbox location
1. Choose the browser button to the right of the Mailbox Location text box.
2. Select the Messaging server on which this object's mailbox resides.
3. Choose OK.

The complete name of Messaging server object you selected from the browser appears in the 
Mailbox Location text box. 
The information is saved to NetWare Directory Services when you choose OK.



Set a Mailbox ID for this Object
After the Mailbox Location text box is filled in, the Mailbox ID text box automatically displays the ID of this 
object. The assigned Mailbox ID is the name of the directory in which all of the object's inbound mail is 
placed.
This means you don't have to manually set a Mailbox ID. It's done for you when you choose a Mailbox 
Location.
However, you can change the default name of the Mailbox ID. You would want to change the ID if, for 
example, you rename an object.
You can enter from 1 to 8 characters each, using the alphabet letters (lower and uppercase), numbers (0-
9), the hyphen (-), the dollar sign ($), and the pound sign (#).
Mailbox ID is a property of Organization, Organizational Role, Organizational Unit, Distribution List, 
Group, and User objects in NetWare Directory Services.

To set a mailbox ID
1. Select the Mailbox ID text box.
2. Type the common name of this object, up to eight characters.
3. Choose OK.

The information is saved to NetWare Directory Services when you choose OK.



Enter a Postmaster General
A Postmaster General is a user who has the Supervisor object right to the Message Routing Group 
that he or she resides in. Postmaster Generals can add a messaging server to, or remove a 
messaging server from, the Message Routing Group.

1. Select the browser button to the right of the Postmaster General field.
2. Choose Add.
3. Select each object that you want to add as a Postmaster General of this Message Routing Group.
3. Choose OK.

Any object you selected is added as a Postmaster General of this Message Routing Group.
4. To save all changes, choose OK.





Create a User Object 
A User object represents a user on the network. One User object must exist for every user who will log in 
to the network.

To create a user
You must follow the user naming conventions.

1. Type the user's name in the Login Name field.
The user uses this name to log in to the network. This name also appears in the Directory tree.

2. Type the user's surname in the Last Name field.
 (Optional) To complete the fields of this new User object with the default information entered in the 

User_Template object for this container, choose Use User Template.
 (Optional) To define additional information about this User object immediately after creating it, choose 

Define Additional Properties.
You cannot choose this if you choose Create Another User.

 (Optional) To create another user immediately after this one, choose Create Another User.
You cannot choose this if you choose Define Additional Properties.

 (Optional) To automatically create a home directory for this user, choose Create Home Directory.
If you choose this option, you must also define a path and directory name for the user's home 
directory.
If you choose this option, this user is granted all rights to this directory.

3. Define a directory for this user's home directory.
3a. Choose the browser icon  to the right of the Path field to select a volume (root directory) or 

other sub directory that will hold this user's home directory.
3b. Type a directory name in the Home Directory field.

The user's login name is generally used as the directory name.
4. Choose Create.

If you chose Define Additional Properties, the User object dialog appears.
If you chose Create Another User, the Create User Object dialog appears again.
If you chose Create Home Directory, a directory is created on the selected volume.

Screen regions and buttons
Login name is the name of this User object in the Directory tree and the name the user enters to log 

in to the network.

Last name shows the user's last name or other identification information that you store in this field.

Use User Template applies default values to properties for this user.

Define Additional Properties lets you define more information about this User object immediately after 
creating it, such as a password or login script commands.

Create another User repeats this dialog.

Create Home Directory creates the home directory described in Path and Home Directory and makes 
the user a trustee of the directory.

Path lets you choose a path on a volume where you want to create the home directory for this user. A 
path such as \USERS or \HOME is often used to hold all users' home directories. This field is only
used if Create Home Directory is selected.

Home Directory is the name of the directory that is created for this user, and to which this user is 
granted rights, if Create Home Directory is selected.

Create creates the new User object.

Cancel returns you to the browser without creating a User object.





Create a User Template Object
The User Template object contains user defaults. With the User Template object, you can define your own
default property values for new users. Whenever you create a new user, NetWare Administrator will 
automatically copy the information from the User Template object to the new user.
There are three ways you can create the User Template:

 Create a User object and name it User_Template.
 Select Define User Defaults when creating an Organizational Unit object.
 Choose User Template from the Object menu after creating an Organizational Unit object.

NetWare Administrator first looks for the User Template object in the context of the new user. If it doesn't 
find it there, it checks in succeeding parent objects until it finds one or encounters the [Root].
You cannot apply user defaults to existing users. If you change the user defaults, the changes apply only 
to the users created after that; they do not apply to users that were previously created using user defaults.
You can use defaults to complete general user information, then make changes to any specific fields in 
the User object dialog.

Procedures
View or Change the User Defaults of a Container



View or Change the User Defaults of a Container
Note: You cannot apply user defaults to existing users. If you change the user defaults, the changes apply
only to the users created after that; they do not apply to users that were previously created using user 
defaults.
1. Select the Organizational Unit object that will contain the new users you want to apply defaults to.
2. From the Object menu, choose User Template.

If Define User Defaults was chosen when this Organizational Unit was created, you can edit the 
existing user defaults. If Define User Defaults was not chosen, the program creates a new object 
called User_Template, which you can edit.

3. Enter or change information in the appropriate pages.
4. Choose OK.
Related topics

Using User Defaults When Creating a User Object
Using the Pages of the Object Dialog



Login Name of a User
The login name is the name that the user enters to log in to the network (this name appears in the 
Directory tree). Your organization may decide to standardize how new login names are entered.

Login Name Restrictions
 The login name must be unique in the container of the Directory tree where the user is located.

In other words, if users Debra Jones and David Jones are in the same Organizational Unit, only one 
of them can use the login name djones. However, if they are in different containers, they can use the 
same login name.

 The login name can be up to 64 characters long.
 Any special characters can be used, unless this user needs to log in from a NetWare 2 or 3 

workstation, in which case you should avoid special characters (see below).
Note: If you have workstations using different code pages, you should only use characters that 

appear in the code page of all systems on the network. For example, a name entered when 
creating an object in code page 937 (Japanese) will contain unreadable characters when viewed 
in code page 850 (international). See your DOS or OS/2 manual for more information about code 
pages.

 Names are displayed in uppercase and lowercase letters as they were first entered, but they are not 
case-sensitive. So DJones and DJONES are considered to be identical names.

 Spaces and underscores can be used, and they will be displayed as they were first entered, but they 
are considered to be the same. So Dave_Jones and Dave Jones are the same.

Note: If you use spaces in an object name, you must always enclose the object name in quotation 
marks when entering it on the command line or in login scripts. For this reason, you may want to 
avoid spaces in login names.

Login Name Restrictions for Bindery Services
When creating users who will log in as bindery users, the names of User objects must match bindery 
naming rules, or the user will not be able to log in.

 Spaces in object names are replaced by underscores in Bindery Services.
 Object names longer than 47 characters are cut off after the 47th character.
 The following characters cannot be used in an object name that must be accessed using Bindery 

Services:
/ Slash
\ Backslash
: Colon
, Comma
* Asterisk
? Question mark



Object Naming Conventions
Although you can use almost anything for an object name, it will simplify network management and 
reduce users' problems if you use simple, relatively short object names.
The rules below apply to most objects, including User, Volume, Organization, and Organizational Unit 
objects. Special rules apply to Country objects, which can only have a two-character name, and to 
NetWare Server objects. More information is also provided elsewhere for User object names (Login 
Names).

Object Name Restrictions
 The name must be unique in the branch (container) of the Directory tree where the object is located.

In other words, if users Debra Jones and David Jones are in the same Organizational Unit, only one 
of them can use the object name djones. However, if they are in different containers, they can use the
same object name.

 The object name can be up to 64 characters long.
 Any special characters can be used, unless this object needs to be accessed from a NetWare 2 or 3 

workstation, in which case you should avoid special characters.
Note: A few special characters like plus (+), equals (=), and period(.) must be preceded in the object 
name by a backslash. Avoid these characters if possible.
If you have workstations using different code pages, you should only use characters that appear in the 
code page of all systems on the network. For example, a name entered when creating an object in code 
page 937 (Japanese) will contain unreadable characters when viewed in code page 850 (international). 
See your DOS or OS/2 manual for more information about code pages.

 Object names are displayed with uppercase and lowercase letters as they were first entered, but they 
are not case-sensitive. So ManagerProfile and MANAGERPROFILE are considered identical names.

 Spaces and underscores can both be used, and they will be displayed as they were first entered, but 
they are considered to be the same. So Manager_Profile and Manager Profile are the same.
Note: If you use spaces in an object name, you must always enclose the object name in quotation marks 
when entering it on the command line or in login scripts. For this reason, you may want to avoid spaces in
object names.

Object Name Restrictions for Bindery Services
When creating objects that will be accessed from a NetWare 2 or 3 workstation through Bindery Services,
the names of objects must match bindery naming rules, or the NetWare 2 or 3 workstation cannot see 
them.

 Spaces in object names are replaced by underscores
 Object names longer than 47 characters are cut off after the 47th character
 The following characters cannot be used in an object name:

/ Slash
\ Backslash
: Colon
, Comma
* Asterisk
? Question mark



NetWare Server Object Naming Conventions
The general object naming rules allow more flexibility than those for naming a NetWare Server object.

NetWare Server Name Restrictions
 The Directory Services (DS) server name must match the name that the server advertises to the 

network through Service Advertising Protocol (SAP). Since SAP requires unique names, every server 
name must be unique within the entire DS tree as well as the network. There cannot be two objects 
named TEST in the same network. This applies to NetWare 2, 3, and 4 servers.

 You can't create server objects for NetWare 4 servers that comprise part of the DS tree. The install 
NLM (NetWare Loadable Module) creates these objects when you install a NetWare 4 server.

 From NetWare Administrator, you can create Server objects which refer to NetWare 2 and 3 (bindery) 
servers. You can also create Server objects to refer to NetWare 4 servers that are part of a different DS 
tree. These servers will be treated as bindery servers. NetWare Administrator will prevent you from 
creating Server objects which refer to servers that are not running, or are running but are part of the DS 
tree in which you're working. If the server is not part the DS tree in which you're working, you can create 
multiple objects which refer to it.

 From NetWare Administrator, you can't rename a NetWare Server object, even if you have the 
Supervisor object right to it.

 Naming rules for servers



Server Naming Rules
These rules are provided as information only. Every NetWare Server object must be named by an existing
physical server that was created with INSTALL.NLM at the server console. 
You cannot rename a NetWare Server object.
The physical name of a NetWare server

 Must be 2 to 47 characters long
 Can contain letters A-Z, numbers 0-9, hyphens, periods, and underscores
 Cannot use a period as the first character



Physical Volume Naming Rules
Whenever you install a new server in your Directory Services (DS) tree, the install program creates 
Volume objects for all volumes on the server being installed. Unlike servers, the DS Volume object name 
does not have to match a volume name on a server, and there can be more than one DS volume object 
referring to the same volume.
However, you may decide to follow the same convention as the install program when it creates volumes 
for servers: server name, underscore, volume name.
For example: SERVER2_SYS
A Volume object that points to a physical volume contains the physical volume name as a property, 
though the Volume object can be named anything that follows the object naming conventions.
The physical name of a NetWare volume

 Must be 2 to 15 characters long
 Can contain letters A-Z, numbers 0-9, hyphens, periods, and underscores
 Cannot use a period as the first character
 Cannot contain spaces, colons, asterisks, question marks, or backslashes



Create a Volume Object 
A Volume object provides a place in the Directory database to record and view information about a 
physical volume that was installed on a NetWare Server.
NetWare 4 volumes are created when NetWare Servers are installed. You can create other Volume 
objects that refer to the same physical volume as an existing Volume object. You can also create Volume 
objects for non-NetWare 4 volumes, if you have created NetWare Server objects for the servers on which 
they reside.
By creating a Volume object and pointing it to a physical volume, you can see the directories and files on 
the volume from within NetWare Administrator and other utilities. The Volume object is a reference from 
NetWare Directory Services to a physical volume. Information about both appears when you view details 
of a Volume object.
There are no subordinate Directory Services (DS) objects under Volume objects. However, NetWare 
Administrator browser shows directories and files as if they were part of the DS tree. The browser treats 
directories as containers and files as leaves.
A Volume object is a leaf object.

To create a new Volume object
1. In the Volume Name text box, type a name for this Volume object.

We recommend that you use the server name, followed by an underscore, followed by the volume 
name. For example: DOCSERVER_SYS. The only requirement is that you follow the object naming 
conventions.

2. Select the browser icon  to the left of the Host server text box.
3. Select the NetWare Server on which the volume resides.

The NetWare Server object must already exist. If it doesn't, you will need to go back to the browser, 
create the Server object, then restart this process.

4. In the Physical Volume Name text box, enter the volume's physical name.
You can type the name or choose one from the drop box. The drop box lists the physical volumes that
have been loaded on the NetWare server selected in Step 4.

 (Optional) To define additional information about this Volume object, choose Define Additional 
Properties.

You cannot choose this if you choose Create Another Volume.
 (Optional) To create another Volume immediately after this one, choose Create Another Volume.

You cannot select this if you choose Define Additional Properties.
5. Choose Create.

If you chose Define Additional Properties, the Volume Object dialog appears.
If you chose Create Another Volume, this dialog appears again.

Screen regions and buttons
Volume Name is the name of the Volume object as it will appear in the browser.

Host Server is the name of the NetWare server on which the physical volume resides. The 

Physical Volume Name is the name of the volume loaded on the server (e.g.: SYS:).

Define Additional Properties allows you to define more information about this Volume immediately 
after creating it.

Create Another Volume repeats this dialog rather than returning to the browser.

Create creates the new Volume object.

Cancel returns you to the browser without creating a Volume.



Create a Volume Object - Naming a Volume Object
The name of the Volume object for NetWare Directory Services can include

 The name of the area where this volume is used
 The server it resides in
 Its physical name

The Volume object name is not the same thing as the physical volume name, although you can use the 
same name for both.
Example: The name of the physical volume is SYS:. You create the new Volume object under the 
MARKETING Organizational Unit. To describe its location, you name the Volume object 
MARKETING_SYS.



Create a NetWare Server Object 
A NetWare Server object allows NetWare Directory Services a way to refer to a physical server. 
Information is stored in the NetWare Server object's properties about the physical location of the server, 
what services it provides, and how those resources are used and accounted for.
For NetWare 4 servers that are part of this DS tree, you must use INSTALL.NLM on each NetWare server
to create the first NetWare Server object for each physical server. There can be only one NetWare Server 
object for each NetWare 4 server that you have installed as part of the DS tree.
You can create a NetWare Server object that points to a NetWare 3 or NetWare 2 (bindery) server, or a 
NetWare 4 server that is part of another DS tree, if the server is running. You can create more than one 
reference to a bindery server, as long as the references are in different contexts.
A NetWare Server is a leaf object.

To create a new NetWare Server object under the selected container
1. In the NetWare Server Name text box, type a name for this NetWare Server object.

The server name must match the name of the server it is referring to. See NetWare Server object 
naming conventions.

 (Optional) To define additional information about this NetWare Server immediately after creating it, 
choose Define Additional Properties.

You cannot choose this if you chose Create another NetWare Server.
 (Optional) To create another NetWare Server object immediately after this one, choose Create Another 

NetWare Server.
You cannot choose this if you chose Define Additional Properties.

2. Choose Create.
If you chose Define Additional Properties, the NetWare Server object dialog appears.
If you chose Create another NetWare Server, this dialog appears again.

Screen regions and buttons
Server Name shows the name of the NetWare Server object.

Define Additional Properties allows you to define more information about this NetWare Server object, 
such as which services it provides.

Create Another NetWare Server repeats this Create a NetWare Server Object dialog.

Create creates the new NetWare Server object.

Cancel returns you to the browser without creating a NetWare Server object.



Create an AFP Server Object 
AFP Server is a leaf object.

To create a new AFP Server object
1. In the AFP Server Name text box, type a name for this AFP Server object.

You must follow the object naming conventions.
 (Optional) To define additional information about this AFP Server object right now, choose Define 

Additional Properties.
You cannot choose this if you chose Create another AFP Server.

 (Optional) To create another AFP Server immediately after this one, choose Create Another Server.
You cannot choose this if you chose Define Additional Properties.

2. Choose Create.
If you chose Define Additional Properties, the AFP Server object dialog appears.
If you chose Create Another AFP Server, this dialog appears again.

Screen regions and buttons
Server Name shows the name of the AFP Server object.

Define Additional Properties lets you define more information about this AFP Server object.

Create Another AFP Server repeats this dialog.

Create creates the new AFP Server object.

Cancel returns you to the browser without creating an AFP Server object.



Create a Computer Object 
Computer is a leaf object.

To create a new Computer object
1. In the Computer Name text box, type a name for this Computer object.

You must follow the object naming conventions.
 (Optional) To define additional information about the Computer object, choose Define Additional 

Properties.
You cannot choose this if you chose Create Another Computer.

 (Optional) To create another Computer object immediately after this one, choose Create Another 
Computer.

You cannot choose this if you chose Define Additional Properties.
2. Choose Create.

If you chose Define Additional Properties, the Computer object dialog appears.
If you chose Create Another Computer, this dialog appears again.

Screen regions and buttons
Computer Name displays the name for this Computer object.

Define Additional Properties lets you define more information about this Computer object.

Create Another Computer repeats this dialog.

Create creates the new Computer object.

Cancel returns you to the browser without creating a Computer object.



Create a Country Object 
A Country object

 Designates the countries where your network resides
 Organizes other NetWare Directory Services objects within the Country object

A Country object is a container object. You can create a Country object only under the [Root] object. 
Country can contain Organization and Organizational Unit objects.

To create a new Country object
1. In the Country Name text box, type the two-letter ISO country code for this Country.

(Optional) Use the Description field of the object dialog to enter the country's full name.
 (Optional) To define additional information about this Country object, choose Define Additional 

Properties.
You cannot choose this if you choose Create another Country.

 (Optional) To create another Country object immediately after this one, select Create Another Country.
You cannot choose this if you choose Define Additional Properties.

2. Choose Create.
If you chose Define Additional Properties, the Country object dialog appears.
If you chose Create Another Country, this dialog appears again.

Screen regions and buttons
Country name displays the two-letter ISO country code that designates the country. The full name of 

the country can be entered in other properties of the object using the object dialog.

Define Additional Properties allows you to define more information about this Country object 
immediately after creating it.

Create another Country repeats this dialog.

Create creates the new Country object.

Cancel returns you to the browser without creating a Country object.



Two-Letter Country Codes
Country objects can only use two characters as an object name. You should use the appropriate two-letter
ISO country code below. Use the Description field of the object dialog to enter the country's full name.
Common ISO country codes are

Argentina - AR
Australia - AU
Austria - AT
Belgium - BE
Brazil - BR
Canada - CA
China - CN
Denmark - DK
Finland - FI
France - FR
Germany - DD
Greece - GR
Hong Kong - HK
Ireland - IE
Israel - IL
Italy - IT
Mexico - MX
Netherlands - NL
Norway - NO
Portugal - PT
Puerto Rico - PR
Singapore - SG
South Africa - ZA
Spain - ES
Sweden - SE
Switzerland - CH
Taiwan - TW
United Kingdom - GB
United States - US
Venezuela - VE



Create a Group Object 
A Group object is a list of users located anywhere in the Directory tree. Group is a leaf object. 
You can grant rights to a Group object, rather than granting rights to individual members of a group. 
These rights transfer automatically by security equivalence to the members of the Group. Groups cannot 
have other groups as members.
Two other classes of objects are similar to groups: Organizational Role, and Distribution List.
Organizational Role has the same behavior as a group in that its occupants have security equivalence to 
the Organizational Role, but it was designed to have a small number of occupants. Groups are intended 
to have any number of members.
Distribution List is a NetWare MHS object, and is different than groups in that the members of a 
Distribution List don't have security equivalence to the Distribution List. In addition, Distribution Lists may 
have other Distribution Lists as members.

To create a new Group object
1. In the Group Name text box, type a name for this Group object.

You must follow the object naming conventions.
 (Optional) To define additional information about this Group immediately after the Group object is 

created, choose Define Additional Properties.
You cannot choose this if you choose Create Another Group.

 (Optional) To create another Group object immediately after this one, choose Create Another Group.
You cannot choose this if you choose Define Additional Properties.

2. Choose Create.
If you chose Define Additional Properties, the Group object dialog appears.
If you chose Create Another Group, this dialog appears again.

Screen regions and buttons
Group Name displays the name of the Group object.

Define Additional Properties lets you define more information about this Group object immediately 
after creating it.

Create Another Group repeats this dialog.

Create creates the new Group object.

Cancel returns you to the browser without creating a Group object.



Create an Organizational Role Object 
An Organizational Role object defines a position that can be filled by various people, such as Team 
Leader or Printing Manager.
You can grant rights to an Organizational Role object, rather than granting rights to the specific occupant 
of the position. These rights transfer automatically to the users listed as Occupants because the users are
security equals to the Organizational Role. If the person acting in a role changes, the trustee assignments
do not have to be changed; only the occupant field of the Organizational Role object needs to be 
changed.
An Organizational Role object is a leaf object.

To create a new Organizational Role object
1. In the Organizational Role Name text box, type a name for this Organizational Role object.

You must follow the object naming conventions.
 (Optional) To define additional information about this Organizational Role object, choose Define 

Additional Properties.
You cannot choose this if you choose Create Another Organizational Role.

 (Optional) To create another Organizational Role object immediately after this one, choose Create 
Another Organizational Role.

You cannot choose this if you choose Define Additional Properties.
2. Choose Create.

If you chose Define Additional Properties, the Organizational Role object dialog appears.
If you chose Create Another Organizational Role, this dialog appears again.

Screen regions and buttons
Organizational Role Name allows you to record the title or position of this role (such as Team Leader).

Define Additional Properties allows you to define more information about this Organizational Role 
object.

Create Another Organizational Role repeats this dialog.

Create creates the new Organizational Role object.

Cancel returns you to the browser without creating an Organizational Role object.



Create an Organizational Unit Object 
Organizational Unit is a container object and can be created only under an Organization or another 
Organizational Unit.
Use an Organizational Unit to

 Designate an object as a logical container, such as a department within a company
 Set user defaults for users created in this container or subordinate containers.

To create a new Organizational Unit object
1. In the Organizational Unit name text box, type a name for this Organizational Unit.

You must follow the object naming conventions.
 (Optional) To define additional information about this Organizational Unit object, choose Define 

Additional Properties.
You cannot choose this if you choose Create Another Organizational Unit.

 (Optional) To create another Organizational Unit object immediately after this one, choose Create 
Another Organizational Unit.

You cannot choose this if you choose Define Additional Properties.
 (Optional) To define user defaults for users that will be created later in this Organizational Unit, choose 

Define User Defaults.
2. Choose Create.

If you chose Define Additional Properties, the Organizational Unit object dialog appears.
If you chose Create Another Organizational Unit, this dialog appears again.
If you chose Define User Template, the object dialog for a new User_Template object appears. Enter 
default information in the pages of this dialog. If a user template exists in the parent container, you will
be asked if you want to copy that information into this user template. You can then change it as 
needed.

Screen regions and buttons
Organizational Unit name is where you enter a name for this Organizational Unit object.

Define Additional Properties allows you to define more information about this Organizational Unit 
object immediately after creating it.

Create Another Organizational Unit repeats this dialog.

Define User Defaults allows you to enter default information for users that you create later in this 
Organizational Unit. A new object, USER_TEMPLATE, is created, and you enter default 
information in the fields of its object dialog.

Create creates the new Organizational Unit object.

Cancel returns you to the browser without creating an Organizational Unit object.



Create an Organization Object 
Organization is a container object and can be created only under the [Root] object or a Country object. An
Organization object cannot contain another Organization object.
Use an Organization object to organize other objects into entities such as a company or division of a 
company.
When you install the first NetWare 4 server in the tree, the server install program will prompt you for the 
name of your Organization.

To create a new Organization object
1. In the Organization Name text box, type a name for this Organization.

You must follow the object naming conventions.
 Optional) To define additional information about this Organization object, choose Define Additional 

Properties.
You cannot choose this if you choose Create Another Organization.

 (Optional) To create another Organization object immediately after this one, choose Create Another 
Organization.

You cannot choose this if you choose Define Additional Properties.
 (Optional) To define user defaults for users that will be created later in this Organization object, choose 

Define User Template.
2. Choose Create.

If you chose Define Additional Properties, the Organization object dialog appears.
If you chose Create Another Organization, this dialog appears again.
If you chose Define User Template, the object dialog for a new User_Template object appears. Enter 
default information in the pages of this dialog. If a user template exists in the parent container, you will
be asked if you want to copy that information into this user template. You can modify it as needed.

Screen regions and buttons
Organization Name is where you enter a name for this Organization object.

Define Additional Properties allows you to define more information about this Organization object 
immediately after creating it.

Create Another Organization repeats this dialog.

Define User Template allows you to enter default information for users that you create later in this 
Organization object. Create creates the new Organization.

Cancel returns you to the browser without creating a Organization object.



Create a Directory Map Object 
A Directory Map object is a leaf object that represents a particular directory in the file system. You can use
Directory Map objects in login scripts to map to directories that contain applications or other frequently 
used files.
For example, if you have a directory that contains DOS 5, you will probably map a search drive to that 
directory in any login scripts you create. If you should later upgrade to DOS 6 and rename the directory, 
you would have to change the mapping in every login script where that mapping appears.
By using a Directory Map object, you could avoid having to make changes to every login script. First, you 
could create a Directory Map object called CURRENT_DOS that points to the DOS directory 
(SYS:PUBLIC\IBM_PC\MSDOS\5). Then, using the MAP command in users' login scripts, you could map 
a search drive to the Directory Map object, rather than to a specific directory:

MAP INS S2:=.CURRENT_DOS.SALES.NOVELL_US

When users log in, they have a search drive mapped to the CURRENT_DOS Directory Map object, which
points to the directory containing DOS 5.
If DOS 5 is ever renamed (to DOS 6 for example) or moved to a different directory, only the Directory Map
must be changed to reflect the new path or name; all login scripts can remain the same.

To create a new Directory Map
1. In the Directory Map Name text box, type a name for this Directory Map object.

Use a name that shows what this Directory Map object is used for, such as what application it points 
to. For example: SPREADSHEET_PATH). The volume and path are entered after the object is 
created.
You must follow the object naming conventions.

2. Choose the browser button to the right of the Volume field and the volume and path that this Directory
Map object will point to.

 (Optional) To define additional information about this Directory Map object, choose Define Additional 
Properties.

You cannot choose this if you choose Create Another Directory Map.
 (Optional) To create another Directory Map object immediately after this one, choose Create Another 

Directory Map.
You cannot choose this if you choose Define Additional Properties.

3. Choose Create.
If you chose Define Additional Properties, the Directory Map Object dialog appears.
If you chose Create Another Directory Map, this dialog appears again.

Screen regions and buttons
Directory Map Name shows the name of the Directory Map object.

Volume specifies the volume that this Directory Map object refers to.

Path specifies the path on the selected volume that this Directory Map object refers to.

Define Additional Properties lets you define more information about this Directory Map object 
immediately after creating it.

Create Another Directory Map repeats this dialog.

Create creates the new Directory Map object.

Cancel returns you to the browser without creating a Directory Map object.



Create an Alias Object 
An Alias object refers to another object in the Directory tree and makes it appear as if the object that it 
names actually exists in the Directory tree where the Alias is created.
The purpose of an Alias object is to allow users to work with the object the alias points to without having 
to change to the object's context.
Although an object appears both where it was first created and where an Alias object referring to it was 
created, only one copy of the object really exists, and changes made to either object affect what appears 
in both locations.
Rights to the Aliased object will always be inherited from an object's true parent container, and not from 
the parent container of an Alias that points to it.
Alias is a leaf object. The object that the Alias refers to, however, can be a container, so an Alias can 
appear to contain other objects.
Example: You want the users in the CENTRAL Organizational Unit to have access to a Volume object 
contained by the SEATTLE Organizational Unit without having to change their context to SEATTLE's part 
of the Directory tree. So, you create an Alias object in CENTRAL that refers to the Volume under 
SEATTLE. (The Volume is the Aliased object.)
Now all users in CENTRAL can see and use the volume in SEATTLE without changing their context to 
that of SEATTLE. Any changes made by users in CENTRAL still occur on the Volume object in 
SEATTLE's area of the Directory tree.

To create a new Alias object
1. In the Alias Name text box, type a name for this Alias object.

You must follow the object naming conventions.
2. Choose the Aliased Object text box.
3. Choose the browser icon. 
4. Select an object.

(Optional) To create another Alias object immediately after this one, choose Create Another Alias.
You cannot choose Define Additional Properties for an Alias object. The Alias object consists only of 
an Alias name and the name of the object that the Alias object points to.

5. Choose Create.
If you chose Create Another Alias, this dialog appears again.

Screen regions and buttons
Alias Name is the name of the Alias object.

Aliased object is the name of the object that the Alias object refers to. This object appears where the 
Alias object is created. The Aliased object can be anywhere in the Directory tree. It can be a leaf 
or a container object.

Create Another Alias repeats this dialog.

Create creates the new Alias object.

Cancel returns you to the browser without creating an Alias object.



Create Alias Object - Naming an Alias
This is the name of the Alias object that will appear in the browser. After you create the Alias object, you 
will be able to recognize it by the mask icon that appears next to the object icon in the browser.



Create Alias Object - Setting an Aliased Object Name
This is the name of the object that the Alias object refers to. It can be a container or a leaf object, 
depending on whether you want to see an entire branch of the Directory tree at this location, or just one 
object.



Create a Profile Object 
A Profile object stores a login script that is used by a group of users that need to share common login 
script commands.
If a Profile object is listed in the Login Script page of a User object, it is executed after the login script of 
the user's container object, but before the user's individual login script. Users should be careful not to 
overwrite drive mappings from the Profile login script with their individual login script mappings.
Note: A user must have Read rights to the Profile object's login script property for the script to execute.
Profile is a leaf object.

To create a new Profile object
1. In the Profile Name text box, type a name for this Profile object.

You must follow the object naming conventions.
 (Optional) To define additional information about this Profile object right now, choose Define Additional 

Properties.
You cannot choose this if you choose Create Another Profile.

 (Optional) To create another Profile object immediately after this one, choose Create Another Profile.
You cannot choose this if you choose Define Additional Properties.

2. Choose Create.
If you chose Define Additional Properties, the Profile object dialog appears.
If you chose Create Another Profile, this dialog appears again.

Screen regions and buttons
Profile Name is the name of the Profile object.

Define Additional Properties lets you define more information about this Profile immediately after 
creating it

Create Another Profile repeats this dialog.

Create creates the new Profile object.

Cancel returns you to the browser without creating a Profile object.



Create a Directory 
Directories are not NetWare Directory Services (NDS) objects. They are part of the file system, which is 
integrated with NDS in the NetWare Administrator utility. You can create a directory when you select a 
Volume or another directory.

To create a new directory
1. In the Name text box, type a name for the directory.

You must follow the object naming conventions.
 (Optional) To define additional information about this directory right now, choose Define Additional 

Properties.
You cannot choose this if you choose Create Another Directory.

 (Optional) To create another directory immediately after this one, choose Create Another Directory.
You cannot choose this if you choose Define Additional Properties.

2. Choose Create.
If you chose Define Additional Properties, the Directory dialog appears.
If you chose Create Another Directory, this dialog appears again.

Screen regions and buttons
Directory Name is the name of the directory.

Define Additional Properties lets you define more information about this directory immediately after 
creating it.

Create Another Directory repeats this dialog.

Create creates the new directory.

Cancel returns you to the browser without creating a directory.



Create a File 
Use NetWare Administrator to see information about files that already exist. You must use another 
application, such as a word processor, to create new files.



Create a Message Routing Group Object 
A Message Routing Group object represents a cluster of messaging servers located anywhere in the 
Directory tree. Servers in a Message Routing Group should not be connected to each other through 
remote links.
You can assign messaging servers to the Message Routing Group. All messaging servers connected to 
the same Message Routing Group may send messages directly among themselves.
A Message Routing Group object is a leaf object.

To create a new Message Routing Group object
1. In the Message Routing Group Name text box, type a name for this Message Routing Group.

You must follow the object naming conventions.
2. Select the browser icon to the right of the Postmaster General text box.
3. Assign a Postmaster General to the Message Routing Group by selecting a user from the browser.

 (Optional) To define additional information about this Message Routing Group, choose Define 
Additional Properties.

You cannot choose this if you choose Create Another Message Routing Group.
 (Optional) To create another Message Routing Group object immediately after this one, choose Create 

Another Message Routing Group.
You cannot choose this if you choose Define Additional Properties.

4. Choose Create.
If you chose Define Additional Properties, the Message Routing Group object dialog appears.
If you chose Create Another Message Routing Group, this dialog appears again.

Screen regions and buttons
Message Routing Group Name displays the name of the Message Routing Group (which you type in 

the text box).

Postmaster General displays the User object that is the owner and administrator of the Message 
Routing Group. (The User object is selected from the browser.) The Postmaster General has 
rights to modify the Message Routing Group object and its attributes.

Define Additional Properties lets you define more information about the Message Routing Group 
object (such as Location, Department, and Organization).

Create Another Message Routing Group repeats this dialog.

Create creates the new Message Routing Group object.

Cancel returns you to the browser without creating a Message Routing Group object.



Create an External Entity Object 
An External Entity object represents an object that is not part of your NetWare Directory Services (NDS) 
tree, such as an internet address, or an NDS object that resides in another tree. This object is needed to 
accommodate foreign E-mail users who E-mail users in NDS may want to communicate with. An External 
Entity object is a leaf object.

To create a new External Entity object
1. In the External Entity Name text box, type a name for this External Entity object.

You must follow the object naming conventions.
 (Optional) To define additional information about this External Entity object, choose Define Additional 

Properties.
You cannot choose this if you choose Create Another External Entity.

 (Optional) To create another External Entity object immediately after this one, choose Create Another 
External Entity.

You cannot choose this if you choose Define Additional Properties.
2. Choose Create.

If you chose Define Additional Properties, the External Entity object dialog appears.
If you chose Create Another External Entity, this dialog appears again.

Screen regions and buttons
External Entity Name displays the name of the External Entity object (which you type in the text box).

Define Additional Properties lets you define more information about the External Entity object (such 
as Location, Department, and Organization) immediately after creating it.

Create Another External Entity repeats this dialog.

Create creates the new External Entity object.

Cancel returns you to the browser without creating an External Entity object.



Create a Distribution List Object 
A Distribution List object represents a collection of objects that have mailboxes. You can assign objects 
(Organizational Unit, Group, or User objects for example) to a Distribution List and conveniently send the 
same message to many different recipients by sending it to the Distribution List.
A Distribution List can have other Distribution Lists as members. Members of Distribution Lists do not 
have security equivalence to the Distribution List.
A Distribution List object is a leaf object.

To create a new Distribution List object
1. In the Distribution List Name text box, type a name for this Distribution List object.

You must follow the object naming conventions.
2. Select the browser icon to the right of the Mailbox Location text box.
3. Assign a mailbox location to the Distribution List by selecting a messaging server from the browser.

 (Optional) To define additional information about this Distribution List object, choose Define Additional 
Properties.

You cannot choose this if you choose Create Another Distribution List.
 (Optional) To create another Distribution List object immediately after this one, choose Create Another 

Distribution List.
You cannot choose this if you choose Define Additional Properties.

4. Choose Create.
If you chose Define Additional Properties, the Distribution List object dialog appears.
If you chose Create Another Distribution List, this dialog appears again.

Screen regions and buttons
Distribution List Name displays the name of the Distribution List object (which you type in the text 

box).

Mailbox Location displays the path to the messaging server where the Distribution List's mailbox 
resides.

Define Additional Properties lets you define more information about the Distribution List object.

Create another Distribution List repeats this dialog.

Create creates the new Distribution List object.

Cancel returns you to the browser without creating a Distribution List object.



Using NetWare Administrator
NetWare Administrator is similar to a file manager, except that it allows you to manage objects in the 
Directory database in addition to managing files.
The browser is the main work area in NetWare Administrator. It displays the name of each object and its 
corresponding icon.
To work with an object, select it; then, choose the task you want. There are several ways to complete 
tasks. You can

Use Menu Options
Double-Click on an Object
Click the Right Mouse Button
Drag and Drop Objects

Procedures
Change the Directory Context
Create a New Object
Move Objects
Move or Copy Files
Include Certain Object Classes in the browser
Open Multiple browser Windows
Use Menu Options
View the Current Directory Context

Screen regions and buttons
Menu Options lets you choose tasks from pull-down menus.

browser displays objects in the Directory database in a tree structure that allows you to see their 
relationships to each other.

Hint Bar explains menu options as you select them.



browser Icons
Object icons show what class of object is displayed.

Container objects

Country
Organization
Organizational Unit

Leaf objects

Alias
AFP Server
Bindery
Computer
Directory Map

Distribution List

External Entity
Group

Message Routing Group

Messaging Server
 NetWare Server

Organizational Role
Printer
Print Server
Profile
Queue
User
Unknown in NDS
Unknown in NetWare Administrator
Volume



Double-Click on an Object
When you double-click on an object (or press <Enter> after an object is selected), NetWare Administrator 
performs the most logical action for that object at that place. The action depends on the object you 
choose. 
For example, when you double-click on

 A container object, the browser lists the objects contained in that object.
 A leaf object, the browser opens an object dialog, unless the leaf object is a Volume object.
 A Volume object, the browser lists directories and files in the root directory of that volume.

Example: If you double-click on Organizational Unit SALES, SALES opens and shows the objects it 
contains. If you double-click on User object JORDAN, you see the object dialog for JORDAN. If you 
double-click on Volume MARKETING, you see the root directory of that volume.



Use Menu Options
Menus list all tasks you can perform. To use most menu options, select the object you want to work with, 
then choose the task from a pull-down menu. 
Example: To create a Server object under Organizational Unit SALES, select SALES; then, choose 
Create from the Object menu.
If a menu option is grayed, that option is not available (either because you do not have rights to perform 
the action, or the object you selected doesn't allow that option). 
Some menu options have ellipses, indicating that a dialog appears when that option is chosen.
The Hint Bar at the top of the screen explains each menu option when you select it.

Menus
Object
View
Options
Tools
Window
Help



Object Menu Options

Create
Opens a dialog that allows you to select which class of object you want to create under the container you 
selected. You can use this option to create directories on a Volume as well. 
If you selected a leaf object or do not have rights to create an object under this container, the Create 
option is grayed. You can use this option to create directories on a Volume as well.

Details
Opens a dialog that allows you to see information about the object, file, or directory. The type of 
information you can view or change varies according to the object you select. The same dialog opens if 
you double-click on a leaf object.

Rights to Other Objects
Opens a dialog that shows what rights the selected object has to other objects. When you choose this 
option, you are prompted to specify the portion of the Directory tree you want to search.
To see who has rights to this object, use the Trustees of this Object option.

Trustees of this Object
Opens a dialog that shows which objects have rights to the object you selected. You can also set the 
object's Inherited Rights Filter or see other objects' effective rights to this object.
Use the Rights to Other Objects option to see which objects this object has rights to. 

Move
Allows you to move the selected leaf objects or files to another location. You can select multiple leaf 
objects or files, and select a destination in the dialog that appears when this menu item is chosen.

Copy
Allows you to make a copy of a file. You can select multiple files. You select a destination in the dialog that
appears after this menu item is chosen.

Rename
Opens a dialog that allows you to rename any object, file, or directory. If you rename an object, you can 
choose to save the object's old name in the Other Names property for future reference.

Delete
Deletes the selected object. Once you have deleted an object, you cannot recover it. A container can be 
deleted only if it is empty except for the USER_TEMPLATE object. You cannot delete the 
USER_TEMPLATE object; it is deleted when its container is deleted.

User Template
Provides a pattern for User objects created under the selected container. You can change the pattern and 
apply it to new User objects.

Search
Allows you to search a branch of the Directory tree for objects matching a pattern that you specify.

Print
Allows you to print the objects currently listed in the browser.

Print Setup
Allows you to select and configure your printer and print jobs.

Exit
Closes NetWare Administrator.





View Menu Options

Set Context
Opens a dialog which allows you to change which part of the Directory tree you are viewing.

Include
Opens a dialog which allows you to limit by name or by object class the objects you see in the browser, or
limit by name the files and directories you see when you view a Volume object's files and directories. Use 
this option if you have a large number of items to display.
For example, you could select to see all User, Group, and Printer objects whose names include S and R, 
and select to see files and directories whose names include P, T, and S.

Sort by Object Class
Opens a dialog which allows you to set the order in which the classes of objects appear in the browser.
For example, if you want to see User objects listed first, Volumes objects second, Group objects third, and
so on, move User objects to the top, Volume objects second, and so on, in the Sort dialog.

Expand
Opens the container object you have selected. The container remains selected.

Collapse
Closes the container you have selected. The container remains selected.



Options Menu
The options in the Options menu are preferences that you select.
Your selections on this menu apply every time you open NetWare Administrator until you deselect the 
options. When you select an option, a check mark appears next to the option. It disappears when you 
deselect the option.

Save Settings on Exit
Saves your current settings, including sort preferences, browser filters, and the context of your active 
browser screens.

Show Hints
Sets NetWare Administrator so that a one-line description of each menu displays at the top of the screen 
as you scroll through each menu. 

Confirm on Delete
Sets NetWare Administrator so that a confirmation box appears when you delete an object, file, or 
directory. You cannot recover deleted objects, so set this to confirm deletions in order to avoid 
accidentally deleting an object.

Get Alias Trustees
When this option is selected, administrators can use the Trustees of this Object dialog to manage the 
trustees of an Alias object, as opposed to the object the alias points to.

Get Aliased Object Trustees
When this option is selected, administrators can use the Trustees of this Object dialog to manage the 
trustees of the object pointed to by an alias, as opposed to the Alias object itself. This should be your 
default setting.



Tools Menu

Partition Manager
Starts the Partition Manager.

Browse
Opens another browser window with the selected object as the first object in the new window.

Salvage
The Salvage option allows you to recover previously deleted files, or permanently delete them to save 
disk space.

Remote Console
Opens a DOS box that allows you to activate the Remote Console utility.



Window Menu

Cascade
Arranges all browser windows in overlapping style (so the title bar of each window can be seen).

Tile
Arranges all browser windows in tile style, like a checkerboard. Each window is smaller, but none overlap.

Arrange Icons
Arranges all icons in a group.

Close all
Closes all browser windows. To open a window to view the Directory tree again, you must choose 
browser from the Tools menu.



Help Menu

New Features
Lists and explains the new features available in this version of NetWare Administrator.

Contents
Lists all topics available in Help. These topics link to procedures and descriptions of all parts of NetWare 
Administrator.

Glossary
Lists all glossary terms used in online help.

Error Messages
Shows a description of error messages that can appear in NetWare Administrator.

About NetWare Administrator
Gives version and copyright information for NetWare Administrator.



Right-Click on an Object
When you put the pointer on an object and click the right mouse button, a menu appears next to the 
object. The menu lists options for all tasks you can complete with that object. You can choose the option 
for the task you want to complete.
If a task is grayed, you cannot perform that task on that object either because of the object type, or 
because you do not have rights.
To close the menu without selecting anything, click the left mouse button.
Example: You need to work with organizational unit SALES. Select SALES; then click the right mouse 
button. A menu appears listing all the tasks you can do with SALES at that point.

Details
Opens an object dialog for the selected object. (This functions the same as choosing Details from the 
Object menu.)

Trustees of this Object
Opens the Trustees dialog for the selected object, where all objects that have a trustee assignment to the 
selected object are listed. Trustees rights and the Inherited Rights Filter can be changed from this dialog. 
(This functions the same as choosing Trustees of this Object from the Object menu.)

Rights to Other Objects
After you specify which part of the Directory tree to look at, a window opens that shows what the selected 
object has rights to. There is a delay when you choose this option while all objects in the selected part of 
the Directory tree are searched for trustee assignments that include the selected object.
To see who has rights to this object, use the Trustees of this Object option.

Browse
Only valid when a container object is selected. This option opens a new browser window with the selected
container as the first object and lists all objects within that container.

Create...
Only valid when a container object, Volume object, or directory is selected. This option opens a dialog that
lets you create a new object or directory below the selected point. (This functions the same as choosing 
Create from the Object menu.)

Delete
Only valid when a leaf object, file, or empty container or directory is selected. This option Deletes the 
selected object after displaying a confirmation box (if selected in options). (This functions the same as 
choosing Delete from the Object menu.)



Drag and Drop Operations

Adding a Trustee of This Object
If you drag one object and drop it onto another object, the Trustees of This Object dialog opens. If you 
have rights to add trustees to the object you landed on, the object that you dragged becomes a trustee of 
the object you dropped it on.

Making This Object a Trustee of Other Objects
If you hold down the <Shift> key while you drag one object and drop it onto another object, the Rights to 
Other Objects dialog opens. If you have rights to add trustees to the object that you dragged, the object 
that you landed on is added as a trustee to the object you dragged.

Moving Leaf Objects
Leaf objects can be moved to a new location in the Directory tree by dragging and dropping the object 
while holding the <Ctrl> key. (You can also select the object and choose Move in the Object menu.)

Moving or Copying Files and Directories
If you drag one file or directory onto another directory or volume, you move or copy that file or directory to 
the place where you dropped it.
You must have rights to create a file or directory where you land.
You can drag and drop files or directories to other directories on the same volume, or to directories in 
other volumes in the Directory tree. You can land on the Volume object to copy or move something to the 
root directory of that Volume, even if the Volume object is not open to display directories.



Rename an Object
When you rename an object, the new name appears in the browser and in any context in which it is 
referenced. (NetWare Directory Services automatically changes all references to the renamed object.)
Renaming a leaf object changes only the object's common name, which is the name that is displayed in 
the Directory tree. It does not change the object's context (the object will reside in the same container as 
before.) However, renaming a container object changes the object's common name, its context, and the 
context of all the objects in the container.

To rename an object
1. In the New Name field, type the object's new name.
2. (Optional) To store the old name in the Other Name field, select the Save Old Name check box.

Note: You might want to save the old name so that users who don't know the object's new name can 
search on the old name. If the Save Old Name box is not checked, the old name is deleted.

3. If you are renaming a container, select Create Alias in Place of Renamed Container.
Important: If you rename a container object and do not select the Create Alias in Place of Renamed 
Container check box, users who are unaware of the object's new name will not easily find the object 
in the Directory tree, since they will look for it by its original name.
Also, users whose name context in their NET.CFG file references the renamed container might be 
unable to log in.

4. Choose OK.
The object is renamed. If you selected the Save Old Name check box, the old name is stored in the 
Other Name field of the Identification page.

5. If you renamed a container object, you should use the NCUPDATE utility to update the name context 
of users in the renamed container. For instructions, see NCUPDATE in Utilities Reference.

Screen regions and buttons
New Name allows you to enter the object's new name.

Save Old Name stores the previous name (if checked).

Create Alias in Place of Renamed Container 

OK saves changes and closes the dialog.

Cancel closes the dialog without changing the name.



Search Option
Search allows you to search for any object in the container that you choose, and it allows you to narrow 
your search to specific object properties.
If NetWare Administrator locates the objects you specify, a new browser window opens that lists the 
objects that were found. From this browser, you can work with the objects that are displayed.

To search for an object
1. In the Start From field, specify the container you want to start your search from.

To search the container specified in the Start From field, do not select Search Entire Subtree.
To search all containers in and below the object in the Start From field, select Search Entire Subtree.

2. To select an object class or a meta class (device, server, top), select the drop-down arrow to the right 
of the Search For field.
Notice that there are extra object classes listed here. If you skip to Step 6, Search lists all objects of 
the selected object class. If you narrow the scope of your search by completing Steps 3 through 5, 
Search lists objects of the selected class only if their properties match those you select below.

3. (Optional) To specify which property value to search on, choose the drop-down arrow to the right of 
the Property field.
If you choose None, then all objects of the class selected above are listed.

4. (Optional) In the field directly below the Property field, choose how you want to narrow the search for 
the selected property.
You can choose Equal To, Greater Than, Less Than, or other choices, depending on what filters are 
available for the property you selected.
For example, if you have selected to search for a User object, and selected the Remaining Grace 
Logins property, you can select the Equal To filter.

5. (Optional) Enter a value in the field to the right of the value that you selected in Step 4.
If you selected Present or Not Present in Step 4, you can leave this field blank.
For example, if you have selected to search for a User object, and selected the Remaining Grace 
Logins property and the Equal To filter, you must specify in this field a number (for example, 5) and 
Search will display all users in the containers searched that have that number of Remaining Grace 
Logins.

6. Choose OK.
Objects that match your selections are displayed in a new browser window. You can now work with 
these objects from the new browser.

Screen regions and buttons
Start From allows you to enter the context (or the container) in the Directory tree you want to start the 

search from.

Search Entire Subtree allows you to specify that the search start at your current container and then 
continue all the way down the tree. If you don't select this option, the search is limited to the 
current container, or the one specified in the Start From field.

Search For allows you to select the object or object class you want to search for.

Property allows you to select the object property you want to search selected objects for. When you 
select a property, you can also choose in the field below how you want to narrow the search for 
the selected property. Depending on what comparisons you choose, you may need to enter 
information in the field to the right, which allows you to specify additional information to filter your 
search.

OK saves changes and begins the search.

Cancel closes the dialog without searching or saving the changes.

Save opens the Save As dialog, which allows you to save the search options you selected for later 
use.



Open brings up a dialog that allows you to select a search option file that you saved previously. You 
can then use the search options as they are, or edit them to do a new search. You can also 
retrieve a search option file that you saved previously by dragging the file from MS Windows' File 
Manager and dropping directly on top of the Search dialog.



Search Object Classes
In addition to the standard object classes used to create objects, several other object classes are listed in 
the search dialog to help find objects. For example,

 Device lists all Computer and Printer objects.
 Locality lists object classes that might be used by third-party products.
 Organizational Person lists all users.
 Partition is used only by the Partition Manager. It indicates which containers are at the top of a separate

partition.
 Person lists all users.
 Resource lists all Printer Queue and Volume objects.
 Server lists all NetWare Server, Print Server, and AFP Server objects.
 Top lists every object in the container that you are searching.



Save As
This dialog allows you to save your search information as files. If you regularly search for the same 
information, you should save the information as a file and use it, instead of entering the information each 
time.
Example: If you are regularly searching for users whose passwords expire in the next week, you can type
in the information once and save the search query. Each time you do the search use the same file, 
changing the date and time value.

Screen regions and buttons
File Name allows you to enter a new filename to save the search information. If it is an existing file, 

you can use the current name, or type in a new name. A filename can contain up to eight 
characters and an extension of up to three characters. 

Drives allows you select the drive where you want to store the file.

Directories allows you to select the directory where you want to store the file.

Save File As Type allows you to select the file type to be used to store the information. Quick Search 
Templates type stores the information for quick and uncomplicated searches.

Read Only allows you to lock the file so others can use the file, but not change it.

OK saves changes and closes the dialog.

Cancel closes the dialog without saving the changes.



Open
This dialog allows you to open and use search information saved as files. If you regularly search for the 
same information, save the information as a file and use it again later, instead of entering the information 
each time.
Example: If you regularly search for users whose passwords expire in the next week, you can type in the 
information once and save the search query. Each time you do the search use the same file, changing the
date and time value 

Screen regions and buttons
File Name is where you select the filename of the search information.

Drives allows you select the drive where you stored the file.

Directories allows you to select the directory where you stored the file.

List Files of Type allows you to select the file type you used to store the information.

Read Only shows you whether the file has been locked so others can use it, but not make changes to
it.

OK saves changes and closes the dialog.

Cancel closes the dialog without saving the changes.



View the Current Directory Context
To view the current directory context, choose Set Context from the View menu. This opens a dialog that 
shows the object in the Directory tree that is the root object of the active browser window.
You can also change the context in this dialog.
Choose Cancel to return to the browser without changing your context.



Create an Object
1. Select the container that you want the object created in.

For example, to create an object that is subordinate to SALES, choose SALES.
You can also select a Volume object or a directory in a volume to create a new subdirectory.

2. From the Object menu, choose Create.
If the Create option is grayed, you do not have sufficient rights, or you selected a leaf object.

3. From the Class of New Object list box, choose the class of object you want to create.
If the class of object you want to create isn't listed, you can't create it in the container you selected. 
For example, a Country object cannot contain a User object.

4. Choose OK.
5. Enter the information required to create the new object.

Note: Although the object appears in the browser if you define only the fields shown in the Create 
dialog, you can choose Define Additional Properties to add information.

6. Choose Create.



Move Objects
Right needed: The Create object right for the container to which you move an object
Important: To move container objects, you must use Partition Manager. You can launch Partition 
Manager from the Tools menu.

To move leaf objects
1. In the browser, select one or more leaf objects.

You can select multiple objects by holding down the <Shift> or <Ctrl> keys while selecting objects.
2. From the Object menu, choose Move.
3. Choose the browser button to the right of the Destination field.

Use the browser in the Directory Context box to view the Directory tree's containers. The Objects box 
that appears in the lower-left corner shows the containers that you select in the browser.

4. From the Objects box, select a container object (an Organization or Organizational Unit) as the place 
to move the listed objects to.

5. Choose OK.
The Destination box now lists the name of the destination container you've just chosen.

6. In the Move dialog box, choose OK.
The selected objects are moved to the selected destination container.
Note: If one of the objects that you selected to move cannot be moved, the Move dialog reappears. 
Objects that have been successfully moved are no longer in the list box. The first object listed is the 
one that could not be moved. You can deselect that object (Ctrl + right click) and choose OK to try 
again.



Move or Copy Files
1. From a volume in the browser, select one or more files.

You can select multiple files by holding down the <Shift> or <Ctrl> keys while selecting files.
2. From the Object menu, choose Move or Copy.

The Copy or Move Object dialog appears.
A button at the top of the dialog indicates whether you are moving or copying the selected files. You 
can change this button.
The From box shows all the files that you selected in the browser. If you change your mind about any 
file in the list, you can deselect it and it will not be included in the operation.

3. Choose the browser button to the right of the Copy Selected Objects To field.
Note: If you are using the drag-and drop feature to copy files, this field is already filled in.

4. Select a directory from a volume using the Select Object dialog that appears.
This is the destination directory. You must have the Create directory right to this directory to complete 
the Move or Copy operation. To move or copy to the root directory, select a Volume object.

5. Choose OK.
The selected files are copied or moved to the selected directory.
Note: If one of the files that you selected cannot be moved or copied, the Move dialog reappears. 
Files that have been successfully moved are no longer in the list box. The first file listed is the one 
that could not be moved. You can deselect that file and choose OK to try again.



Creating an Object Using the New Object Dialog
Use the New Object dialog to create new objects in the Directory tree. You must have the Create object 
right on a container to create objects in that container.
You can also create directories on a volume. You must have the Create directory right to do this.

Procedure
Create a new object

Screen regions and buttons
Parent Object shows the container object that will contain the new object.

Class of New Object lists classes of objects that you can create in this container. You can only select 
one object class each time you create an object.

Context shows the place in the Directory tree where you are creating this object.

OK opens the Create dialog for the object class that you selected.

Cancel closes this dialog without creating an object.



Set a New Context
Opens a dialog that lets you set the context of the browser to any location in the Directory tree.
If you don't want to see the entire Directory tree, you can set the context to the object that you want to be 
the root of the browser.
You can also see a NetWare 2 or 3 server's file system as a separate browser, even if no object exists for 
that server. To do so, you must type servername/volume: in the New Context field.
Example: If you want to see only objects under Engineering.Acme.US, you can set the context to that 
object (Engineering).

To set a new context
1. In the New Context field, enter the new context, or, choose the browser button to the right of the New 

Context field and select a container as the new context.
To make the top of the tree the new context, enter [Root].
Example: Enter a container object's complete name, ie: WP.Sales.Novell

2. Choose OK.
The browser now displays objects starting from the context you entered.

Screen regions and buttons
Current Context shows the context you are in.

New Context allows you to enter a new context.

OK sets the new context that you entered.

Cancel closes this dialog without changing your context.



Server Login
This dialog appears when you attempt to set your context to a NetWare 2 or 3 server. Because the server 
you entered does not use NetWare Directory Services, you must have a separate account on that server.

To log in to a NetWare 2 or 3 server
1. In the Name field, enter the username for an account on the server you are attempting to log in to.
2. In the Password field, enter the password for the username you just entered.
3. Choose OK.

If you entered a valid username and password for the server shown, you are logged in, and NetWare 
Administrator proceeds with your request.



Set Confirmation
Use this dialog to set whether you see a confirmation box when you delete an object, file, or directory. 
Your selection remains in effect every time you start NetWare Administrator until you change this dialog.
Leave the confirmation on unless you are very comfortable with the operation of NetWare Administrator 
and will be making many deletions where the confirmation might become a nuisance.
You cannot undo a delete object operation.

Defaults
Confirm on Delete: On

Screen regions and buttons
Confirm on Delete determines whether you see a confirmation box when you delete an object. You 

cannot recover deleted objects, so you should set this to confirm object deletions.

OK closes the dialog and makes the settings effective for this and future sessions of NetWare 
Administrator.

Cancel closes the dialog without making the changes effective.



Including Certain Objects in the browser
Use the Include dialog to define by name and by object class what you want displayed in the browser.
Example 1: To see all objects starting with f in the active browser window, select all object types in the 
Object Types list, and type f* in the Directory Services Object Name field. Collapse and then expand the 
container to see the new list.
Example 2: To see only User objects in the active browser window, select User in the Object Types list.
Also use the Include dialog to define by name which directories and files you want displayed. If you select
Volume objects to be displayed, you see the directories and files on those volumes.
Example 1:  To see volumes with files that have .EXE extensions in the active browser window, select 
Volume in the Object Types list, and type *.exe in the DOS File Name field.
Example 2:  To see volumes with directories and files that have P and R in their names, select Volume in 
the Object Types list, and type P*R* in the DOS File Name field.

To choose which objects to display in the browser
1. From the Include Object Classes list, select all object classes that you want displayed in the browser.

You can select multiple objects in the list by holding down the <Shift> or <Ctrl> keys while selecting 
objects. The <Shift> key allows you to select multiple objects listed next to each other; The <Ctrl> key
allows you select multiple objects not next to each other in the list.

2. (Optional) Enter data in the Directory Services Object Name Filter field.
3 (Optional) Enter data in the DOS File Name Filter field.
4. (Optional) Select the Save as Default button.
5. Choose OK.

The objects that were selected in the list are the only object classes that are displayed in the browser 
only after you collapse and then expand the container.

Screen regions and buttons
Included Object Classes lists the classes you can select for display.

Directory Services Object Name Filter allows you use wildcard characters to view objects whose 
names include a certain letter or group of letters.

DOS File Name filter allows you to use wildcard characters to view files whose names include a 
certain letter or group of letters or that end with a certain extension.

Save As Default allows you to save the options you have set for the next time you use NWADMIN.

Restore Default allows you to return to the previous default settings and use them as your current 
default settings.

OK closes the dialog and sets the browser to display only the selected objects the next time you 
expand a container or Volume object in the browser.

Cancel closes the dialog without saving the changes.



Sorting Objects in the browser
Use the Sort Object by Class dialog to select the order in which you want objects to display in the 
browser.
Example: To list User objects listed first in the browser, Group objects second, Volume objects third, and 
Printer objects fourth, select an object and use the arrow buttons (icons) to move the objects up or down 
in the list.

Screen regions and buttons

Class Sort Order lists the classes you can select to set the order in which object classes appear in the
browser.

Save As Default allows you to save the options you have set for the next time you use NWADMIN.

Restore Default allows you to return to the previous default settings and use them as your current 
default settings.

OK closes the dialog and sets the browser to display objects in the order you set when you expand a 
container in the browser.

Cancel closes the dialog without saving the changes.



Open Multiple Browser Windows
If you want to drag and drop objects from one window to another, or view different areas in a large 
Directory tree at the same time, you can open multiple browser windows.

To open a new browser window
1. Select the container object that you want to be the first object in the new browser window.
2. From the Tools menu, choose browser.

Another browser window is opened, displaying the context of the object you selected.
Note: To have a browser window start at the very top of the Directory tree, set the context of a 
browser to [Root].

3. (Optional) Select Tile from the Window menu to view all open browsers.



Salvage Option
The Salvage option allows you to recover previously deleted files, or permanently delete them to save 
disk space.

Procedures
Salvage One or More Files
Permanently Delete All Deleted Files in a Directory
Permanently Delete One or More Files
Change Which Files Are Listed in the File List Box
Change How the Files in the File List Box Are Sorted
Change Which Directory's Files Are Listed

Screen regions and buttons
Include allows you to select which files to display.

List displays files specified in the Include field.

Sort Options defines how files are sorted.

Source shows which directory the files listed are located in.

File List box shows all deleted files in the directory with the pattern chosen in the Include field.

Salvage recovers the selected files.

Purge permanently deletes files.

Close closes the Salvage dialog and returns you to the browser.



Permanently Delete All Deleted Files in a Directory
Note: If you are purging from Deleted Directories as your Source option, a DELETED.SAV directory must 
exist in the root directory of this volume; it must be flagged as Hidden.
1. Choose Purge.

You do not have to choose List first.
If you selected any files in the File List box, the Include field applies and only the selected files are 
purged.
You must be the owner of or have at least the Erase file right to any file that you want to Purge.

2. Choose Yes.
A count of the files found is displayed. This number decreases to zero as they are purged. All deleted 
files in the directory are now permanently deleted. Purged files cannot be recovered later.

3 Choose Close



Permanently Delete One or More Files
Note: If you are purging from Deleted Directories as your Source Option, a DELETED.SAV directory must
exist in the root directory of this volume, and it must be flagged as Hidden.
1. From the File List box, select the file or files that you want to purge.

You can select multiple files by holding the <CTRL> or <Shift> keys while you make your selections 
with the mouse.
If the files you want are not shown, change the source or select another directory before choosing 
Salvage. You must be the owner of or have at least the Erase file right to any file that you want to 
purge.

2. Choose Purge.
A count of the files found is displayed, and decreases to zero as they are purged. All deleted files in 
the directory are now permanently deleted. Purged files cannot be recovered later.

3. Choose Close.



Salvage One or More Files
Note: If you are salvaging from Deleted Directories as your Source option, a DELETED.SAV directory 
must exist in the root directory of this volume; it must be flagged as Hidden.
1. From the File List box, select the file or files you want to salvage.

If the files you want are not shown, change the source or select another directory before choosing 
Salvage.
You must have the Create right on a file to salvage it.
If you are salvaging a file from a deleted directory, you must have the Supervisor right to the root 
directory of the volume.

2. Choose Salvage.
The files disappear from the File List box. They now appear in regular file listings (DIR, NDIR, or the 
browser).

3. Choose Close.



Change Which Files Are Listed
1. Select the Include field.
2. Enter a file pattern that describes the files that you want shown in the File List box.

Example: Type *.* to display all files. Type *.DAT to display all data files.
3. Choose List.

Listing the files for a large directory can take several minutes. You can change the source directory, or
purge files without first listing them.
The files matching the file specification that you entered are displayed in the File List box. These files 
can be permanently deleted or salvaged.



Change How Files Are Sorted
1. Choose the arrow next to the Sort Options field.
2. Choose the sort option that describes how you want the files in the File List box displayed.

You can only select one sort option at a time. The left-to-right order of the columns does not change.
Example: If you want all files organized according to when they were deleted, choose Deletion Date as 
the sort option. The first file listed is the one most recently deleted, and the last file listed is the one that 
has been deleted for the longest time.



Change Which Directory's Files Are Listed
1. Choose the arrow next to the Source list.
2. Choose a source directory.

2a. To display files from the directory you selected before choosing Salvage, choose Get From 
Current Directory.
You must have the Create right to a file to salvage it.

2b. To display files from directories that have been deleted on this volume, choose Get From 
Deleted Directories. A DELETED.SAV directory must exist in the root directory of this volume.
You must have the Supervisor right to the root directory of the volume to salvage files from a 
deleted directory.

Note: If you have selected deleted directories as your source and you are working on a SYS: volume, it 
can take a long time to list the files. Consider limiting the list using the Include field. You can select a 
source directory, and enter a value in the Include field before choosing List.



Salvage - Include Field
The Include field defines which files are shown in the File List box.
To determine which files are displayed, type a pattern in the Include field and choose List. The list of files 
changes to show those files.
Example: Type *.* to display all files. Type *.DAT to display all data files.
You can enter information in the Include field and choose a source directory before listing files. This can 
save time searching the directory for deleted files. You do not have to choose List before purging all files 
in this directory.



Salvage - List button
Choose List to indicate that you have finished entering changes in the Include field. The File List box is 
updated according to what you entered.
You can enter information in the Include field and choose a source directory before listing files. This can 
save time. You do not have to choose List before purging all files in this directory.
Note: If you have selected deleted directories as your source and you are working on a SYS: volume, it 
can take a long time to list the files. Consider limiting the list with the Include field.



Salvage - Sort Options
The Sort Options field allows you to specify how files in the File List box are organized.
Organize files to more easily find the files you are looking for. The Sort option changes which files are 
listed from last to first; it does not change the left-to-right order of the fields. (However, you can click on 
the title of each column and drag it to another column.)
For example, if you select Sort by Deletion Date from the Sort Options drop-down list, the files are listed 
from last to first deleted.

Sort Options
Sort by Deletion Date sorts numerically by the date that the file was deleted.

Sort by Deletor sorts alphabetically by name of user who deleted the file.

Sort by File Name sorts alphabetically by filename.

Sort by File Size sorts numerically by how large the file is.

Sort by File Type sorts alphabetically by the file's three-letter extension. (for example .EXE or .DAT). 
Files without extensions (including those used by non-DOS name spaces such as Macintosh) are
listed first in alphabetical order.



Salvage - Source
The Source field determines the source directory to use.
Note: If you have selected deleted directories as your source and you are working on a SYS: volume, it 
can take a long time to list the files. You should consider limiting the list using the Include field.

Source options
Get From Current Directory lists deleted files from the directory that you selected. You need the 

Create right to a file to salvage it from the current directory.

Get From Deleted Directories lists deleted files from directories that have been deleted. You need the 
Supervisor right to the root directory of the volume to salvage files from a deleted directory. A 
DELETED.SAV directory must exist in the root directory of this volume.



Salvage - File List Box
The File List box shows all files in the selected directory that have been deleted and can be salvaged or 
purged.
You can change which files are shown using the Include field and Source field. You can change how the 
list of files is organized with the Sort Options field. You can select all three fields before listing the files; 
which can save time if the directory is large. You also do not have to list the files before purging all files in 
the directory; just choose Purge.

Screen regions
File Name displays the name of the file.

Deleted Date displays the date that the file was deleted.

Deleted Time displays the time that the file was deleted.

File Size displays the size of the file in bytes.

Deletor Name displays the name of the user who deleted the file.

Last Update Date displays the date that the file was last written to.

Last Update Time displays the time that the file was last written to.

Last Updater Name displays the name of the user who last wrote to this file.

Creation Date displays the date that the file was first created in this location.

Creation Time displays the time that the file was first created in this location.

Owner Name displays the name of the user who created the file.

Archive Date displays the date that the file was last backed up.

Archive Time displays the time that the file was last backed up.

Archiver Name displays the name of the user who last backed up this file.

Last Access Date displays the date that the file was last read.



Salvage - Salvage button
Choose Salvage to salvage all selected files. You must have the Create right to a file in order to salvage 
it.
Files that are salvaged can be used as if they had never been deleted.
Files that have been permanently deleted (purged) cannot be salvaged or reused.



Salvage - Purge button
Choose Purge to permanently delete all selected files. You must be the owner of the file, or have at least 
the Erase right, in order to purge it.
Caution: If you have not chosen List yet, or if no files are selected, all deleted files in the directory that 
you selected are permanently deleted, not just the files described by the pattern in the Include field. A 
confirmation dialog appears before files are purged.
Permanently deleting files can speed up your system and free disk space, but permanently deleted files 
cannot be recovered for use later.



Salvage - File Already Exists
A file already exists in this directory with the same name as the file that you are trying to salvage. You 
must enter a new name for the file that you want to salvage.
1. In the Filename text box, enter a new filename.
2. Choose OK.

The file is salvaged and given the new name you entered in this dialog.
If you choose Cancel, this file is not salvaged.



Print the Objects in the Browser
You can print the objects listed in the browser as a one item per line list, in a two column format, or as a 
file that you can manipulate or print later.

Screen regions and buttons

Printer lists the printer you are currently connected to.

Print in Two columns allows you to choose the format of the printed objects--as a list with each object 
on a separate line, or in two columns.

Print to File allows you to save the objects listed in the browser to a file.

Print Quality allows you to choose the dots per inch for the print job.

OK sends the print job to the printer.

Cancel closes this dialog without making any changes.

Setup allows you to select how the information prints on the page, the paper size and source, and the
printer.



Print Setup
This dialog allows you to choose a printer for the print job, choose the way the information appears on the
page, and choose the paper size and source.

Screen regions and buttons

Printer allows you to choose the printer to print to.

Orientation allows you to choose the layout of the information on the page.

Paper allows you to choose the paper size and source for the print job.

OK saves all changes and returns you to the browser.

Cancel closes this dialog without making any changes.

Options allows you to choose to print to the printer or to an encapsulated postscript file, change the 
margins, set the scaling, or send a banner.



Continue or Cancel Object Operation
The objects that were not found may have been deleted, moved, or renamed by another user working in 
the same tree you're in. You probably need to collapse and expand the browser so that NetWare 
Administrator can refresh the browser and display the objects that actually exist in the tree.

Screen regions and buttons
Continue completes the object operation you began with the objects that were successfully found by 

NetWare Administrator. This button is disabled and appears gray if none of the objects you 
selected are valid.

Cancel stops the object operation you began and returns you to the browser.

Copy List to Clipboard copies the list of objects that you had selected (but which NetWare 
Administrator could not find) to the clipboard. You might want to copy the list of invalid objects to a
document while you research why the objects are missing or deleted.

Print List launches the printer dialog where you can print the list of objects that you had selected (but 
which NetWare Administrator could not find).



New Features
These are the new features in this version of NetWare Administrator.

NetWare MHS Services
You can now use NetWare MHS Services to send and receive electronic mail. To provide messaging 

services, NetWare uses a Messaging Server, a Message Routing Group, a Distribution List, and 
an External Entity. For more information on NetWare MHS, see the MHS Manual.

Move Container Object (Move Partition)
Prior to NetWare 4.10, you could not move a container object. You can now move a container object, 

as long as it is the root object of a partition and has no subordinate partitions. You can move a 
partition using either Partition Manager (which you launch from within the NetWare Administrator 
graphical utility) or the NETADMIN text utility.

Rename Container
Prior to NetWare 4.10, you could not rename a container object. You can now rename a container 

object from the NetWare Administrator browser.

Snap-In SDK
You can now enhance NetWare Administrator by writing your own snap-in modules to help you 

manage NDS objects.





Setting Up NetWare Print Services
Network printing differs from stand-alone printing in that it requires storage, intermediate processing, and 
transmission between processing locations. To provide these functions, NetWare Print Services require 
you to create three printing objects: a Print Server, a Printer, and a Print Queue.
After you create the printing objects, Printer objects must be assigned to Print Server objects, and Print 
Queue objects must be assigned to Printer objects.

To create basic NetWare Print Services
1. Select the context or Organizational Unit where you want to create printing objects.
2. Create a Print Queue object.

Novell recommends that you choose the volume that usually has the most free disk space when 
creating the Print Queue object.

3. Create a Printer object.
From the Create Printer window, type in the name you want to assign to the printer and select Define 
Additional Properties.

4. Select the Assignments page.
5. Add the Print Queue object that you created in Step 2 to the Assignments page for the Printer object.

This assigns the print queue to the printer.
6. Select the Configuration page and make any necessary changes.

Note: The default printer configuration is a parallel printer cabled to a NetWare server's LPT1 port 
using polled mode.

7. Choose OK to return to the browser.
8. Create a Print Server object.

From the Create Printer Server window, type in the name you want to assign to the print server and 
select Define Additional Properties.

9. Select the Assignments page of the Print Server object dialog.
10. Add the Printer object that you created in Step 3 to the Assignments page for the Print Server object.

This assigns the Printer object to the Print Server object. Each print server can support up to 255 
printers. 

11. Choose OK to return to the browser.
12. Load the print server software (PSERVER.NLM) at the NetWare server console.
13. Load the correct network port driver. Load NPRINTER.EXE for printers cabled to workstations and 

NPRINTER.NLM for printers cabled to NetWare servers.
Users can now send print jobs to the printer or print queue.



Load Print Server Software 
In order for NetWare print services to function, you must load a print server module (PSERVER.NLM) on 
your NetWare server corresponding to the Print Server object already created. 
You cannot load multiple copies of PSERVER.NLM on the same NetWare server. PSERVER.NLM 
supports up to 255 printers.

To load a print server module
1. Go to the NetWare server console. You may use the Remote Console option under the Tools menu of 

NetWare Administrator.
You cannot load PSERVER.NLM from within NetWare Administrator except by using the Remote 
Console option.

2. At the NetWare server console prompt, type LOAD PSERVER.
A text-based browser appears.

3. Do one of the following:
3a. Press <Ins> and select the container object where the Print Server object is defined; then 
select the Print Server object.

Example: Choose PS-SALES in the SALES container.
3b. To avoid browsing for the print server, type 

LOAD PSERVER .<PrintServerName>.<context>
at the NetWare server console.
Example: To load print server PS-SALES in the Organizational Unit SALES of 
Organization NOVELL, type LOAD PSERVER .PS-SALES.SALES.NOVELL at the
NetWare server console.

5. Load NPRINTER.EXE or NPRINTER.NLM for each network printer. 
Note: Only printers cabled to the NetWare server that loads PSERVER.NLM can be configured to 
have their NetWare port driver (NPRINTER.NLM) loaded automatically when the print server loads. 
This can be done from the Communications page of the Printer Configuration dialog. (This Auto Load 
option is the default.)



Load Network Printer Software 
NetWare print services require you to load a network port driver for each printer. The port driver sends 
data through the appropriate port to the printer that services the print job.
How the printer is connected to the network determines where you load the port driver. Network printers 
can be cabled in the following ways:

 Directly to the network cabling
 To a DOS workstation (Load NPRINTER.EXE on a DOS or Windows Workstation)
 To an OS/2 workstation (Load NPRINTER.EXE on an OS/2 Workstation)
 To a NetWare server not running PSERVER.NLM (Load NPRINTER.NLM at the NetWare Server 

Console)
 To a NetWare server running PSERVER.NLM (NPRINTER.NLM can be loaded automatically or 

manually. Specify which option you want at the Communications page of the Printer Configuration dialog. 
(The default is Auto Load.)



Load NPRINTER.NLM
1. Go to the NetWare server console by using the Remote Console option under the Tools menu, or 

physically go to the physical server.
Note: You cannot load the NPRINTER.NLM from within NetWare Administrator except by using the 
Remote Console option.

2. At the NetWare server console prompt, type
LOAD NPRINTER <PrintServerName> <PrinterNumber>
Replace PrintServerName with the advertising name (not the complete object name) of the print 
server. The print server's advertising name is on the Identification page of the Print Server object 
dialog.
Replace PrinterNumber with the logical printer number. The print server's logical printer number is 
next to the printer name on the Assignments page of the Print Server object dialog 
Example: To load printer P1, which is assigned to print server PS-SALES with logical number 0, type 
LOAD NPRINTER P1 PS-SALES 0
Note: NPRINTER.NLM can be loaded automatically if the NetWare server is running PSERVER.NLM.
To configure NPRINTER.NLM to load automatically, use the Communication page of the Printer 
Configuration dialog.



Load Port Driver on a DOS or Windows Workstation
The NetWare port driver (NPRINTER.EXE) for a DOS or Windows workstation is a terminate-and-stay-
resident (TSR) program. 
NPRINTER.EXE allows a single workstation to support up to seven printers.    NPRINTER.EXE must be 
loaded one time for each printer; it can be loaded either from a menu or from the command line. 

On a Windows workstation
You must load NPRINTER.EXE before loading Windows 3.0 or 3.1 on the same workstation. You must 
also do one of the two following tasks:

 Configure the printer to use polled mode instead of a specific interrupt number.
 Configure the printer to use a specific interrupt by placing the following lines in the Windows 

SYSTEM.INI file under the heading [386Enh]
LPT1AutoAssign=0
LPT1irq=-1
If the port is different from LPT1, specify the port that the printer is cabled to (for example, LPT2, 

COM1, COM2).
To load NPRINTER on a DOS workstation using the menu option
1. At the DOS prompt, type 

NPRINTER
2. (Optional) Press <F4> to switch to Directory Services mode and then press <Ins> to browse for a 

printer. You can then skip to step 4.
3. Choose a print server.

A list of printers assigned to this print server appears.
4. Choose a printer.

If you choose a printer of type Other/Unknown instead of a manual load parallel or serial type printer, 
you must now specify whether the printer is cabled to a parallel or serial port, the port number, the 
interrupt, and so forth.

To load NPRINTER on a DOS workstation using the command line option
At the DOS prompt, type NPRINTER PrinterName and specify the full name that includes the Directory 
tree. 
Example: To load printer P1 in the Organizational Unit SALES of Organization Novell, type
NPRINTER .CN=P1.SALES.NOVELL
Place the line in AUTOEXEC.BAT file for automatic execution each time the workstation boots. 
NPRINTER.EXE cannot be loaded directly from a login script.

To unload NPRINTER.EXE on a DOS or Windows workstation
1. Unload Windows if it is running. 
2. At the DOS prompt, type NPRINTER /U 

The most recently loaded NetWare port driver unloads. 
You can unload only one port driver at a time.



Load Port Driver on an OS/2 Workstation
The NetWare port driver for an OS/2 workstation is available as an icon in the Novell icon created when 
you install the NetWare Client for OS/2. 
Before running the port driver (NPRINTER.EXE), you need to define an OS/2 printer to correspond with 
each NetWare printer that will be receiving print jobs from an OS/2 queue.
NPRINTER.EXE can run any printer configured as Manual Load or type Other/Unknown.
To load a port driver on an OS/2 workstation, use the following procedure.
1. Choose the Novell icon from your desktop.

When you install the NetWare Client for OS/2, NPRINTER.EXE is available as an icon named 
Network Printer.

2. Choose the Network Printer icon from the Novell Icon View window on your desktop. Then select the 
Printers menu from the NPRINTER window.
The Load and Unload options are listed.
If the Load option is dimmed on this menu, you have already loaded the maximum number of    OS/2 
printers allowed (7). You must unload one before you can load another one.
If the Unload option is dimmed, no port drivers are currently loaded.

3. Choose Load from the Printers menu.
The Load Printers dialog box appears with a list of port drivers already defined for existing printers. 
If there are no configured printers on the list, you must define a printer. The following steps describe 
how to define and add a new printer.
3a. Choose Define from the Load Printers menu.

A list of OS/2 printers currently defined on this workstation appears in the Define Printers dialog 
box.
3b. Choose the Add button to define the OS/2 printer you want NPRINTER to load on this 

workstation.
The Add/Edit Printer dialog appears.

3c. Type a printer name in the Description field.
You must fill in this field. 
Novell recommends that you use the same name for this OS/2 printer as you assigned
to the corresponding NetWare printer. (NetWare printers are defined and configured in
NetWare Administrator or PCONSOLE.)

3d. Double-click a print server from the Print Server Name list.
A list of NetWare printers now appears in the Printer Name box. These printers are
active NetWare printers assigned to the selected print server. They were created with 
either PCONSOLE or NetWare Administrator.
Make sure the NetWare printers are defined as remote connection type. For example, on 
a parallel printer, the connection type should be Manual Load. Otherwise, the printers 
do not appear on the list.

3e. Choose the desired printer by highlighting the name.
This specifies the NetWare printer for NPRINTER to later load.

3f. (Optional) If you want NPRINTER to load the printer when NPRINTER is loaded, mark the 
box for Load on startup.

3g. Using the arrow box to the right of the Default OS/2 print queue, select an OS/2 print queue.
NPRINTER requires that an OS/2 print queue exist on the workstation.

3h. Choose OK.
This OS/2 printer now appears in the Define Printers dialog box with any other printers 
currently defined on this workstation.

3i. (Optional) Repeat the appropriate steps above for each additional printer NPRINTER loads 
on this workstation.
You can have up to seven port drivers loaded concurrently.



4. Highlight the printer to be loaded and select Load.
Note: You cannot    capture a port that NPRINTER is loaded on. This will intercept jobs that 
NPRINTER is sending to the port. You can either capture a different port or print directly to the port 
NPRINTER is loaded on. (The job will be queued by OS/2.)

5. (Optional) To unload any or all port drivers, select Unload from the Printers menu. Highlight the 
printers you want to unload and select Unload, or unload them all by selecting Unload All.



Create a Print Server Object 
A Print Server object represents a print server on the network. Print servers direct print jobs from print 
queues to the appropriate printers.
NetWare Print Services require a Print Server object along with a Printer     object and Print Queue object 
in order for network users to share printers.

To create a Print Server object under the selected container
1. Type a name for this Print Server object in the Name text box. 

This is both the name of the Print Server object as it appears in the Directory tree and as it is loaded 
at the NetWare server console. You must follow the object naming conventions. 

2. (Optional) To define additional information about this print server right now, select Define Additional 
Properties. 
You cannot select this if you select Create Another Print Server.

3. (Optional) To create another Print Server object immediately after this one, select Create Another 
Print Server.
You cannot select this if you select Define Additional Properties.

4. Choose Create.
If you selected Define Additional Properties, the Print Server object dialog appears.
If you selected Create Another Print Server, this dialog appears again.

Screen regions and buttons
Print Server Name shows the name of the Print Server as it appears in the Directory tree and as it is 

loaded at the NetWare server console.

Define Additional Properties lets you define more information about this Print Server (such as which 
printers it services and which users can access it) immediately after creating it.

Create Another Print Server repeats this dialog rather than returning to the browser.

Create creates the new Print Server object.

Cancel returns to the browser without creating a Print Server object.

Related topic
Setting Up NetWare Print Services



Create a Printer Object 
A Printer object represents a physical printer on the network. 
NetWare Print Services requires a Printer object along with a Print Server object and Print Queue object 
in order for network users to share printers.

To create a Printer object under the selected container
1. Type a name for this Printer object in the Name text box. 

This is the name of the Printer object as it appears in the Directory tree. You must follow the object 
naming conventions.

2. (Optional) To define additional information about this printer right now, select Define Additional 
Properties.
You cannot select this if you select Create Another Printer.

3. (Optional) To create another Printer object immediately after this one, select Create Another Printer.
You cannot select this if you select Define Additional Properties.

4. Choose Create.
If you selected Define Additional Properties, the Printer object dialog appears.
If you selected Create Another Printer, this dialog appears again.

Screen regions and buttons
Printer Name shows the name of the Printer object as it appears in the Directory tree.

Define Additional Properties lets you define more information about this printer (such as which 
queues service it and which users have access to it) immediately after creating it.

Create Another Printer repeats this dialog rather than returning to the browser.

Create creates the new Printer object.

Cancel returns to the browser without creating a Printer object.

Related topic
Setting Up NetWare Print Services



Create a Print Queue Object 
A Print Queue object represents a network print queue, a subdirectory that stores print jobs. 
NetWare Print Services requires a Print Queue object along with a Printer object and Print Server object 
in order for network users to share printers.

To create a Print Queue object under the selected container
1. Type a name for this Print Queue object in the Name text box. 

This is the name of the Print Queue object as it appears in the Directory tree. You must follow the 
object naming conventions.

2. Type a name for the print queue volume in the Volume text box, or choose the browser button to 
browse for a print queue volume.
Novell recommends that you choose the volume that usually has the most free disk space.

3. (Optional) To define additional information about this Print Queue object right now, select Define 
Additional Properties.
You cannot select this if you select Create Another Print Queue.

4. (Optional) To create another Print Queue object immediately after this one, select Create Another 
Print Queue.
You cannot select this if you select Define Additional Properties.

5. Choose Create.
If you selected Define Additional Properties, the Print Queue object dialog appears.
If you selected Create Another Print Queue, this dialog appears again.

Screen regions and buttons
Directory Services Queue allows you to create both a Print Queue object in your Directory tree and a 

physical directory for that print queue on a server.

Reference a Bindery Queue allows you to create a Print Queue object for a print queue that already 
exists outside your Directory tree. This queue is a previously defined directory on a NetWare 2 or 
NetWare 3 server or a NetWare 4 server in another Directory tree.    Creating a Print Queue object
for this queue allows you to manage printing outside your current Directory tree.

Print Queue Name shows the name of the print queue as it appears in the Directory tree.

Print Queue Volume shows the name of the volume on which this print queue's print jobs are stored.

Define Additional Properties lets you define more information about this print queue (such as which 
printers it services and which users can access it) immediately after creating it.

Create Another Print Queue repeats this dialog rather than returning to the browser.

Create creates the new Print Queue object.

Cancel returns to the browser without creating a Print Queue object.

Related topic
Setting Up NetWare Print Services



View or Change a Printer Object 
The Identification page describes this Printer object. The fields in this page are only for your information 
and future reference. Most may be left blank if you wish. On this page, you can use this page to store 
information such as

 Where the printer is located
 Additional names for the printer

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until you 
have entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Setting Up NetWare Print Services
See the Status of This Printer
Enter a Description for This Printer
Enter Another Name for This Printer

Screen regions and buttons
Other Name lists identification information associated with this printer that helps you search for and 

identify specific printers.

Description describes the function the printer performs (such as print Sales documents).

Network Address lists the 16-digit (8-byte) number associated with the NetWare server or workstation 
that this printer is cabled to.

Location specifies the printer's physical location (such as a person's office).

Department shows the department or division that generally uses the printer.

Organization lists the organization that can use the printer.

Printer Status allows you to see information such as which print form the printer is using and how the 
printer is servicing print jobs.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



View the Status of This Printer
You must be an operator or user of a print server that services this printer to be able to see its status.
1. From the printer Identification page, choose Printer Status.

A dialog appears which shows the various status elements for printers.
2. To make any changes to this printer's status (such as changing forms or sending a form feed), use 

the buttons.
You must be an operator to change the printer's status.
Changes you make at the Printer Status page take effect immediately.

Screen regions and buttons
Status shows the current status of this printer. Possible printer statuses include the following:

Not connected
Waiting for form.
Out of paper
Printing
Paused
Stopped
Offline
Private
Waiting for job
Ready to go down

Mounted Form shows the number of the form currently mounted in the printer. Only print jobs that 
specify this printer form number can be printed until a new printer form is mounted with the Mount
Form button.

Service Mode shows which service mode is being used by this printer and its associated print queue. 
The service mode determines how jobs within a print queue are organized for the most efficient 
use of the printer.

Current Job Information includes all of the information about the print job that is currently being 
printed on this printer. Most of this information can be changed only by going to the print queue 
and selecting this print job from the list of jobs.

Print Queue indicates the print queue submitting this print job.

Description indicates the banner name. By default, the banner name with CAPTURE is the port and 
with NPRINT it is the filename.

Job Number is the print job ID.

Form shows which printer form this print job is using. This print job cannot be printed unless this form 
matches the Mounted Form field above Current Job Information.

Copies Requested indicates the number of copies of this print job requested by the user.

Copies Complete indicates how many of those copies requested have been printed.

Size of 1 Copy indicates the size of each copy of this print job. This is like the File Size field when you
see the details of a print job within the print queue.

Bytes Printed indicates the total number of bytes in one copy of a print job that have been printed.

Percent Complete indicates how much of this print job is complete, which is determined both by the 
size of one copy and the number of copies requested for this print job.

Abort Job allows you to cancel this print job and immediately stop printing.

Pause changes the status of this printer to Paused. If no jobs are printing and Pause is used, the 



status is changed to Stopped. Only a print server operator can perform this action.

Start can change the status of this printer from Paused to Printing, Stopped to Printing, or Stopped to 
Waiting for Job.

Mount Form allows you to specify a new printer form that you have mounted on this printer. When you
use this button, the Mounted Form field changes to reflect the newly mounted form. Only print 
jobs that specify the new form can be printed.

Eject Page sends a command to this printer to eject the page that is being printed. This is like a Form 
Feed command.



Printer Assignments Page 
The Assignments page controls which Print Queues objects are assigned to this Printer object. On this 
page, you can

 Add or delete print queue assignments
 Specify a default print queue for print jobs sent to a printer, such as with CAPTURE or NPRINT.

Important: OK and Cancel affect the entire Object dialog, not just this page. Do not choose OK until you 
have entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Setting up NetWare Print Services
Add a Print Queue to the List of Queues Assigned to This Printer
Delete a Print Queue from the List of Queues Assigned to This Printer
Change a Print Queue's Priority
Change Which Print Queue is the Default Print Queue

Screen regions and buttons
Print Server names the Print Server object that provides print jobs to this printer.

Print Queues lists the print queues and the service priority for each print queue serviced by this 
printer.

Add lets you add a print queue to the list of print queues assigned to this printer.

Delete lets you delete the highlighted print queue from the list of Print Queue objects.    If you delete a
print queue, all of its jobs are lost.

Priority allows you to define whether the print server sends print jobs from one print queue to the 
printer before or after print jobs in other print queues assigned to this printer. Highest priority = 1.

Default Print Queue shows which of the print queues in the Print Queues list is used when print jobs 
are being sent to a printer. These print jobs are stored in the default queue for that printer.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add a Print Queue to the List of Queues Assigned to This Printer
1. Select Add.
2. Select the print queue that you want to add to the list.
3. Choose OK.

You return to the Assignments page, and the new Print Queue object is displayed.
The print server assigned to this printer can now take print jobs from the print queue that you added 
and send them to this printer.



Delete a Print Queue from the List of Queues Assigned to This Printer
1. Select a print queue from the Print Queues list box.
2. Select Delete.

The print queue is deleted from the list. Print jobs sent to that print queue are not printed.
3. Choose OK.



Change a Print Queue's Priority
A print queue's priority determines whether the print server sends print jobs from this print queue to the 
printer before or after print jobs in other print queues assigned to this printer.
1. Select a print queue from the Print Queues list box.

The priority of the selected print queue is shown in the Priority field.
2. Enter the new priority for the selected print queue in the Priority field.

You can select a number from 1 to 10, inclusive. Print queues with lower priority numbers are 
serviced before print queues with higher numbers.

3. Choose OK.
The priority is changed and you return to the browser.



Change Which Print Queue is the Default Print Queue
The default print queue is used for print jobs that specify a printer (for example, with the CAPTURE 
command). The default queue for a given printer is where the jobs will be stored.
1. Choose the arrow to the right of the Default Print Queue field.

The Print Queues list box appears.
2. Select a Print Queue object from the list.

The selected print queue appears in the Default Print Queue field.



Printer Notification Page 
The Notification page controls the objects that are notified when the printer requires servicing (for 
example, when it is out of paper or jammed). You can

 Add or delete User or container objects that receive printer error messages
 Specify how soon and how frequently printer error messages arrive
 Specify that the print job owner receive the printer status messages

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until you 
have entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Setting up NetWare Print Services
Add to the List of Users Notified about This Printer
Delete from the List of Users Notified about This Printer
Change the Delays Used between Notifying Users about This Printer

Screen regions and buttons
Notify shows objects that are notified about this printer.

First shows how long (in minutes) after an event that a notice is sent to the object in the Notify field.

Next shows how long (in minutes) after the first notification of an event that subsequent notices are 
sent to the object in the Notify field.

Add lets you add an object to the Notification list.

Delete lets you delete the selected object from the Notification list.

Notification Settings allows you to change notification intervals.

Notify Print Job Owner enters the print job owner as an object in the Notification list, so that the object
that sends the print job receives notifications.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add to the List of Users Notified about Printer Status
1. Choose Add.
2. Choose the object that you want to add to the list.
3. Choose OK.

You return to the Notification page, and the new object is added to the list. All of the objects listed are 
notified of changes in printer status.



Delete from the List of Users Notified about Printer Status
1. Select an object from the Notification list.
2. Choose Delete.

The object is deleted from the list. It is no longer be notified of changes in printer status. Note that if 
you delete the (Print job owner) entry, you can add it to the list by selecting the Notify Print Job Owner
check box.

3. Choose OK.



Change the Delays Used between Notifying Users about Printer Status
1. Select the object from the Notification list box for which you want to change the delays for notification 

of changes in printer status.
The notification settings for the selected object appear in the Notification Settings fields.

2. Enter new numbers into the First and Next fields as needed.
The numbers represent the time in minutes that the print server waits to notify the selected object of 
an event related to this printer. First and Next represent a first and subsequent notifications of the 
event, if the printer status remains unchanged.

3. Choose OK.
You return to the browser.



Printer Features Page 
The Features page stores printer information such as

 Printer languages supported
 Amount of memory
 Supported typefaces

You can access this information through searches. For example, you can search for PostScript printers 
with at least 4 MB (4096 KB) of memory and the Futura font. 
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until you 
have entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Page Description Language for This Printer
Add to the List of Supported Typefaces for This Printer

Screen regions and buttons
Page Description Language shows the printer languages supported by the printer. To add a language,

choose the button to the right of the Page Description Language field and then choose Add for 
each language the printer supports.

Memory in KB shows the amount of RAM installed in the printer.

Supported Type Faces shows the fonts that the printer can use. You must enter the correct typefaces;
they are not read from the printer.

Supported Cartridges lists the font cartridges that the printer can use. You must enter the correct 
cartridges; they are not read from the printer.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add a Printer Language for This Printer
A printer language is a protocol or type of printing that this printer can receive (for example, PCL, PCL 5, 
or PostScript).
Enter the printer languages that this printer supports so that users can search for printers that support the 
language they need.
1. Enter a description of the main language used by this printer in the Page Description Language field.
2. To enter other printer languages for this printer, choose the button to the right of the Page Description 

Language field.
3. Add other descriptions in the Add Value dialog which appears.
4. Choose OK.

You return to the Features page of the Printer object dialog.



Add to the List of Supported Typefaces for This Printer
A typeface is a collection of fonts in different stroke weights and sizes that this printer can produce (for 
example, Helvetica and Times Roman).
Enter the typefaces that this printer supports so that users can search for printers that support a typeface 
they need.
1. Enter the first typeface (the default) used by this printer in the Supported Type Faces field.
2. To enter other typefaces (most network printers have many), choose the button to the right of the 

Supported Type Faces field.
3. Add other descriptions in the dialog that appears.
4. Choose OK.

You return to the Features page of the Printer object dialog.



Printer Configuration Page 
The printer Configuration page allows you to store or define information about the hardware configuration 
of this printer and how it is used in the network. On this page, you can define information such as

 Printer type: Serial, Parallel, AIO, UNIX, AppleTalk, XNP (eXtended NetWare Printer protocol), or 
Other/Unknown printers

 Communication parameters that vary according to the printer type (This does not apply to printers with 
type Other/Unknown or XNP.) 

 Frequency at which the print server checks for print jobs for this printer
Note: The default values are for a parallel printer that is cabled to the LPT1 port of a NetWare server 
running PSERVER.NLM.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until you 
have entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Setting Up NetWare Print Services
Change the Printer Type
Change the Service Mode for Forms Used by This Printer

Screen regions and buttons
Printer Type shows the communication method used by this printer (for example, parallel or serial).    

Printers that attach to an OS/2 workstation or directly to the network, require type 
Other/Unknown. 

Communication Parameters allows you to see the values defined for the selected printer type. 
Different dialogs are used depending on which printer type is selected. The dialog appears 
automatically whenever you change the printer type.

Banner Type shows whether the printer produces banner pages in text or PostScript mode.

Service Interval shows how often the print server checks the print queue for print jobs going to this 
printer. The default is every 5 seconds. Values from 1 to 255 are allowed.

Buffer Size in KB shows how large any piece of data sent to this printer can be. The default is 3 KB 
(3,072 bytes). Values from 3 to 20 are allowed.

Starting Form shows the number of the printer form that this printer services when the NetWare port 
driver is loaded. Printer forms are defined in the Organization or Organizational Unit object above 
this printer. Any form number defined there can be used here (values from 0 to 255 are possible).

Network Address Restrictions shows the network addresses that this printer can use. The Set button 
is used to add an IPX    network address to this field.

Service Mode for Forms determines how the print server services print jobs in a print queue 
according to printer form.

When a print job requests a printer form other than the form currently mounted in the printer, the 
print server does not service the job until the new form is mounted in the printer.

The following service mode options determine how often the print server requires you to change 
printer forms:

Change Forms as Needed. The priority of each print queue and the order of print jobs in the print 
queue determine which print job to service next. You may have to change forms often.

Minimize Form Changes Within Print Queues. The print server requires you to mount a new form 
for a print job before servicing print jobs with the currently mounted form in a print queue with a 
lower priority.



Minimize Form Changes Across Print Queues. The print server services all print jobs requiring the
currently mounted form before requesting a form change. Print jobs in lower priority print queues 
that require the mounted form are serviced before print jobs in a high priority print queue that 
require a different form.

Service Only Currently Mounted Form. The printer never requests a form change. If no print job 
requiring the current form is available, nothing is printed.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Change Printer Type
1. Choose the down arrow to the right of the Printer Type field.
2. Choose the correct printer type from the communication protocols listed.

For printers that attach to an OS/2 workstation or directly to the network, select type Other/Unknown. 
(For example, HPIIIsi or 4, Compaq PageMarq 20, GENICOM 7170, or Talaris 1794 Printstation.)
A dialog appears where you must check the communication values for the selected printer type. 
(Other/Unknown and XNP do not have a dialog; they are configured elsewhere.)

3. Make any changes in the communication parameters dialog for this printer type.
4. Choose OK.

You return to the printer Configuration page.



Change the Service Mode for Forms Used by This Printer
The service mode determines how the print server services print jobs within a print queue according to 
printer form. A printer form is defined in the container object that contains the print server and print queue.
You can designate a printer form in a print job configuration to prevent your printer from printing a job on 
the wrong paper. When the print server detects a job in the print queue and that job requests a form other 
than the form currently mounted in the intended printer, the printer is paused and you are notified that a 
new form must be mounted before the print job can be serviced.
Printer forms do not in themselves specify any action for the printer to take. They simply prevent a job 
from printing until you change to the type of paper you want to print on and then tell the printer (using 
PCONSOLE, PSC, or NetWare Administrator) to resume printing You can also mount printer forms at the 
NetWare server console in the print server console.
The service mode options determine how often the print server require you to change printer forms.

To select a service mode for this printer
1. Choose the arrow to the right of the Service Mode for Forms field.
2. Choose a service mode from the list that appears.
3. Choose OK.

You return to the browser.
Service mode options include the following:

Change Forms as Needed sends all print jobs to the printer in the order that they arrive, without 
considering whether the printer form currently in use is the same as the printer form needed by 
the next print job. You may have to change printer forms often.

Minimize Form Changes Across Print Queues indicates that the print server services print jobs that 
use the mounted form in print queues with lower priorities before it requires you to mount a new 
form for a print job in a higher priority print queue.

Minimize Form Changes Within Print Queues indicates that the print server requires you to mount a 
new form for a print job before servicing print jobs that use the mounted form in a print queue with
a lower priority.

Service Only Currently Mounted Forms holds any print jobs that specify a printer form other than the 
one currently in use on this printer. In this mode, the printer never requests a form change. If no 
print job requiring the current form is available, nothing is printed.



AIO Printer Communication 
This printer uses asynchronous input/output. Use this type for printers cabled to a special network board. 
These boards allow a workstation or NetWare server to support more than seven printers.

To modify this printer type
1. Make the changes to the fields so that the correct values are specified.
2. Choose OK.
Screen regions and buttons

Port indicates the number of the port where you want the printer to connect. The value must be a 
number ranging from 0 through 255.

Hardware Type refers to what specific hardware is being addressed. The allowable range is 0 through
255. Novell Labs has designated the following AIO hardware types:

0        Reserved
1        Comx
2        IBM Artic
3        Gateway Communications WNIM+
4-99 Reserved
100    Unused
101    AVM ISDN Controller-B1
102    Newport Systems ANIC
103    Newport Systems WNIC
104    Hayes Microcomputer Products ESP
105    DIGIXI Digiboard PC/Xe, PC/Xi and MC/Xi series
106    DIGICX Digiboard C/X multichannel cluster controllers
107    DIGIXM Digiboard PC/Xm and PC/Xem
108    DOGIEP Digiboard EPC/X system
109    Network Products Corporation NPCC
110    Unused

Board Number indicates the number coded into the AIO board this printer is using. The allowable 
range is 0 through 255.

Connection Type describes how this printer is connected to the network or a computer on the 
network. The options are Manual Load and Auto Load (the default).

All AIO printers can have their NetWare port driver manually loaded (or in an AUTOEXEC file) 
whether they are located at a NetWare server or a workstation. 

You must select Manual Load for printers cabled to workstations or NetWare servers that do not 
load PSERVER.NLM. You have the option of selecting Manual Load for printers cabled to the 
NetWare server that loads PSERVER.NLM.

Network-attached printers are not cabled to parallel or serial printer ports. They contain their own 
network boards (for example, the HPIIIsi and the Qume1700) and port drivers.

Line Control defines the parameters for serial printer communication.

Baud rate specifies the speed at which data is transferred over a serial interface. The most 
common baud rates for printers are 9600, 1200, and 300 baud. Consult your printer 
documentation to determine the correct baud rate.

Data bits specify the character length in bits (the number of bits used to represent a character in a
character set). The standard ASCII character set has 128 characters of letters, numbers, and 
punctuation. It requires 7 bits for transmission. An extended character set has 256 characters with
128 characters from the standard character set and an additional 128 characters of line drawings 
and foreign characters. It requires a character length of 8 bits. The use of 5 data bits allows 1 or 



1.5 stop bits. The use of 6, 7, or 8 data bits allows 1 or 2 stop bits.

Stop bits are special signals in asynchronous communications that indicate the minimum length 
of time after each character before the start bit for the next character is sent. This time is needed 
by the receiving circuitry to prepare to receive each new character. Most printers today are fast 
enough that Stop bits is set to one. Slower printers like teletypes require more than one stop bit. 
The use of 1.5 stop bits requires a character length of 5 data bits. To select 1.5 stop bits, first set 
data bits to 5.

Parity (parity checking) is a method of checking for errors in data transmission. Serial printers are 
commonly configured for no parity, but can be reconfigured if desired. Parity checking degrades 
speed by about 10% but may be desirable in some environments such as printers connected by 
very long cables. If you select None (the default), parity checking is not be used If you select 
Even or Odd, parity checking is enabled and set to Even parity or Odd parity, respectively.

When parity checking is used, errors are reported at the printer. However, parity checking does 
not provide absolute assurance that no errors occur. If more than one bit changes, parity 
checking may or may not detect the error.

XON/XOFF is a flow control method used to prevent the sending system from transmitting data 
faster then the receiving system can accept the information. It is an alternate method for 
hardware handshaking; which uses the Clear to Send signal between the port and the printer. 
When Use XON/XOFF is set to Yes, the NetWare port driver expects the printer to send an XOFF
character (<Ctrl>+<S>) whenever transmission should be suspended (usually indicating that the 
printer's memory buffer is full), and an XON character (<Ctrl>+<Q>) when transmission can be 
resumed. When Use XON/XOFF is set to No (the default), the NetWare port driver expects the 
printer to signal its ability to receive data by the state of the Clear to Send signal on the serial 
connection. 

For details of serial pin configuration, see the Print Services manual. To avoid troubleshooting the
printer or cable pin configuration, select Yes to enable the XON/XOFF protocol.



UNIX Printer Communication 
The NetWare-to-UNIX print service enables native NetWare users to send print jobs to printers on your 
UNIX network, and users on UNIX workstations to send print jobs to printers on your native NetWare 
network.
In order to use this option, you must have the print driver LPR_GWY.NLM loaded on your NetWare server
and be using the NetWare 4.1 version of PSERVER and PCONSOLE or NetWare Administrator. If this 
driver is loaded, you can set up NetWare-to-UNIX printing by entering the following information.

To modify this printer type
1. Make the changes to the fields so that the correct values are specified.
2. Choose OK.
Screen regions and buttons

Host Name indicates the name of the host of this printer within UNIX.

Printer Name indicates the name of this printer within UNIX.



AppleTalk Printer Communication 
This printer is cabled to an AppleTalk network. (For more information, see Print Services.)

To modify this printer type
1. Make the changes to the fields so that the correct values are specified.
2. Choose OK.
Screen regions and buttons

Name specifies the name of this printer as it is known in the Macintosh system.

Type specifies which type of printer this is. Macintosh compatible printers are listed in the drop box.

Zone refers to the AppleTalk zone that the printer resides in. The zone is a name that is assigned to a 
group of computers and printers.

Print Error Messages indicates whether this printer prints error messages on a banner page.

Hide Printer shows whether or not this printer is hidden from the view of AppleTalk users. You should 
hide the printer to prevent Macintosh users from submitting their print jobs directly to the printer 
and possibly conflicting with NetWare print jobs. 



Serial Printer Communication 
This printer is cabled to a serial port of a workstation or NetWare server.

To modify this printer type
1. Make the changes to the fields so that the correct values are specified.
2. Choose OK.
Screen regions and buttons

Port specifies which hardware serial port this printer is using. Possible values that can be selected 
from the drop-down list are COM1, COM2, COM3, and COM4.

Interrupts are signals to a processor that temporarily suspend (interrupt) the current sequence of 
instructions to perform others. This is one method to control communications between the 
processor and a printer port. Another method is for the processor to poll the port at regular 
intervals.

If a port is set to use an interrupt, that interrupt generally must not be used by any other 
hardware. Interrupt numbers are repeated for different ports in the lists above only to show a 
common first choice for each. Some ports may not exist in the workstation, or may not have 
active interrupts, being accessed instead by some polling method.

The default printer configuration setting in NetWare 4 is polled mode, which does not use 
interrupts. For most situations, polled mode provides satisfactory performance and avoids the 
possibility of interrupt conflicts.

If you decide to use interrupts, this field indicates the number of the interrupt used by the port. 
Consult the documentation for your parallel or serial ports to find out which interrupt to use.

NetWare print services supports the use of interrupts 3, 4, 5, 7, 10, and 11. These interrupts 
correspond to the IRQ (Interrupt ReQuest) levels.

Serial printer ports generally use the following interrupts:

COM1: Interrupt 4
COM2: Interrupt 3
COM3: Interrupt 3
COM4: Interrupt 3

Connection type describes how this printer is connected to the network or a computer on the network.
The options are Manual Load and Auto Load (the default).

All serial printers can have their NetWare port driver manually loaded (or in an AUTOEXEC file) 
whether they are located at a NetWare server or a workstation. 

NPRINTER.NLM can be automatically loaded (using the Auto Load option).

You must select Manual Load for printers cabled to workstations or NetWare servers that do not 
load PSERVER.NLM. You have the option of selecting Manual Load or Auto Load for printers 
cabled to the NetWare server that loads PSERVER.NLM. Auto Load is the default.

Network-attached printers are not cabled to parallel or serial printer ports. They contain their own 
network boards (for example, the HPIIIsi and the Qume1700) and internal equivalent of a port 
driver. (NPRINTER.EXE and NPRINTER.NLM are port drivers.)

Line Control defines the parameters for serial printer communication.

Baud rate specifies the speed at which data is transferred over a serial interface. The most 
common baud rates for printers are 9600, 1200, and 300 baud. Consult your printer 
documentation to determine the correct baud rate.



Data bits specify the character length in bits (the number of bits used to represent a character in a
character set). The standard ASCII character set has 128 characters of letters, numbers, and 
punctuation. It requires 7 bits for transmission. An extended character set has 256 characters with
128 characters from the standard character set and an additional 128 characters of line drawings 
and foreign characters. It requires a character length of 8 bits. The use of 5 data bits allows 1 or 
1.5 stop bits. The use of 6, 7, or 8 data bits allows 1 or 2 stop bits.

Stop bits are special signals in asynchronous communications that indicate the minimum length 
of time after each character before the start bit for the next character is sent.    This time is needed
by the receiving circuitry to prepare to receive each new character. Most printers today are fast 
enough that Stop bits is set to one. Slower printers like teletypes require more than one stop bit. 
The use of 1.5 stop bits requires a character length of 5 data bits. To select 1.5 stop bits, first set 
data bits to 5.

Parity (parity checking) is a method of checking for errors in data transmission. Serial printers are 
commonly configured for no parity, but can be reconfigured if desired. Parity checking degrades 
speed by about 10% but may be desirable in some environments such as printers connected by 
very long cables.

If you select None (the default), parity checking is not be used.

If you select Even or Odd, parity checking is enabled and set to Even parity or Odd parity, 
respectively.

When parity checking is used, errors are reported at the printer. However, parity checking does 
not provide absolute assurance that no errors occur. If more than one bit changes, parity 
checking may or may not detect the error.

XON/XOFF is a flow control method used to prevent the sending system from transmitting data faster 
then the receiving system can accept the information. It is an alternate method for hardware 
handshaking; which uses the Clear to Send signal between the port and the printer. When Use 
XON/XOFF is set to Yes, the NetWare port driver expects the printer to send an XOFF character 
(<Ctrl>+<S>) whenever transmission should be suspended (usually indicating that the printer's 
memory buffer is full), and an XON character (<Ctrl>+<Q>) when transmission can be resumed. 
When Use XON/XOFF is set to No (the default), the NetWare port driver expects the printer to 
signal its ability to receive data by the state of the Clear to Send signal on the serial connection. 

For details of serial pin configuration, see the Print Services manual. To avoid troubleshooting the 
printer or cable pin configuration, select Yes to enable the XON/XOFF protocol.



Parallel Printer Communication 
This printer is cabled to a parallel port of a workstation or NetWare server.

To modify this printer type
1. Make the changes to the fields so that the correct values are specified.
2. Choose OK.
Screen regions and buttons

Port specifies which hardware parallel port this printer is using. Possible values that can be selected 
from the drop-down list are LPT1, LPT2, and LPT3.

Interrupts are signals to a processor that temporarily suspend (interrupt) the current sequence of 
instructions to perform others. This is one method to control communications between the 
processor and a printer port. Another method is for the processor to poll the port at regular 
intervals.

If a port is set to use an interrupt, that interrupt generally must not be used by any other 
hardware. Interrupt numbers are repeated for different ports in the lists above only to show a 
common first choice for each. Some ports may not exist in the workstation, or may not have 
active interrupts, being accessed instead by some polling method.

The default printer configuration setting in NetWare 4 is polled mode, which does not use 
interrupts. For most situations, polled mode provides satisfactory performance and avoids the 
possibility of interrupt conflicts.

If you decide to use interrupts, this field indicates the number of the interrupt used by the port. 
Consult the documentation for your parallel or serial ports to find out which interrupt to use.

NetWare print services supports the use of interrupts 3, 4, 5, 7, 10, and 11. These interrupts 
correspond to the IRQ (Interrupt ReQuest) levels.

Parallel printer ports generally use the following interrupts:

LPT1: Interrupt 7
LPT2: Interrupt 5
LPT3: Interrupt 5

Connection type describes how this printer is connected to the network or a computer on the network.
The options are Manual Load and Auto Load (the default).

All parallel printers can have their NetWare port driver manually loaded (or in an AUTOEXEC file) 
whether they are located at a NetWare server or a workstation. 

NPRINTER.NLM can be automatically loaded (using the Auto Load option).

You must select Manual Load for printers cabled to workstations or NetWare servers that do not 
load PSERVER.NLM. You have the option of selecting Manual Load or Auto Load for printers 
cabled to the NetWare server on which PSERVER.NLM is loaded. The default is Auto Load.

Network-attached printers are not cabled to parallel or serial printer ports. They contain their own 
network boards (for example, the HPIIIsi and the Qume1700) and the internal equivalent of a port
driver. (NPRINTER.EXE and NPRINTER.NLM are port drivers.)



Interrupts for a Printer
Interrupts are signals to a processor that temporarily suspend (interrupts) the current sequence of 
instructions to perform others. This is one method to control communications between the processor and 
a printer port. Another method is for the processor to poll the port at regular intervals.
If a port is set to use an interrupt, that interrupt generally must not be used by any other hardware. 
Interrupt numbers are repeated for different ports in the lists above only to show a common first choice for
each. Some ports may not exist in the workstation, or may not have active interrupts, being accessed 
instead by some polling method.
The default printer configuration setting in NetWare 4 is polled mode, which does not use interrupts. For 
most situations, polled mode provides satisfactory performance and avoids the possibility of interrupt 
conflicts.
If you decide to use interrupts, this field indicates the number of the interrupt used by the port. Consult the
documentation for your parallel or serial ports to find out which interrupt to use.
NetWare print services supports the use of interrupts 3, 4, 5, 7, 10, and 11. These interrupts correspond 
to the IRQ (Interrupt ReQuest) levels.
Parallel printer ports generally use the following interrupts: 

LPT1: interrupt 7
LPT2: interrupt 5
LPT3: interrupt 5
COM1: interrupt 4
COM2: interrupt 3
COM3: interrupt 3
COM4: interrupt 3

Screen regions and buttons
Use Interrupts indicates to use a specific interrupt, rather than polled mode.

Interrupt allows you to select an interrupt number if Use Interrupts is selected.

Polled indicates to use polled mode. In polled mode, the PC uses the timer interrupt instead of a 
specific interrupt number to gauge signals to the printer.



Connection Type of a Printer
Connection Type specifies how the port driver (NPRINTER.EXE/NLM) is loaded. 
Only printers cabled to the NetWare server that loads the print server (PSERVER.NLM) can have the port
driver (NPRINTER.NLM) loaded automatically (Auto Load option).
Each NPRINTER.NLM loaded on a NetWare server displays a status screen on the NetWare server 
console.

Screen regions and buttons
The default is Auto Load.

Manual Load indicates that the port driver is manually loaded. You can select this option for a printer 
cabled to any PC on your network. If the printer is cabled to a workstation, you must load 
NPRINTER.EXE from the command line or AUTOEXEC.BAT file. If the printer is cabled to a 
NetWare server, you must load NPRINTER.NLM from the NetWare server console or 
AUTOEXEC.NCF file.

Auto Load indicates that the port driver is automatically loaded. (This is the default.) You can select 
this option only for printers cabled to a NetWare Server running PSERVER.NLM. With this option,
NPRINTER.NLM is automatically loaded by PSERVER.NLM when you load PSERVER.NLM.



Line Control for a Printer
Line control defines the parameters for serial printer communication.

Screen regions and buttons
Baud Rate specifies the speed at which data is transferred over a serial interface. The most common 

baud rates for printers are 9600, 1200, and 300 baud. Consult your printer documentation to 
determine the correct baud rate.

Data Bits specify the character length in bits (the number of bits used to represent a character in a 
character set). The standard ASCII character set has 128 characters of letters, numbers, and 
punctuation. It requires 7 bits for transmission. An extended character set has 256 characters with
128 characters from the standard character set and an additional 128 characters of line drawings 
and foreign characters. It requires a character length of 8 bits. The use of 5 data bits allows 1 or 
1.5 stop bits. The use of 6, 7, or 8 data bits allows 1 or 2 stop bits.

Stop Bits are special signals in asynchronous communications that indicate the minimum length of 
time after each character before the start bit for the next character is sent. This time is needed by 
the receiving circuitry to prepare to receive each new character. Most printers today are fast 
enough that Stop bits is set to one. Slower printers like teletypes require more than one stop bit. 
The use of 1.5 stop bits requires a character length of 5 data bits. To select 1.5 stop bits, first set 
data bits to 5.

Parity (parity checking) is a method of checking for errors in data transmission. Serial printers are 
commonly configured for no parity, but can be reconfigured if desired. Parity checking degrades 
speed by about 10% but may be desirable in some environments such as printers connected by 
very long cables. If you select None (the default), parity checking is not be used. If you select 
Even or Odd, parity checking is enabled and set to Even parity or Odd parity, respectively.

When parity checking is used, errors are reported at the printer. However, parity checking does 
not provide absolute assurance that no errors occur. If more than one bit changes, parity 
checking may or may not detect the error.

Use XON/XOFF is a flow control method used to prevent the sending system from transmitting data 
faster then the receiving system can accept the information. It is an alternate method for 
hardware handshaking; which uses the Clear to Send signal between the port and the printer. 
When Use XON/XOFF is set to Yes, the NetWare port driver expects the printer to send an XOFF
character (<Ctrl>+<S>) whenever transmission should be suspended (usually indicating that the 
printer's memory buffer is full), and an XON character (<Ctrl>+<Q>) when transmission can be 
resumed. When Use XON/XOFF is set to No (the default), the NetWare port driver expects the 
printer to signal its ability to receive data by the state of the Clear to Send signal on the serial 
connection. 

For details of serial pin configuration, see the Print Services manual. To avoid troubleshooting the 
printer or cable pin configuration, select Yes to enable the XON/XOFF protocol.



Printer Status 
This dialog shows the status of this printer. You must be an operator or user of a print server that services
this printer to be able to see its status.

To change the status of this printer
Use the buttons to make any changes to this printer's status (such as changing printer forms or sending a
Form Feed). 
You must be an operator to change the printer's status.

Screen regions and buttons
Status shows the current status of this printer. Possible printer statuses include the following:

Not connected
Waiting for form.
Out of paper
Printing
Paused
Stopped
Offline
Private
Waiting for job
Ready to go down

Mounted Form shows the number of the form currently mounted in the printer. Only print jobs that 
specify this printer form number can be printed until a new printer form is mounted with the Mount
Form button.

Service Mode shows which service mode is being used by this printer and its associated print queue. 
The service mode determines how jobs within a print queue are serviced for the most efficient use
of the printer and printer forms.

Current Job Information includes all the information about the print job currently being printed on this 
printer. Some of this information can be changed only by going to the print queue and selecting 
this print job from the list of jobs.

Print Queue indicates the print queue submitting this print job.

Description indicates the banner name of this print job. If NPRINT is used, it is the filename. If 
CAPTURE is used, it is the port that was captured.

Job Number is the Job ID

Form shows which printer form this print job is using. This print job cannot be printed unless this Form
matches the Mounted Form field above Current Job Information.

Copies Requested indicates the number of copies of this print job requested by the user who 
submitted it.

Copies Complete indicates how many of those copies have been printed.

Size of 1 Copy indicates the size of each copy of this print job. This is like the File Size field when you
see the details of a print job within the print queue.

Bytes Printed indicates the total number of bytes sent to the printer for this print job.

Percent Complete indicates how many bytes of one copy of this print job have been printed.

Abort Job allows you to cancel this print job. Printing is not stopped.

Pause changes the status of this print job. Status can be changed from Printing to Paused, or from 



Waiting for Job to Stopped. Only a print queue operator can perform this action.

Start changes the status of this print job. Status can be changed from Paused to Printing, Stopped to 
Printing, or Stopped to Waiting for Job.

Mount Form allows you to specify a new printer form that you have mounted on this printer. When you
use this button, the Mounted Form field changes to reflect the newly mounted form. Only print 
jobs that specified the new form can be printed.

Eject Page sends a command to this printer to eject the page that is being printed. This is like a Form 
Feed command.



Mount a Printer Form 
This dialog allows you to control the printer forms used by this printer.
You can designate a printer form in a print job configuration to prevent your printer from printing a job on 
the wrong paper. When the print server detects a job in the print queue and that job requests a form other 
than the form currently mounted in the intended printer, the printer is paused and you are notified that a 
new form must be mounted before the print job can be serviced.
Printer forms do not in themselves specify any action for the printer to take. They simply prevent a job 
from printing until you change to the type of paper you want to print on and then tell the printer (using 
PCONSOLE, PSC, or NetWare Administrator) to resume printing You can also mount printer forms at the 
NetWare server console in the print server console.

To mount a printer form
1. Choose the name of the printer form you want.
2. Choose OK.

Cancel returns you to the Printer Status dialog without modifying the printer form.



View or Change a Print Server Object 
The Identification page describes this Print Server object. The fields in this page are for your information 
and reference only. Most may be left blank if you wish. On this page, you can store information such as

 Additional names for the print server
 Where the print server is located

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until you 
have entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.
To change the object's name, select the object and choose Rename from the Object menu.

Procedures
How to Use the Object Dialog
Setting Up NetWare Print Services
Enter a Description for This Print Server
Enter Another Name for This Print Server
Change the Password of This Print Server
Down This Print Server

Screen regions and buttons
Name is the name of this Print Server object.

Advertising Name shows the name the print server uses in network communications.

Other Name lists identification information associated with this print server that helps you search for 
and identify it among other print servers. (Optional)

Network Address lists the 8 digit IPX internal network address of the NetWare server that runs this 
print server (PSERVER.NLM), followed by additional address information.

Description describes the function the print server performs (such as routing print jobs for a particular 
group). (Optional)

Location shows the print server's physical location (such as a room number). (Optional)

Department shows the department or division that generally uses the print server. (Optional)

Organization shows the organization that is using the print server. (Optional)

Version shows the version of PSERVER.NLM being used with this Print Server object to control Print 
Services.

Status shows the status of the print server (Running, Going Down, or Down).

Unload allows you to take down an active print server.

Change Password allows you to set a password to secure the Print Server object. You can also 
remove a password with this option.

OK saves changes in all pages of this dialog. 

Cancel closes this dialog without saving changes in any page.



Print Server Assignments Page 
The Assignments page controls the printers assigned to this Print Server object. On this page, you can 
add or delete printer assignments. 
At least one Printer object must be assigned to a print server in order for NetWare Print Services to 
function properly.
Important: OK and Cancel affect the entire Object dialog, not just this page. Do not choose OK until you 
have entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Printer to the List of Printers Serviced by This Print Server
Delete a Printer from the List of Printers Services by This Print Server

Screen regions and buttons
Printer shows the name of a Printer object that is serviced by this print server.

Number shows the number of each Printer object in the list of printers serviced by this print server.

Add lets you add a printer to the list of Printer objects assigned to be serviced by this print server.

Delete removes the selected printer from the list of Printer objects serviced by this print server.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Change the Printer Number
This dialog allows you to modify the logical printer number. A logical number is assigned to each printer 
when it is created. You may want to change this number to match existing batch files, for example.
NPRINTER.NLM requires and NPRINTER.EXE allows you to load a port driver by specifying the print 
server name and logical printer number.
After changing the printer number, you must unload and reload the print server for the changes to take 
effect.



Unload Print Server 
You must be an operator of this print server to unload the print server software.

To unload a print server
1. Select one of the two options for unloading PSERVER.NLM (see below).

You can cancel current print jobs and unload PSERVER.NLM now, or finish the print jobs that are in 
progress before unloading.    You normally should allow current print jobs to finish (choose the second 
option).

2. Choose OK.
The PSERVER.NLM software is unloaded and you return to the object dialog. No print jobs serviced 
by this print server are printed until PSERVER.NLM is reloaded.

Screen regions and buttons
Unload Print Server Immediately stops printing right now and unloads PSERVER.NLM. Other print 

jobs serviced by this print server are not printed until PSERVER.NLM is reloaded.

Unload Print Server After Current Jobs finishes the current print jobs in print queues serviced by this 
print server. The PSERVER.NLM is then unloaded and no new print jobs are started until 
PSERVER.NLM is reloaded.

OK unloads PSERVER.NLM as you have specified and returns to the object dialog.

Cancel closes this dialog without unloading PSERVER.NLM and returns to the object dialog.



Add a Printer to the List of Printers Serviced by This Print Server
1. Choose the Add button below the Printers list box.
2. Choose the printer that you want to add to the list.
3. Choose OK.

You return to the Assignments page, and the new Printer object is displayed.
You must unload and reload the print server before the printer you added can receive print jobs from print 
queues serviced by this print server. However, you must also list a print queue in this printer's 
Assignments page.



Delete a Printer from the List of Printers Serviced by This Print Server
1. Select a printer from the Printers list box.
2. Choose Delete.

The printer is deleted from the list. Print jobs sent to a print queue serviced by this print server can no 
longer be sent to the deleted printer.

3. Choose OK.
After deleting the printer, you must unload and reload the print server for the changes to take effect.



View or Change the List of Print Server Operators
Operators of a print server are allowed to manage the print server and printers serviced by this server. 
This includes downing the print server, seeing its status, and controlling the printers it services. 
Use the Operators page to record operators of this print server. For example, you can

 See which objects are listed as operators
 Add or delete objects from the list of operators

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until you 
have entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add an Operator
Delete an Operator

Screen regions and buttons
Operators lists objects that are operators of this print server.

OK saves the changes specified in all pages of the object dialog and returns you to the browser.

Cancel closes the dialog box without saving the changes entered in any page.



Add a Print Server Operator
1. Choose Add
2. Select objects that you want to add as operators.
3. Choose OK.

The objects you selected are listed as operators. These objects can manage this print server and the 
printers it services.



Delete a Print Server Operator
1. Select an operator from the Operators list.
2. Choose Delete.

The operator is removed from the list.
3. Choose OK.



View or Change the List of Users for a Print Server
Objects that are listed as users of this print server are allowed by Queue Management Services to see 
the status of this print server.
The Users page lists users of this print server. This list is created and maintained by the network 
supervisor. For example, you can

 View users who access this print server
 Add or delete a user of this print server

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until you 
have entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a User
Delete a User

Screen regions and buttons
Users lists all objects that are users of this print server and allowed to see its status.

OK returns to the browser and saves any changes you have made.

Cancel returns you to the browser without saving any changes you have made.



Add a Print Server User
1. Choose the Add button below the Users list box.
2. Choose the object that you want to add to the list.
3. Choose OK.

You return to the Users page, and the new object is displayed.



Delete a Print Server User
1. Select a user from the Users list box.
2. Choose Delete.

The user is removed from the list.
3. Choose OK.



View or Change a Print Queue Object 
The Identification page describes this Print Queue object. The fields in this page are for your information 
and reference only. Most may be left blank if you wish. On this page, you can store information such as

 Additional names for this print queue
 Where this print queue is located

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until you 
have entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.
To change the object's name, select the object and choose Rename from the Object menu.

Procedures
How to Use the Object Dialog
Setting up NetWare Print Services
Enter a Description for This Computer
Enter another Name for This Computer

Screen regions and buttons
Name shows the name of this Print Queue object.

Volume shows the name of the NetWare volume that contains the directory where this print queue 
stores print jobs in progress.

Other Name lists other names of this Print Queue object (such as a name the queue was previously 
known by). (Optional)

Description describes the function the print queue performs (such as print jobs for a particular group). 
(Optional)

Location shows the print queue's physical location (such as a room number). (Optional)

Department shows the department or division that generally uses the print server. (Optional)

Organization lists the organization that can use the print queue.    (Optional)

Operator Flags 

Allow Users To Submit Print Jobs If set to No, prevents users    from submitting print jobs to the 
print queue until you reset it to Yes.

Allow Service By Current Print Servers If set to No, prevents servers from servicing print jobs in 
the print queue until you reset it to Yes.

Allow New Print Servers To Attach If set to No, prevents servers from attaching to the print queue 
until you reset it to Yes.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Print Jobs in This Print Queue    
This dialog lists the print jobs that are currently in this print queue. Information about each print job is 
shown in the table. Use the arrows in the scroll bar to expand your view of the table's contents.
You must be an operator of this print queue to change the status of a print job that you did not submit.

Screen regions and buttons
Print Queue shows the name of the Print Queue object for which you are viewing print jobs that have 

been submitted.

Print Jobs shows the number of print jobs currently in this print queue.

Seq (sequence) shows the order in which each job is sent to the printer.

Job Name shows the name of the print job submitted to the print queue. By default, if CAPTURE is 
used, this is the port the job that was sent to; if NPRINT is used, this is the filename.

Description shows a description of the print job that was submitted.

Form shows which of the available printer forms is to be used for this print job.

Status shows the status of the print job: Ready, Held, Paused, or Printing.

Job ID shows the ID of the print job assigned by NetWare.

Job Details shows the code for each print job that the print queue used to identify the print job.

Hold Job allows you to hold the job in the print queue without printing, if you have rights to do so.

Resume activates a print job on hold so that it can be printed. 

Delete allows you to delete a print job from the print queue if you have rights to do so.

OK saves changes in this dialog and returns to the Print Queue Identification page.

Cancel closes this dialog without saving changes and returns to the Print Queue Identification page.



Details of a Print Job in This Print Queue 
This dialog shows the details of one of the print jobs that is currently in this print queue.
You must be an operator of this print queue to change a print job that you did not submit. If you are an 
operator, or you submitted the print job that you are viewing, you can change any of the fields that are not 
dimmed.

Procedures
Setting Up NetWare Print Services

Screen regions and buttons
Print Job shows the job ID of this print job.

File Size shows the file size, in bytes, of this print job.

Client shows the name of the user who submitted this print job.

Description shows a description that was entered for this print job.

Status shows the status of this print job. The possible statuses are as follows:

Print job is being serviced.
Print job has operator hold.
Print job is ready and waiting for the print server.
Print job is being added to the print queue.
Print job will be serviced at the target date and time.

User Hold indicates that the print job has been put on hold by the user who submitted the print job.

Operator Hold indicates that the print job has been put on hold by the queue operator.

Service Sequence shows this print job's position in line to be printed.

Number of Copies shows how many copies of this print job the print server are to be sent to the 
printer.

File Contents shows the type of file that was sent for this print job.

Byte Stream indicates that this print job consists of a byte stream file, such as a graphic, or PostScript
file.

Text indicates that this print job consists of a text file, containing only ASCII characters.

Tab Size is used only with text files, and sets the number of spaces between tab stops.

Form Feed shows whether or not a form feed character is sent to the printer at the end of this print 
job.

Notify When Job is Printed shows whether users are notified when this print job has been completed.

Entry Date shows the date that this print job was submitted to the queue.

Entry Time shows the time that this print job was submitted to the queue.

Form shows which printer form is being used to print this print job. You can select from available 
printer forms using the drop-down box.

Print Banner shows whether a banner page with identification information is being printed as the first 
page of this print job.

Name identifies the user who sent this print job. This is only valid if a banner page is printed.

Banner Name indicates the name of the print job. This is only valid if a banner page is printed.

Defer Printing indicates that the printing of this job is delayed until a later date and time.



Target Date shows the date when this print job will be printed. This field is valid only if Defer Printing 
is selected.

Target Time shows the time when this print job will be printed. This field is only valid if Defer Printing 
is selected.

OK saves changes in this dialog and returns to the list of print jobs in this print queue.

Cancel closes this dialog without saving changes and returns to the list of print jobs in this print 
queue.



Print Queue Assignments Page 
The Assignments page lists the printers this print queue is assigned to and the print servers assigned to 
the printers. You cannot change these assignments here, only view them.
To change assignments between Print Server and Printer objects, use the Print Server object dialog. To 
change assignments between Printer and Print Queue objects, use the Printer object dialog.

Procedures
How to Use the Object Dialog
Setting Up NetWare Print Services

Screen regions and buttons
Authorized Print Servers shows the print servers that are servicing this print queue. You must use the 

Print Server object dialog to change these assignments.

Printers Servicing Print Queue shows the printers that are receiving print jobs from this print queue. 
You must use the Printer object dialog to change these queue assignments.



View or Change the List of Print Queue Operators
Operators of a print queue are allowed to manage the print jobs in the print queue. This includes activities
such as deleting print jobs or changing their order. Use the Operators page to record operators of this 
print queue. For example, you can do the following:

 See which objects are listed as operators
 Add or delete objects from the list of operators

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until you 
have entered all changes to this page and other pages. If you choose Cancel, you    lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add an Operator
Delete an Operator

Screen regions and buttons
Operators lists objects that are operators of this print queue.

OK saves the changes specified in all pages of the object dialog and returns you to the browser.

Cancel closes the dialog without saving the changes entered in any page.



Add an Operator
1. Choose Add.
2. Select objects that you want to add as operators.
3. Choose OK.

The objects you selected are listed as operators. These objects can manage the print jobs in this print
queue.



Delete an Operator
1. Select an operator from the Operators list.
2. Choose Delete.

The operator is removed from the list.
3. Choose OK.



View or Change the List of Users for a Print Queue
Objects that are listed as users of this print queue are allowed to submit print jobs to this print queue, and 
to manage jobs they submit.
The Users page lists users of this print queue. This list is created and maintained by the network 
supervisor. On this page, if you have appropriate rights, you can do the following:

 View users who access this print queue
 Add or delete a user of this print queue

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until you 
have entered all changes to this page and other pages. If you choose Cancel, you    lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a User
Delete a User

Screen regions and buttons
Users lists all objects that are users of this print queue and are allowed to submit print jobs to it.

OK returns to the browser and saves any changes you have made.

Cancel returns to the browser without saving any changes that you have made.



Add a Print Queue User
1. Choose Add.
2. Choose the object you want to add to the list.
3. Choose OK.

You return to the Users page, and the new object is displayed. This object can now submit print jobs 
to this print queue.



Delete a Print Queue User
1. Select a user from the Users list.
2. Choose Delete.

The user is deleted from the list.
3. Choose OK.



Log In to a Server
Server Login allows you to establish a bindery connection to a NetWare server that is not in your current 
Directory tree so that you can access its print queues.
Enter your username and password for the server, then choose OK.



Reference a Bindery Queue
Allows you to browse for an existing print queue outside of your Directory tree so that you can create a 
Print Queue object for that queue.    
Creating a Print Queue object allows you to manage printing in an environment that is running multiple 
versions of NetWare or that has more than one Directory tree.
You can locate print queues on any server you have an account on.

To locate a print queue
1. At the Create Print Queue dialog, choose Reference a Bindery Queue.
2. From the Network Servers list, select a server. 

To access a print queue on a server you are not attached to, unmark List Only Attached Servers.
2. From the Queues list, select the print queue that you want to appear in the Directory tree.
3. Choose OK.

You can now create a print queue object in the Directory tree.
Screen regions and buttons

Network Server/Queue displays the queue that appears in the Directory tree and the queue's bindery 
server.

List Only Attached Servers allows you to limit the list of bindery servers to only those you are currently
attached to or expand the list to all bindery servers in the network. If your network is large, 
building a list of all servers can take some time.

Network Servers lists servers outside of your Directory tree from which you may want to access 
queues.

Queues lists queues available on the server highlighted in the Network Servers list.

OK transfers the information listed in the Network Sever/Queue field to the appropriate fields in the 
Create Print Queue dialog.

Cancel returns you to the Create Print Queue dialog without changing any of its information.

Related Topics
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View Print Layout
Print layout shows a map of your printing setup. You can see which print objects are assigned to each 
other and each object's status. This information can help you quickly determine if printing is up or which 
print objects may have problems.
Double-clicking on a print object in the print layout expands or contracts the tree of objects below.
A trouble icon indicates printing problems. Expand the print layout tree completely to see exactly which 
object is not functioning 
A dashed line between objects means the connection is established only for the current print server 
session rather than configured to connect every time the print server is loaded.

Screen regions and buttons
Update refreshes the print layout tree to reflect any changes with the print objects.

Status provides a brief summary of the selected printing object's details. For complete detail 
information, select the object in the browser Directory tree and choose Details.

To view the status for an object, use the right-hand mouse button.

Status for print jobs is not available in print layout. Manage print jobs from the queue the job is 
stored in.



Audit Print Jobs
The auditing log is a file created by the print server that allows you to track print jobs. The log stores 
information such as which printer the job was sent to, how large the job was, and how long it took to print.
By default, the auditing log is not enabled. No log file is created unless you enable auditing, and then 
unload and reload the print server.
The auditing log provides information about all jobs that have been printed. Auditing records are retained 
as ASCII files so that they can be read with any text editor. In designing the auditing log, Novell has 
recognized that companies do accounting in a variety of ways. For this reason, the auditing log provides a
basic default format based on ASCII and a fixed record length. Both characteristics are designed to make 
it as easy as possible to write a customized program to retrieve the information you need in a format 
determined by your organization.
The auditing log is sufficiently flexible to record whatever information a printer sends to it. Regardless of 
printer type, the log records how many bytes a job took to print, the user who submitted the job, when the 
job entered the print queue, when the job was printed, and what printer serviced the job.
If the printer is an XNP type used by Macintosh or UNIX, the log might also indicate how long it took to 
print the job, how many pages were printed, when the job was printed, and when the job was submitted.

Screen regions and buttons
Status indicates whether auditing is enabled or disabled. Choose Enable Auditing to enable auditing. 

Choose Disable Auditing to disable auditing.

Location of Auditing Log shows the path where the log file is created. This location is not configurable.

Current Size is the size of the file.

Limit Size allows you to specify whether you want to limit the size of the log file. If the print server log 
is not monitored regularly, it can grow until it uses all available disk space. Limiting the size of this
file prevents this problem, but you risk losing valuable accounting information because 
information is not recorded after the maximum size has been reached.

Maximum Print Jobs allows you to limit the number of print jobs recorded in the auditing log.

After auditing has been enabled, you must unload and then reload the print server for auditing to begin.
After you have enabled auditing, we suggest that you submit a print job to ensure that the log is recording 
information on print jobs properly.



Change a Print Server Password
You can help ensure security for your print server by limiting access to it with a password. Security could 
be compromised if someone gains unauthorized access as a Print Server object and takes advantage of 
security equivalencies.
The following are suggestions for passwords that improve network security:

 Don't use common dictionary words
 Don't use the names of family members or pets
 Don't use birthdays
 Use combinations of words
 Combine alpha and numeric characters in the password

To change a password
1. In the New Password field, type the new password. (The Old Password field is permanently dimmed.)

The password is not case sensitive.
2. In the Retype New Password field, type the new password again.
3. Choose OK.

Note: To remove a password without assigning a new one, leave both fields blank and choose OK.
Screen regions and buttons

New Password is where you enter the new password.

Retype New Password is where you enter the new password a second time.

OK changes the password.

Cancel closes this dialog without changing the password.



How to Use the Object Dialog
Use the object dialog to set or change information about an object. You can open an object dialog several 
different ways.
The object dialog has two areas: 

 An information area, where you work with that object
 A page area, where you specify information about the object

To open pages, choose a page button. The information area changes when you open a page. All pages 
are part of the object dialog. When you open a page, you're still in the same object dialog.
You can move back and forth between pages by pressing the <CTRL> Page Up and <CTRL> Page Down
keys on your keyboard.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Screen regions and buttons
More  allows multiple entries in a field.

browser  appears next to fields that require the complete name of an object. Lets you browse and select
an object.
Page buttons change the information you can edit.
OK saves the changes in all pages of the dialog.
Cancel closes the dialog without saving the changes entered in any page.



Enter a Title
The Title property is one of several properties of this object that are shown on the Identification page of 
the object dialog. 
Use this procedure as an example for entering values for any of the properties on the Identification page 
with a similar field style.

To enter a title
1. Select the Title field.

Note: If this is not the first value in the Title property, you must choose the More button to the right of 
the Title field and use the dialog that appears to enter other values. Choose Help in that dialog for 
more information.

2. Type the title that you want recorded as a property of this object.
3. Choose OK.

The information is saved to NetWare Directory Services when you choose OK.



Enter Another Name for This Object
The Other Names field can record any identification information you think is useful for this object. You can
add several alternative names for this object. Any of these names can be used when searching for this 
object.
Use this procedure as an example for entering values for any of the properties on the Identification page 
with a similar field style.

To enter another name for this object
1. Select the Other Name field.

Note: If this is not the first value in the Other Names property, choose the More button to the right of 
the Other Names field and use the dialog that appears to enter other values. Choose Help in that 
dialog for more information.

2. Type the name you want recorded as a property of this object.
3. Choose OK.

The information is saved to NetWare Directory Services when you choose OK.



Enter a Location for This Object
The Location field can record any information that you think is useful for this object. It is generally used to 
record the physical location of the object, such as where your office complex is located.
Use this procedure as an example for entering values for any of the properties on the Identification page 
with a similar field style.

To enter a location
1. Select the Location field.

Note: If this is not the first value in the Location property, choose the More button to the right of the 
Location field and use the dialog that appears to enter other values. Choose Help in that dialog for 
more information.

2. Type the location that you want recorded for this object.
3. Choose OK.

The information is saved to NetWare Directory Services when you choose OK.



Enter a Description of This Object
The Description field can record any information that you think is useful. 
You can enter up to 30 lines of 37 characters each. 
Description is a property of most objects in NetWare Directory Services.

To enter a description
1. Select the Description field.
2. Type the information that you want recorded for this object.

The information scrolls as you type. Use the scroll bar to the right of the field to scroll through the text 
that you have entered. Choose Help for more information.

3. Choose OK.
The information is saved to NetWare Directory Services when you choose OK.



Enter a Serial Number for This Object
The Serial Number field can be used to record the unique serial number of this object. A serial number 
uniquely identifies each piece of equipment you own. 
This field can be very useful when searching for information about a specific piece of equipment.

To enter a serial number
1. Select the Serial Number field.
2. Type the serial number of the piece of equipment represented by this object.
3. Choose OK.

The information is saved to NetWare Directory Services when you choose OK.



Enter a Fax or Phone Number for This Object
The Fax and Telephone Number fields record numbers where the people or places represented by this 
object can be reached. 
You can enter several fax numbers and several phone numbers for each object.
Use this procedure as an example for entering values for any of the properties on the Identification page 
with a similar field style.

To enter a fax or phone number
1. Select the Fax or Telephone Number field.

Note: If this is not the first value in the Fax or Telephone Number property, choose the More button to 
the right of the field and use the dialog that appears to enter other values. Choose Help for more 
information.

2. Type the number that you want recorded as a property of this object.
You can use any characters or symbols.

3. Choose OK.
The information is saved to NetWare Directory Services when you choose OK.



See What Name Spaces Are Used on This Volume
To see what name spaces are available (or installed) on the volume where this file or directory is stored, 
look at the Name Space list. Every file or directory on a volume must have a name in every name space 
that is installed on that volume.
For example, if your file has a name shown for DOS, OS/2, and Macintosh name spaces, those name 
spaces are available to every file on that volume, and every file must have a name in each of those name 
spaces.



See the Name of This File or Directory in Each Available Name Space
The name of each file or directory is listed with all of the available name spaces in the table on the 
Identification page of the object dialog for the file or directory. Look at the table to see what the name of 
the file or directory name is in each of the available name spaces.



Printer Forms
You can designate a printer form in a print job configuration to prevent your printer from printing a job on 
the wrong paper. 
When the print server detects a job in the print queue and that job requests a form other than the form 
currently mounted in the intended printer, the printer is paused and you are notified that a new form must 
be mounted before the print job can be serviced.
Printer forms do not in themselves specify any action for the printer to take. They simply prevent a job 
from printing until you change to the type of paper you want to print on and then tell the printer (using 
PCONSOLE, PSC, or NetWare Administrator) to resume printing. You can also mount printer forms at the 
NetWare Server console in the print server console.
Printer form names must begin with an alphabetic character and can have up to 12 alpha-numeric 
characters. Numbers can range from 0-255. Length can range from 1-255. Width can range from 1-999. 
Width numbers are for your information only. They do not control what the printer does. The length value 
is used by the rewind function.
The Printer Forms page lists the different forms that can be used when printing to a Printer object in this 
container.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Create a New Printer Form
Modify a Printer Form
Delete a Printer Form

Screen regions and buttons
Number/Name lists the number and name of each printer form defined for this container object.

Create opens the Create Printer Form dialog, where you can enter values for a new printer form.

Modify opens the Modify Printer Form dialog with the values of the selected printer forms displayed. 
You can then change any of these values.

Delete opens the Delete Printer Form dialog that displays the values of the selected printer forms. 
This allows you to see what you are deleting when you choose OK.

All changes take effect immediately.



Create a New Printer Form
1. From the Printer Forms page, choose Create.

The Create Printer Form dialog appears.
2. In the Name field, enter a name.

The name must begin with a letter and must be unique. It can be up to 12 characters long. Spaces 
are converted to underscores (_).

3. In the Number field, enter a number from 0 to 255.
4. In the Length field, enter a number from 1 to 255.

This is the length of the printer form you are defining, measured in lines of text.
5. In the Width field, enter a number from 1 to 999.

This is the width of the printer form you are defining, measured in characters.
6. Choose OK.

A printer form with the name you entered is listed in the Printer Forms list box. Any time that printer 
form is used, the values you entered with that printer form name are used.



Modify a Printer Form
1. From the Printer Forms page, select a printer form from the Printer Forms list box.
2. Choose Modify.

The Modify Printer Form dialog appears. The values for the printer form that you selected appear in 
the fields of the dialog. You can change any of the fields.

3. (Optional) In the Name field, enter a new name.
The name must begin with a letter and must be unique. It can be up to 12 characters long. Spaces 
are converted to underscores (_).

4. (Optional) In the Number field, enter a number from 0 to 255.
5. (Optional) In the Length field, enter a number from 1 to 255.

This is the length of the printer form you are redefining, measured in lines of text.
6. (Optional) In the Width field, enter a number from 1 to 999.

This is the width of the printer form you are redefining, measured in characters.
7. Choose OK.

The form is now modified. The printer form that you selected in Step 1 is still selected. It appears with 
a different name if you changed the Name field in Step 3.
 You do not have to choose OK in the object dialog to complete the action.



Delete a Printer Form
1. From the Printer Forms dialog, select a printer form from the Printer Forms list box.
2. Choose Delete.

The Delete Printer Form dialog appears. The values for the printer form you selected appear in the 
fields, but are grayed. You can see what values you are deleting as part of this printer form, but you 
cannot change them here.

3. Choose OK.
You return to the Printer Forms list box. The printer form that you selected is deleted from the list of 
printer forms. 
The Delete operation cannot be undone. 
You do not have to choose OK in the object dialog to complete the action.



Print Device Definitions
The Print Devices page lists the names of different types of print devices that can be used as printers in 
this container. You can add new definitions for print devices, or modify the definitions of existing print 
devices. Use Import and Export to avoid re-entering information for the same device in different 
containers.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Create a New Print Device Definition
View or Modify a Print Device Definition
Delete a Print Device Definition
Import a Print Device Definition
Export a Print Device Definition

Screen regions and buttons
Print Devices lists the names of the print devices defined for use in this container object.

Create opens the Create Print Device dialog, where you can enter the name for a new print device. 
Functions and modes are added using the Modify Print Device dialog.

Modify opens the Modify Print Device dialog, where you can view or add functions and modes for the 
selected print device.

Delete opens the Delete Print Device dialog, where you can see the name of the selected print device
definition before deleting it. You cannot examine functions and modes from this dialog.

Import opens the Import Print Device dialog, which allows you to use an existing definition without re-
entering the information.

Export opens the Export Print Device dialog, where you can enter the name of a file that the selected 
print device definition should be saved as.

All changes take effect immediately.



Create a Print Device
This dialog allows you to create a new print device that can be used by objects in this container. 
A print device is defined by name, functions, and modes, but you enter only a name in the Create dialog. 
Use the Modify Print Device dialog to enter functions and modes.

To create a new print device definition
1. In the Name field, enter a print device name.

You can use up to 32 characters for the name. It must begin with a letter or number; spaces are 
allowed.

2. Choose OK.
The name of the print device that you entered is added to the list. Use the Modify Print Device dialog 
to define functions and modes for this print device before using it.



Delete a Print Device Definition
This dialog allows you to delete the definition of a print device that was previously entered. The definition 
can then no longer be used by objects in this container. All functions and modes are deleted at the same 
time.

To delete this print device definition
1. From the Print Devices list box, select a print device name.
2. Choose Delete.

The Delete Print Device dialog appears with the Name field and the Functions and Modes buttons 
grayed. You cannot modify the definition here; you can only see what you are deleting.

3. Choose OK.
The print device that was listed in the Name field is deleted from the Print Devices list box and is no 
longer available to objects in this container.



Import a Print Device
This dialog allows you to import a definition for a print device that can be used by objects in this container.
A definition consists of a name, functions, and modes.
With NetWare, Novell ships a set of commonly used .PDF files, which are found in the SYS:PUBLIC 
directory. In order to use these definitions in your job configurations, they must be imported.
The Import button allows you to use an existing definition without re-entering all of the functions and 
modes. You may import a definition that was provided with NetWare or that was created for another 
container. To import a print device in this dialog, use the following procedure:

To import a print device definition
1. From the File Open dialog, choose Import below the Print Devices list box.
2. From the Files window, select the file for the print device definition that you want to import.

The file extension .PDF is used for print device definition files.
3. Choose OK.

The print device is added to the Print Devices list box, and the definition contained in the file can now 
be used by objects in this container.



Export a Print Device
This dialog allows you to export a print device definition listed in this dialog from a database. The print 
device definition can then be imported for use in other containers without re-entering all functions and 
modes.

To export a print device definition
1. From the Print Devices list box, select a print device definition.
2. Choose Export below the Print Devices list box.
3. Find the directory where you want to create a file containing this print device definition.

The file extension .PDF is used for print device definition files.
The name of the print device definition is used as the filename when you export a definition. All 
spaces are removed and the first eight characters of the print device definition are used.

4. Choose OK.
The print device definition is saved. All functions and modes are included in the definition. The 
definition can be imported to another container.



Modify a Print Device Definition
This dialog allows you to modify the definition of a print device that was previously created. You can add, 
change, or delete the functions and modes that are defined for this device. The definition can be used by 
objects in this container.
You can change a print device name, or any of its functions or modes.
A function is an action that the print device can perform, such as bold text or proportional spacing. 
A mode is a combination of functions that you define to prepare the print device for specific printing 
needs. For example, you might define a print mode called Title that includes functions for bold, double 
wide, and letter-quality printing.

Procedures
Change the Name of This Print Device
Add a Function to This Print Device
Modify a Function
Delete a Function
Add a Mode to This Print Device
Modify a Mode
Delete a Mode 

Screen regions and buttons
Name shows the name of this print device.

Functions shows the functions that have been entered for this print device. These include all of the 
capabilities of this print device, such as compressed or letter-quality printing.

Modes shows the modes that have been entered for this print device. A mode is a combination of 
functions that you define to serve a specific printing need.

Create Function allows you to add a function to the Functions list.

Create Mode allows you to define a new mode and add it to the Modes list.

Modify allows you to change the selected mode or function by adding or removing functions or control
sequences, respectively, from its definition.

Delete deletes the selected mode or function. The functions that were a part of a selected mode are 
not affected; they are still part of the print device definition.



Change the Name of This Print Device
1. In the Name field, enter a new name.
2. Choose OK.

You return to the list of print devices. The new name appears in the list.



Add a Function to This Print Device
1. Choose Create Function.

The Create Function dialog appears. The name of the print device is at the top of the dialog.
2. In the Function Name field, enter a name for the new function. 

Function names must be unique (no two names can be the same) and no longer than 32 characters. 
Function names are not case sensitive. You can use both letters and numbers.

3. Enter the characters used by this printer as a control sequence to engage this function. 
Characters with ASCII values from 33 through 126 are not delimited; they appear as is. If a character 
in the control sequence has an ASCII value less than 33 or equal to 127, the character is displayed as
a delimited acronym, as listed below. If the character's ASCII value is greater than 127, it is displayed 
as a delimited ASCII value. The value is a decimal number.
The space character can be entered as a space or as a delimited token. A space is displayed as a 
delimited token. 
Except for delimited tokens, characters in a function follow the used as is rule. This means that the 
characters you see displayed are the actual characters that make up the function.
Delimited Tokens
PRINTDEF functions can contain special characters when delimited tokens are included in the 
function. A delimited token has two parts--the delimiters and the token. 
The three types of delimiters are

Angle brackets < and >
Backwards slash \
Caret ^

Because these characters function as delimiters, they are exceptions to the used as is rule. To enter a
left-angle bracket (<), backwards slash (\), or caret (^), you must enter two characters. The right-angle
bracket (>) can be used as is. 
For example, a function that contains the string \\<<^^> will be interpreted as \<^>. The double rule is 
used when entering and displaying PRINTDEF functions.
The other part to a delimited token is the token. A token can be a number, character, or a valid 
character string.
Numbers are used in conjunction with the angle bracket or backwards slash delimiters and can be 
entered in decimal or hexadecimal. To enter a hexadecimal number, use a 0x or 0X prefix. A number 
without the hexadecimal prefix is assumed to be decimal. 
For example, the ASCII control character can be input by the delimited numbers <27>, <0x1b>, 
<0X1B>, \27, \0x1b, or \0X1B. 
You can enter any ASCII character value from 0 to 255 using this method.
Character tokens can be used with angle bracket or caret delimiters. Valid characters are A through Z 
and a through z. Delimited character tokens are the same as ASCII control characters. In other words,
^A has an ASCII value of 1, ^B has an ASCII value of 2, etc.
Character string tokens are the names or acronyms of ASCII control characters. The name is not 
case sensitive. For example, the ASCII control character can be input by the delimited strings <esc>, 
<ESC>, or <Esc>.
The syntax for a delimited token is any of the following:

delimited_token = delimited_number, delimited_character, or delimited_string
delimited_number = <number_token> or \number_token
delimited_character = ^character_token or <^character_token>
delimited_string = <string_token>
character_token = A - Z or a - z
string_token = <control character name>

The following are examples of three equivalent functions:
<ESC><SI>^^<DEL><soh> 
<0x1B><0xF>\0x5E<0x7F>^A
\27<15><94><127>\1



ASCII ValueVALID STRING TOKENS
      0      NUL, NULL
      1      SOH, ^A, START OF HEADER, START_OF_HEADER, STARTOFHEADER
      2      STX, ^B, START OF TEXT, START_OF_TEXT, STARTOFTEXT
      3      ETX, ^C, END OF TEXT, END_OF_TEXT, ENDOFTEXT
      4      EOT, ^D, END OF TRANSMISSION, END_OF_TRANSMISSION, ENDOFTRANSMISSION
      5      ENQ, ^E, ENQUIRE
      6      ACK, ^F, ACKNOWLEDGE
      7      BEL, ^G, BELL
      8      BS,    ^H, BACK SPACE, BACK_SPACE, BACKSPACE
      9      TAB, ^I, HT, HORIZONTAL TAB, HORIZONTAL_TAB, HORIZONTALTAB
    10      LF,    ^J, LINE FEED, LINE_FEED, LINEFEED
    11      VT,    ^K, VERTICAL TAB, VERTICAL_TAB, VERTICALTAB
    12      FF,    ^L, FORM FEED, FORM_FEED, FORMFEED
    13      CR,    ^M, RET, CARRIAGE RETURN, CARRIAGE_RETURN, CARRIAGERETURN
    14      SO,    ^N, SHIFT OUT, SHIFT_OUT, SHIFTOUT
    15      SI,    ^O, SHIFT IN, SHIFT_IN, SHIFTIN
    16      DLE, ^P, DATA LINK ESCAPE, DATA_LINK_ESCAPE, DATALINKESCAPE
    17      DC1, ^Q, DEVICE CONTROL 1, DEVICE_CONTROL_1, DEVICECONTROL1
    18      DC2, ^R, DEVICE CONTROL 2, DEVICE_CONTROL_2, DEVICECONTROL2
    19      DC3, ^S, DEVICE CONTROL 3, DEVICE_CONTROL_3, DEVICECONTROL3
    20      DC4, ^T, DEVICE CONTROL 4, DEVICE_CONTROL_4, DEVICECONTROL4
    21      NAK, ^U, NEGATIVE ACKNOWLEDGE, NEGATIVE_ACKNOWLEDGE, 
NEGATIVEACKNOWLEDGE
    22      SYN, ^V, SYNCHRONOUS
    23      ETB, ^W, END OF TRANSMISSION BLOCK, END OF TRANS BLOCK, 
END_OF_TRANSMISSION_BLOCK, ENDOFTRANSMISSIONBLOCK
    24      CAN, ^X, CANCEL
    25      EM,    ^Y, END OF MEDIUM, END_OF_MEDIUM, ENDOFMEDIUM
    26      SUB, ^Z, SUBSTITUTE
    27      ESC, ^[, EC, ESCAPE
    28      FS,    ^/, FILE SEPARATOR, FILE_SEPARATOR, FILESEPARATOR
    29      GS,    ^], GROUP SEPARATOR, GROUP_SEPARATOR, GROUPSEPARATOR
    30      RS, RECORD SEPARATOR, RECORD_SEPARATOR, RECORDSEPARATOR
    31      US,    ^_, UNIT SEPARATOR, UNIT_SEPARATOR, UTILSEPARATOR
    32      SP, SPACE
 127      DEL, DELETE

4. Choose OK.
You return to the Modify Print Device dialog. The function that you entered is listed in the Functions 
list.



Modify a Function
You can create or modify print device functions by entering the necessary control sequences. These 
control sequences (also called control codes or escape sequences) are described in the operator's 
manual for your printer.
A function is an action that the print device can perform, such as bold text or proportional spacing. You 
can cause the print device to perform the function by sending control codes to the print device. 

Create or modify a print device function
1. From the Functions list, select a function.

You cannot select a function and a mode at the same time in this dialog.
2. Choose Modify.

The Modify Function dialog appears. The name of the print device is shown at the top of the dialog.
3. (Optional) In the Function Name field, enter a new name for the function. 

Function names must be unique (no two names can be the same) and no longer than 32 characters. 
Function names are not case sensitive. You can use both letters and numbers.

4. Enter the characters used by this printer as a control sequence to engage this function.
Characters with ASCII values from 33 through 126 are not delimited; they appear as is. If a character 
in the control sequence has an ASCII value less than 33 or equal to 127, the character is displayed as
a delimited acronym, as listed below. If the character's ASCII value is greater than 127, it is displayed 
as a delimited ASCII value. The value is a decimal number.
The space character can be entered as a space or as a delimited token. A space is displayed as a 
delimited token. 
Except for delimited tokens, characters in a function follow the used as is rule. This means that the 
characters you see displayed are the actual characters that make up the function.
Delimited Tokens
PRINTDEF functions can contain special characters when delimited tokens are included in the 
function. A delimited token has two parts--the delimiters and the token. 
The three types of delimiters are

Angle brackets < and >
Backwards slash \
Caret ^

Because these characters function as delimiters, they are exceptions to the used as is rule. To enter a
left-angle bracket (<), backwards slash (\), or caret (^), you must enter two characters. The right-angle
bracket (>) can be used as is. 
For example, a function that contains the string \\<<^^> will be interpreted as \<^>. The double rule is 
used when entering and displaying PRINTDEF functions.
The other part to a delimited token is the token. A token can be a number, character, or a valid 
character string.
Numbers are used in conjunction with the angle bracket or backwards slash delimiters and can be 
entered in decimal or hexadecimal. To enter a hexadecimal number, use a 0x or 0X prefix. A number 
without the hexadecimal prefix is assumed to be decimal. 
For example, the ASCII control character can be input by the delimited numbers <27>, <0x1b>, 
<0X1B>, \27, \0x1b, or \0X1B. 
You can enter any ASCII character value from 0 to 255 using this method.
Character tokens can be used with angle bracket or caret delimiters. Valid characters are A through Z 
and a through z. Delimited character tokens are the same as ASCII control characters. In other words,
^A has an ASCII value of 1, ^B has an ASCII value of 2, etc.
Character string tokens are the names or acronyms of ASCII control characters. The name is not 
case sensitive. For example, the ASCII control character can be input by the delimited strings <esc>, 
<ESC>, or <Esc>.
The syntax for a delimited token is any of the following:

delimited_token = delimited_number, delimited_character, or delimited_string



delimited_number = <number_token> or \number_token
delimited_character = ^character_token or <^character_token>
delimited_string = <string_token>
character_token = A - Z or a - z
string_token = <control character name>

The following are examples of three equivalent functions:
<ESC><SI>^^<DEL><soh> 
<0x1B><0xF>\0x5E<0x7F>^A
\27<15><94><127>\1

ASCII ValueVALID STRING TOKENS
      0      NUL, NULL
      1      SOH, ^A, START OF HEADER, START_OF_HEADER, STARTOFHEADER
      2      STX, ^B, START OF TEXT, START_OF_TEXT, STARTOFTEXT
      3      ETX, ^C, END OF TEXT, END_OF_TEXT, ENDOFTEXT
      4      EOT, ^D, END OF TRANSMISSION, END_OF_TRANSMISSION, ENDOFTRANSMISSION
      5      ENQ, ^E, ENQUIRE
      6      ACK, ^F, ACKNOWLEDGE
      7      BEL, ^G, BELL
      8      BS,    ^H, BACK SPACE, BACK_SPACE, BACKSPACE
      9      TAB, ^I, HT, HORIZONTAL TAB, HORIZONTAL_TAB, HORIZONTALTAB
    10      LF,    ^J, LINE FEED, LINE_FEED, LINEFEED
    11      VT,    ^K, VERTICAL TAB, VERTICAL_TAB, VERTICALTAB
    12      FF,    ^L, FORM FEED, FORM_FEED, FORMFEED
    13      CR,    ^M, RET, CARRIAGE RETURN, CARRIAGE_RETURN, CARRIAGERETURN
    14      SO,    ^N, SHIFT OUT, SHIFT_OUT, SHIFTOUT
    15      SI,    ^O, SHIFT IN, SHIFT_IN, SHIFTIN
    16      DLE, ^P, DATA LINK ESCAPE, DATA_LINK_ESCAPE, DATALINKESCAPE
    17      DC1, ^Q, DEVICE CONTROL 1, DEVICE_CONTROL_1, DEVICECONTROL1
    18      DC2, ^R, DEVICE CONTROL 2, DEVICE_CONTROL_2, DEVICECONTROL2
    19      DC3, ^S, DEVICE CONTROL 3, DEVICE_CONTROL_3, DEVICECONTROL3
    20      DC4, ^T, DEVICE CONTROL 4, DEVICE_CONTROL_4, DEVICECONTROL4
    21      NAK, ^U, NEGATIVE ACKNOWLEDGE, NEGATIVE_ACKNOWLEDGE, 
NEGATIVEACKNOWLEDGE
    22      SYN, ^V, SYNCHRONOUS
    23      ETB, ^W, END OF TRANSMISSION BLOCK, END OF TRANS BLOCK, 
END_OF_TRANSMISSION_BLOCK, ENDOFTRANSMISSIONBLOCK
    24      CAN, ^X, CANCEL
    25      EM,    ^Y, END OF MEDIUM, END_OF_MEDIUM, ENDOFMEDIUM
    26      SUB, ^Z, SUBSTITUTE
    27      ESC, ^[, EC, ESCAPE
    28      FS,    ^/, FILE SEPARATOR, FILE_SEPARATOR, FILESEPARATOR
    29      GS,    ^], GROUP SEPARATOR, GROUP_SEPARATOR, GROUPSEPARATOR
    30      RS, RECORD SEPARATOR, RECORD_SEPARATOR, RECORDSEPARATOR
    31      US,    ^_, UNIT SEPARATOR, UNIT_SEPARATOR, UTILSEPARATOR
    32      SP, SPACE
 127      DEL, DELETE

5. Choose OK.



Delete a Function
1. From the Functions list, select a function.
You cannot select a function and a mode at the same time in this dialog.
2. Choose Delete.

The Delete Function dialog appears. The name of the print device is at the top of the dialog. All fields 
are grayed because you cannot change anything; you can only see what you are deleting.

3. Choose OK.



Add a Mode to This Print Device Definition
To create a mode, you select functions that have been defined for this print device. You can repeat a 
function in a mode definition. Functions are executed in the order listed.
1. Choose Create Mode.

The Create Mode dialog appears. The name of the print device is shown at the top of the dialog.
All of the functions defined for this printer are listed in the Device Functions list box.

2. In the Mode Name field, enter a name for the new mode.
3. From the Device Functions list, select the function that you want to be executed first. Functions are 

executed in the order listed.
4. Choose Add Below.
5. From the Device Functions list, select the function that you want to be executed next.

You can select the same function more than once if the mode requires it.
6. Repeat Steps 4 and 5 until all of the functions that you want as part of this mode are listed in correct 

order in the Mode Functions list box.
If you make a mistake, use the Delete or Add Above buttons to rearrange the functions listed in Mode 
Functions.

7. Choose OK.



Modify a Mode
1. From the Modes list in the Modify Print Devices dialog, select a mode.

You cannot select both a function and a mode in this dialog.
2. Choose Modify.

The Modify Mode dialog appears. The name of the print device is shown at the top of the dialog for 
your reference.
All of the functions defined for this printer are listed in the Device Functions list box.

3. (Optional) In the Mode Name field, enter a new name for the mode.
4. From the Device Functions list, select the function that you want to add to the mode.
5. In the Mode Functions list, select the function next to where you want to insert the new function.
6. Choose Add Below or Add Above to insert the selected device function in the correct place in the 

Mode Functions list.
7. Select any mode function that you want to delete from the definition of this mode.
8. Choose Delete.

The selected function is no longer a part of this mode definition. The function is still a part of this 
device definition, but is not used for this mode.

9. Repeat Steps 4 through 8 for modes you want to modify.
10. Choose OK.

You return to the Modify Print Device dialog.



Delete a Mode 
1. Select a mode from the Modes list.

Note: You cannot delete the [Reinitialization] mode from the list, even if it has no functions defined. 
You should add functions to the [Reinitialization] mode to restart your printer and create the correct 
settings. Refer to your printer documentation.
You cannot select a function and a mode at the same time in this dialog.

2. Choose Delete.
The Delete Mode dialog appears. The name of the print device is shown at the top of the dialog. All 
fields are grayed because you cannot change anything; you can only see what you are deleting.

3. Choose OK.



Create a Function for a Print Device
This dialog allows you to enter a name and control sequences to define a print device function. Control 
sequences (also called control codes or escape sequences) are described in the operator's manual of 
your print device.
A function is an action that the print device can perform, such as bold text or proportional spacing. You 
cause the print device to perform the function by sending control sequences to the print device.

To create a new function definition
1. In the Function field, enter a function name.

Function names must be unique (no two names can be the same) and no longer than 32 characters. 
Function names are not case sensitive. You can use both letters and numbers.

2. In the Control Sequence field, enter a control sequence by typing the characters that the printer uses 
to set that function.
See the operator's manual for your print device to find the correct control sequences for print device 
functions.
Characters with ASCII values from 33 through 126 are not delimited; they appear as is. If a character 
in the control sequence has an ASCII value less than 33 or equal to 127, the character is displayed as
a delimited acronym, as listed below. If the character's ASCII value is greater than 127, it is displayed 
as a delimited ASCII value. The value is a decimal number.
The space character can be entered as a space or as a delimited token. A space is displayed as a 
delimited token. 
Except for delimited tokens, characters in a function follow the used as is rule. This means that the 
characters you see displayed are the actual characters that make up the function.
Delimited Tokens
PRINTDEF functions can contain special characters when delimited tokens are included in the 
function. A delimited token has two parts--the delimiters and the token. 
The three types of delimiters are

Angle brackets < and >
Backwards slash \
Caret ^

Because these characters function as delimiters, they are exceptions to the used as is rule. To enter a
left-angle bracket (<), backwards slash (\), or caret (^), you must enter two characters. The right-angle
bracket (>) can be used as is. 
For example, a function that contains the string \\<<^^> will be interpreted as \<^>. The double rule is 
used when entering and displaying PRINTDEF functions.
The other part to a delimited token is the token. A token can be a number, character, or a valid 
character string.
Numbers are used in conjunction with the angle bracket or backwards slash delimiters and can be 
entered in decimal or hexadecimal. To enter a hexadecimal number, use a 0x or 0X prefix. A number 
without the hexadecimal prefix is assumed to be decimal. 
For example, the ASCII control character can be input by the delimited numbers <27>, <0x1b>, 
<0X1B>, \27, \0x1b, or \0X1B. 
You can enter any ASCII character value from 0 to 255 using this method.
Character tokens can be used with angle bracket or caret delimiters. Valid characters are A through Z 
and a through z. Delimited character tokens are the same as ASCII control characters. In other words,
^A has an ASCII value of 1, ^B has an ASCII value of 2, etc.
Character string tokens are the names or acronyms of ASCII control characters. The name is not 
case sensitive. For example, the ASCII control character can be input by the delimited strings <esc>, 
<ESC>, or <Esc>.
The syntax for a delimited token is any of the following:

delimited_token = delimited_number, delimited_character, or delimited_string
delimited_number = <number_token> or \number_token



delimited_character = ^character_token or <^character_token>
delimited_string = <string_token>
character_token = A - Z or a - z
string_token = <control character name>

The following are examples of three equivalent functions:
<ESC><SI>^^<DEL><soh> 
<0x1B><0xF>\0x5E<0x7F>^A
\27<15><94><127>\1

ASCII ValueVALID STRING TOKENS
      0      NUL, NULL
      1      SOH, ^A, START OF HEADER, START_OF_HEADER, STARTOFHEADER
      2      STX, ^B, START OF TEXT, START_OF_TEXT, STARTOFTEXT
      3      ETX, ^C, END OF TEXT, END_OF_TEXT, ENDOFTEXT
      4      EOT, ^D, END OF TRANSMISSION, END_OF_TRANSMISSION, ENDOFTRANSMISSION
      5      ENQ, ^E, ENQUIRE
      6      ACK, ^F, ACKNOWLEDGE
      7      BEL, ^G, BELL
      8      BS,    ^H, BACK SPACE, BACK_SPACE, BACKSPACE
      9      TAB, ^I, HT, HORIZONTAL TAB, HORIZONTAL_TAB, HORIZONTALTAB
    10      LF,    ^J, LINE FEED, LINE_FEED, LINEFEED
    11      VT,    ^K, VERTICAL TAB, VERTICAL_TAB, VERTICALTAB
    12      FF,    ^L, FORM FEED, FORM_FEED, FORMFEED
    13      CR,    ^M, RET, CARRIAGE RETURN, CARRIAGE_RETURN, CARRIAGERETURN
    14      SO,    ^N, SHIFT OUT, SHIFT_OUT, SHIFTOUT
    15      SI,    ^O, SHIFT IN, SHIFT_IN, SHIFTIN
    16      DLE, ^P, DATA LINK ESCAPE, DATA_LINK_ESCAPE, DATALINKESCAPE
    17      DC1, ^Q, DEVICE CONTROL 1, DEVICE_CONTROL_1, DEVICECONTROL1
    18      DC2, ^R, DEVICE CONTROL 2, DEVICE_CONTROL_2, DEVICECONTROL2
    19      DC3, ^S, DEVICE CONTROL 3, DEVICE_CONTROL_3, DEVICECONTROL3
    20      DC4, ^T, DEVICE CONTROL 4, DEVICE_CONTROL_4, DEVICECONTROL4
    21      NAK, ^U, NEGATIVE ACKNOWLEDGE, NEGATIVE_ACKNOWLEDGE, 
NEGATIVEACKNOWLEDGE
    22      SYN, ^V, SYNCHRONOUS
    23      ETB, ^W, END OF TRANSMISSION BLOCK, END OF TRANS BLOCK, 
END_OF_TRANSMISSION_BLOCK, ENDOFTRANSMISSIONBLOCK
    24      CAN, ^X, CANCEL
    25      EM,    ^Y, END OF MEDIUM, END_OF_MEDIUM, ENDOFMEDIUM
    26      SUB, ^Z, SUBSTITUTE
    27      ESC, ^[, EC, ESCAPE
    28      FS,    ^/, FILE SEPARATOR, FILE_SEPARATOR, FILESEPARATOR
    29      GS,    ^], GROUP SEPARATOR, GROUP_SEPARATOR, GROUPSEPARATOR
    30      RS, RECORD SEPARATOR, RECORD_SEPARATOR, RECORDSEPARATOR
    31      US,    ^_, UNIT SEPARATOR, UNIT_SEPARATOR, UTILSEPARATOR
    32      SP, SPACE
 127      DEL, DELETE

3. Choose OK.
The name of the function definition that you entered is added to the Functions list. The function can 
now be used by the print device or by any mode you define for this print device.



Modify a Function for a Print Device
This dialog allows you to modify the name and control sequence for the function that you selected in the 
Functions dialog box. 
A function is an action that the print device can perform, such as bold text or proportional spacing. You 
cause the print device to perform the function by sending control sequences to the print device.

To modify a function definition
1. (Optional) In the Function field, enter a new function name.

Function names must be unique (no two names can be the same) and no longer than 32 characters. 
Function names are not case sensitive. You can use both letters and numbers.

2. (Optional) Edit the control sequence in the Control Sequence field by typing the characters that the 
printer uses to set the function.
To find the correct control sequences for print device functions, see the operator's manual for your 
print device .
Characters with ASCII values from 33 through 126 are not delimited; they appear as is. If a character 
in the control sequence has an ASCII value less than 33 or equal to 127, the character is displayed as
a delimited acronym, as listed below. If the character's ASCII value is greater than 127, it is displayed 
as a delimited ASCII value. The value is a decimal number.
The space character can be entered as a space or as a delimited token. A space is displayed as a 
delimited token. 
Except for delimited tokens, characters in a function follow the used as is rule. This means that the 
characters you see displayed are the actual characters that make up the function.
Delimited Tokens
PRINTDEF functions can contain special characters when delimited tokens are included in the 
function. A delimited token has two parts--the delimiters and the token. 
The three types of delimiters are

Angle brackets < and >
Backwards slash \
Caret ^

Because these characters function as delimiters, they are exceptions to the used as is rule. To enter a
left-angle bracket (<), backwards slash (\), or caret (^), you must enter two characters. The right-angle
bracket (>) can be used as is. 
For example, a function that contains the string \\<<^^> will be interpreted as \<^>. The double rule is 
used when entering and displaying PRINTDEF functions.
The other part to a delimited token is the token. A token can be a number, character, or a valid 
character string.
Numbers are used in conjunction with the angle bracket or backwards slash delimiters and can be 
entered in decimal or hexadecimal. To enter a hexadecimal number, use a 0x or 0X prefix. A number 
without the hexadecimal prefix is assumed to be decimal. 
For example, the ASCII control character can be input by the delimited numbers <27>, <0x1b>, 
<0X1B>, \27, \0x1b, or \0X1B. 
You can enter any ASCII character value from 0 to 255 using this method.
Character tokens can be used with angle bracket or caret delimiters. Valid characters are A through Z 
and a through z. Delimited character tokens are the same as ASCII control characters. In other words,
^A has an ASCII value of 1, ^B has an ASCII value of 2, etc.
Character string tokens are the names or acronyms of ASCII control characters. The name is not 
case sensitive. For example, the ASCII control character can be input by the delimited strings <esc>, 
<ESC>, or <Esc>.
The syntax for a delimited token is any of the following:

delimited_token = delimited_number, delimited_character, or delimited_string
delimited_number = <number_token> or \number_token
delimited_character = ^character_token or <^character_token>



delimited_string = <string_token>
character_token = A - Z or a - z
string_token = <control character name>

The following are examples of three equivalent functions:
<ESC><SI>^^<DEL><soh> 
<0x1B><0xF>\0x5E<0x7F>^A
\27<15><94><127>\1

ASCII ValueVALID STRING TOKENS
      0      NUL, NULL
      1      SOH, ^A, START OF HEADER, START_OF_HEADER, STARTOFHEADER
      2      STX, ^B, START OF TEXT, START_OF_TEXT, STARTOFTEXT
      3      ETX, ^C, END OF TEXT, END_OF_TEXT, ENDOFTEXT
      4      EOT, ^D, END OF TRANSMISSION, END_OF_TRANSMISSION, ENDOFTRANSMISSION
      5      ENQ, ^E, ENQUIRE
      6      ACK, ^F, ACKNOWLEDGE
      7      BEL, ^G, BELL
      8      BS,    ^H, BACK SPACE, BACK_SPACE, BACKSPACE
      9      TAB, ^I, HT, HORIZONTAL TAB, HORIZONTAL_TAB, HORIZONTALTAB
    10      LF,    ^J, LINE FEED, LINE_FEED, LINEFEED
    11      VT,    ^K, VERTICAL TAB, VERTICAL_TAB, VERTICALTAB
    12      FF,    ^L, FORM FEED, FORM_FEED, FORMFEED
    13      CR,    ^M, RET, CARRIAGE RETURN, CARRIAGE_RETURN, CARRIAGERETURN
    14      SO,    ^N, SHIFT OUT, SHIFT_OUT, SHIFTOUT
    15      SI,    ^O, SHIFT IN, SHIFT_IN, SHIFTIN
    16      DLE, ^P, DATA LINK ESCAPE, DATA_LINK_ESCAPE, DATALINKESCAPE
    17      DC1, ^Q, DEVICE CONTROL 1, DEVICE_CONTROL_1, DEVICECONTROL1
    18      DC2, ^R, DEVICE CONTROL 2, DEVICE_CONTROL_2, DEVICECONTROL2
    19      DC3, ^S, DEVICE CONTROL 3, DEVICE_CONTROL_3, DEVICECONTROL3
    20      DC4, ^T, DEVICE CONTROL 4, DEVICE_CONTROL_4, DEVICECONTROL4
    21      NAK, ^U, NEGATIVE ACKNOWLEDGE, NEGATIVE_ACKNOWLEDGE, 
NEGATIVEACKNOWLEDGE
    22      SYN, ^V, SYNCHRONOUS
    23      ETB, ^W, END OF TRANSMISSION BLOCK, END OF TRANS BLOCK, 
END_OF_TRANSMISSION_BLOCK, ENDOFTRANSMISSIONBLOCK
    24      CAN, ^X, CANCEL
    25      EM,    ^Y, END OF MEDIUM, END_OF_MEDIUM, ENDOFMEDIUM
    26      SUB, ^Z, SUBSTITUTE
    27      ESC, ^[, EC, ESCAPE
    28      FS,    ^/, FILE SEPARATOR, FILE_SEPARATOR, FILESEPARATOR
    29      GS,    ^], GROUP SEPARATOR, GROUP_SEPARATOR, GROUPSEPARATOR
    30      RS, RECORD SEPARATOR, RECORD_SEPARATOR, RECORDSEPARATOR
    31      US,    ^_, UNIT SEPARATOR, UNIT_SEPARATOR, UTILSEPARATOR
    32      SP, SPACE
 127      DEL, DELETE

3. Choose OK.
Any changes that you made are retained in the print device definition. If you changed the function 
name, the name changes in the Functions list box.



Delete a Function for a Print Device
This dialog allows you to delete the function that you selected in the Modify Print Device dialog box. All 
fields are grayed because you cannot change anything; you can only see the function you are deleting.
To delete the selected function definition, choose OK.
You return to the Modify Print Device dialog. The selected function is deleted from the list and cannot be 
used by the print device definition or any of its modes.



Create a Mode Definition for a Print Device
This dialog allows you to enter a name and a list of functions to define a printer mode.
A mode is a combination of functions that you define to prepare the print device for specific printing 
needs. For example, you might define a print mode called Title that includes functions for bold, double 
wide, and letter-quality printing.

To create a new mode definition
1. Choose Create Mode.
2. In the Mode Name field, enter a name for the new mode.

You can use any eight-character name that begins with a letter. You should choose a name that 
represents the purpose of the printer mode.
Example: You might have modes for different types of documents like memos or reports, for different 
user's preferred settings, or for the requirements of different papers or forms that you use.

2. From the Device Functions list, select the function that you want to be executed first.
Functions are executed in the order they are listed.

3. Choose Add Below.
4. From the Device Functions list, select the function that you want to be executed next.

You can select the same function more than once if the mode requires it.
5. Repeat Steps 3 and 4 until all of the functions that you want as part of this mode are listed in the 

correct order in the Mode Functions list box.
If you make a mistake, use the Delete or Add Above buttons to rearrange the functions listed in Mode 
Functions.

6. Choose OK.



Modify a Mode Definition for a Print Device
This dialog allows you to modify a mode definition that you previously entered.
From this dialog, you can change the name of the mode or which functions are executed by this mode.
A mode is a combination of functions that you define to prepare the print device for specific printing 
needs. For example, you might define a print mode called Title that includes functions for bold, double 
wide, and letter-quality printing.

To modify an existing mode definition
1. (Optional) In the Mode Name field, enter a new name for the mode.
2. From the Device Functions list, select the function that you want to add to the mode.
3. In the Mode Functions list, select the function next to where you want to insert the new function.
4. Choose Add Below or Add Above to insert the selected device function in the correct place in the 

Mode Functions list.
5. Select any mode function that you want to delete from the definition of this mode.
6. Choose Delete.

The selected function is no longer part of this mode definition. The function is still a part of this device 
definition, but is not used for this mode.

7. Repeat Steps 2 through 6 as needed.
8. Choose OK.



Delete a Mode Definition for a Print Device
This dialog allows you to delete a mode definition. All fields are grayed because you cannot change 
anything; you can only see what you are deleting.
1. Select the mode definition you want to delete.
2. Choose OK.
The mode name you selected is removed from the Modes list box. That mode can no longer be used by 
this print device. The function is still part of this device definition, but is not used for this mode.



View or Modify Print Job Configurations
The Job Configuration page lists the names of different print job configurations that can be used. You can 
add new job configurations or modify the parameters of existing configurations.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Change Which Print Job Configuration Is the Default
Create a New Print Job Configuration
View or Modify a Print Job Configuration
Delete a Print Job Configuration

Screen regions and buttons
Name/Owner lists the names of the print job configurations that can be used, and the object at which 

the configuration was defined. If you are looking at a Container object, then only the jobs 
assigned to that container are in the list. If you are looking at a User object, then the jobs 
assigned to the user and the jobs assigned to the user's container are in the list.

New opens the Create Print Job Configuration dialog, where you can enter a name and parameters 
for a new print job configuration.

Modify opens the Modify Print Job Configuration dialog, where you can view and modify the 
parameters of any of the print job configurations that are listed.

Delete removes the selected print job configuration from the list. It can no longer be used.

Default marks the selected print job configuration as the default configuration, as noted by the printer 
icon.

Changes take place immediately.



Change Which Print Job Configuration is the Default
1. From the Print Job Configurations list box, select the print job configuration that you want to make the 

default configuration.
2. Choose Default.

The printer icon to the left of the configuration names moves to the selected configuration. That 
configuration is now the default.



Create a Print Job Configuration
1. Complete each of the applicable fields in the dialog.
2. Choose OK.

The name of the new print job configuration is added to the list.
Related topic

Print Job Configuration Fields



View or Modify a Print Job Configuration
1. Change any fields in the dialog.

You cannot change the name of the print job configuration. You must create a new print job 
configuration.

2. Choose OK.
The print job configuration is saved with any new values you entered.

Related topic
Print Job Configuration Fields



Delete a Print Job Configuration
1. Select a print job configuration from the Name/Owner list box.
2. Choose Delete.

The selected print job configuration is removed from the list.
3. Choose OK.



Print Job Configuration Fields
Print Job Name lists the name of the print job configuration (as listed in the Job Configuration list box)

that a user specifies to be used for a printing job. This field is entered when you create a new job 
configuration. It cannot be changed.

Number of Copies indicates how many copies of the file to print. The number of copies can range 
from 1 to 65,000.

File Contents can be byte stream or text. If text is selected, then tabs are recognized and tab size can
be set.

Tab Size is the number of spaces between tab stops. For example, if a job has two consecutive tabs, 
the position moves two tab stops to the right. This field is only available if you select the File 
Contents field.

Form Feed determines whether a form feed is sent when a job is completed.

Notify When Done determines whether a message is sent to the workstation of the print job originator 
when the job has finished printing.

Local Printer specifies which parallel port of your computer print jobs should be sent to. The values 
listed are LPT1 through LPT9.

Auto End Cap causes the queue file to close automatically when a print job is completed.

Printer/Queue allows you to select the Printer or Queue object that the print job configuration should 
use. The Select Object dialog appears when the browser button is selected.

Device allows you to select which print device this print job configuration uses.

Mode allows you to select the mode this print job configuration uses. The modes listed are defined by 
the device you selected.

Form Name allows you to select which printer form this print job configuration uses.

Print Banner determines if this print job configuration includes a banner page at the beginning of each
print job. If this check box is selected, the next two fields are available.

Name is part of the banner page that is printed at the beginning of a print job using this configuration. 
If this field is left blank, the name of the user who originated the print job is used. This field can 
only be entered if the Print Banner field is selected.

Banner Name is part of the banner page that is printed at the beginning of a print job using this 
configuration. If this field is left blank, the name of the file being printed appears if NPRINT is 
used. If CAPTURE is used, the port number appears. This field can only be entered if the Print 
Banner field was selected.

Enable Timeout determines whether each print job will time out after a specified period of time. If this 
is selected, the Timeout Count field can be set.

Timeout Count field is the number of seconds that each print job takes to time out if the printer does 
not respond. You must select the Enable Timeout field to enter a value here. Timeout can range 
from 1 to 1000 seconds.



View or Change an Object's Rights to Directories and Files
The Rights to Files and Directories page shows all trustee assignments that this object has to files and 
directories on a volume. For example, you can

 See trustee assignments that this object has to a directory or file
 Change this object's trustee assignment to any directory or file
 See the effective rights of this object to any directory or file

You can view trustee assignments to files and directories on volumes that are listed in the Volumes list. To
see trustees on a volume other than those listed, you must add that volume to the list.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
View Trustee Assignments to a Directory or File
Change Trustee Assignments to a Directory or File
Grant This Object a Trustee Assignment to a Directory or File
View Effective Rights to a Directory or File
Add a Volume to the Volumes List
Remove a Volume from the Volumes List

Screen regions and buttons
Volumes lists Volume objects. Any trustee assignment that this object has to a directory or file on a 

volume is listed in the Files and Directories list when you select that Volume object.

Find allows you to search for a Volume object from a context you specify.

Show lets you to add a Volume object to the Volumes list.

Hide lets you remove a Volume object from the Volumes list.

Files and Directories lists files and directories that this object has a trustee assignment to. If you do 
not have rights to change the trustee assignment to that file or directory, the names of the rights 
are grayed.

Add lets you create a new trustee assignment for this object to a directory or file.

Delete lets you delete this object's trustee assignment to the directory or file.

Rights displays the rights that make up the trustee assignment to the directory or file.

Effective Rights lets you see this object's effective rights to a directory or file.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.

Related topics
Trustees and Trustee Paths



Search Context
This dialog allows you to search for Volume objects from any point you specify in the Directory tree.



View Trustee Assignments to a Directory or File
1. From the Volumes list, select the volume that contains the directory or file for which you want to view 

this object's trustee assignment.
2. From the Directories and Files list, select the directory or file.

If you don't have rights to change this trustee assignment, the name of the file and all rights will be 
grayed.
The directory or file's trustee assignment appears in the Rights field.
Note: If you have multiple browser windows open, the volume name shown for this file might not be 
the one you selected the file from. This has no affect on the operation; you are simply viewing the 
same physical file from different objects or views.



Change Trustee Assignments to a Directory or File
1. From the Volumes list, select the volume that contains the directory or file.
2. From the Directories and Files list, select the directory or file.

The rights that make up this object's trustee assignment to the file or directory appear in the rights 
area.
Note: If you don't have rights to change this trustee assignment, the name of the file and all rights are
grayed.
Note: If you have multiple browser windows open, the volume name shown for this file might not be 
the one that you selected the file from. This has no affect on operation; you are simply viewing the 
same physical file from different objects or views.

3. Select the check boxes for rights you want to change.
Note: If the names of the rights are grayed, you don't have rights to change this trustee assignment. 
You must have the Access Control right to the file or directory.

4. Choose OK.
The new trustee assignment is now effective for this object.



Grant This Object a Trustee Assignment to a Directory or File
1. Choose Add.

The Select Object dialog appears.
2. Select the directory or file that you want to grant rights to for this object.

If you don't have rights to change this trustee assignment, the name of the file and all rights are 
grayed.
Note: If you have multiple browser windows open, the volume name shown for this file might not be 
the one you selected the file from. This has no affect on operation; you are simply viewing the same 
physical file viewed from different objects or views.

3. Choose OK.
If you have sufficient rights, the Read and File Scan rights are granted by default. The rights that 
make up this object's trustee assignment to the file or directory appear in the Rights field.

4. Select the check boxes for rights you want to change.
Note: If the names of the rights are grayed, you don't have rights to change this trustee assignment. 
You must have the Access Control right to the file or directory.

5. Choose OK.
The new trustee assignment is now effective for this object.



Add a Volume to the Volumes List
Note: The Rights to Files and Directories page lists Volumes on which this object is a trustee. Being on 
this list does not affect the volumes.
1. Choose Show.
2. Select Volume objects that you want listed in the Rights to Files and Directories page.

You can view or change trustee assignments only to files and directories located on volumes listed 
here.

3. Choose OK.
The volumes you selected are added to the Volumes list.



Remove a Volume from the Volumes List
Note: The Rights to Files and Directories page lists volumes on which this object is a trustee. Being on 
this list does not affect the volumes.
1. From the list at the top of the dialog, select a volume.
2. Choose Hide.

The volume is removed from the list.
To unhide the volume, choose Show and select the volume from the browser; then choose OK.



View This Object's Effective Rights to a Directory or File
1. From the Files and Directories list, select a file or directory.

Note: If you have multiple browser windows open, the volume name shown for this file might not be 
the one that you selected the file from. This has no affect on operation; you are simply viewing the 
same physical file from different objects or views.

2. Choose Effective Rights
This object's effective rights to the object you selected are shown below the File/Directory field.
Effective rights are bold; rights not available to this object are grayed.

3. To see effective rights to specific properties, choose a property from the list.
4. Choose Close.

Note: If you have made changes to this dialog, they are not reflected in Effective Rights until you exit 
this dialog with OK. When you return to this dialog, any previous changes are reflected in Effective 
Rights.

Related topics
More about Effective Rights



Add or Delete Values

To add a value
1. Choose Add.
2. Enter a value.

2a. If the property that you are adding a value to requires an object as a value, select an object.
2b. If the property that you are adding a value to requires text or a number as a value, enter text.

3. Choose OK.
The value is added to the list.

To delete a value
1. From the box above the buttons in this dialog, select the value that you want to delete.
2. Choose Delete.

The value is removed from the list.
Screen regions and buttons

Add lets you add values.

Delete lets you delete values.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Select an Object
1. To search the Directory tree, double-click on objects the Directory Context list box.

The objects located in each context you select appear in the Objects list box.
Use the arrow buttons to the right side of each box to browse through that box.

2. From the Objects list box, select the object you want once it is shown.
The classes of objects listed here for you to select depend on the active field in the previous dialog.

3. Choose OK.
The object that you selected is entered into the active field in the previous dialog.

Screen regions and buttons
Selected Object shows the object that you have selected from the Objects list box.

Current Context shows where you are in the Directory tree (the position in the Directory tree of the 
object that you are working with at the moment).

Name Filter allows you to limit the objects that appear in the left-side list box by using wildcard 
characters or object names. For example, if you wanted only objects that start with the letter P to 
appear in the left-side list box, you could type P* in this field. If you wanted only an object named 
Computer1 to appear in the left-side list box, you would type Computer1 in this field.

Directory Context Filter allows you to limit the containers that appear in the right-side list box by using
wildcard characters or container names. For example, if you wanted only containers that start 
with the letter N to appear in the Objects list box, you could type N* in this field. If you wanted 
only a container named OrgUnitA to appear in the right-side list box, you would type OrgUnitA in 
this field.

Objects shows the objects that you can select. Only certain types of objects are listed here, 
depending on the dialog you are entering information for. Choose the desired object to select it 
and return to the previous dialog. A maximum of 4,600 objects can be listed.

Directory Context shows objects at the next level down the Directory tree. Choose an object to open it
and display its contents in the left-side list box. The up-arrow key moves back up the Directory 
tree. A maximum of 8,192 objects can be listed.

Change Context allows you to enter a new context to begin searching for an object in, without using 
the Directory Context list to browse all over the Directory tree.

OK returns to the previous dialog, inserting the object that you have selected in the active field. You 
must select an object from the Objects list box before OK is available.

Cancel returns to the previous dialog without any object selected.



Select One or More Objects

To choose an object
1. To search the Directory tree, double-click on objects in the Directory Context list box 

The objects located in each context you select appear in the Objects list box.
Use the arrow buttons to the right side of each box to browse through that box.

2. From the Objects list box, select the object you want.
The classes of objects listed here for you to select depend on the active field in the previous dialog.
To select multiple objects listed sequentially, hold down the <Shift> key as you select objects. To 
select multiple objects listed sequentially, hold down the <Ctrl> key as you select objects.

3. Choose OK.
The objects you selected are entered into the active field in the previous dialog.

Screen regions and buttons
Selected Object shows the objects that you have opened to reach the list of objects in the Objects list 

box.

Current Context shows where you are in the Directory tree (the position in the Directory tree of the 
object you are working with at the moment).

Object shows the objects that you can select. Only certain types of objects are listed here, depending 
on the dialog you are entering information for. Choose the desired object to select it and return to 
the previous dialog. A maximum of 4,600 objects can be listed.

Directory Context shows objects at the next level down the Directory tree. Choose an object to open it
and display its contents in the Objects list. The up-arrow key moves back up the Directory tree. A 
maximum of 8,192 objects can be listed.

Change Context allows you to enter a new context to begin searching for an object without using the 
Directory Context list to browse up and down the Directory tree.

OK returns to the previous dialog, inserting the object that you have selected in the active field. You 
must select an object in the Objects list before OK is available.

Cancel returns to the previous dialog without any object selected.



Change Context to Select an Object
This dialog allows you to change the context you are viewing.
By changing your context, you can view other parts of the Directory tree that you have rights to browse, 
without being blocked by upper areas of the Directory tree that you do not have rights to browse.



Select an Object from a Bindery
Use this dialog to select an object that exists in the bindery of a NetWare 3 server. This allows you to do 
limited management tasks on NetWare 3 servers, such as changing the owner of a file, or making trustee 
assignments to a file or directory.
To select an object from a bindery
1. From the list shown, select the User object or Group object.
2. Choose OK.

The object you selected is shown in the field you were in before entering this dialog.



Enter a Property Value
1. Type the value you want to add to the property field.

You can only enter one item in this dialog. Any characters can be used, up to 64 characters.
2. Choose OK.

The value appears in the Selected Property field.



Set a Network Address
The Network Addresses page shows the address of the object you selected in all network protocols 
through which it can be accessed. These addresses tell NetWare Directory Services how to locate the 
physical object, depending on which protocol is being used. On this page, you can

 See the addresses of the object for different protocols
 Add or delete addresses

Note: There is also a Network Address Restrictions page that lists network addresses that a user is 
allowed to log in from.
Because many different protocols can be active on the network at one time, an object can have an 
address for each protocol.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Network Address
Delete a Network Address

Screen regions and buttons
Network Protocol lists the protocol for the new address. Complete the fields in the dialog with values 

appropriate for the protocol you use.

Add... lets you add another network address to the Network Addresses list.

Delete removes the selected network address from the Network Addresses list.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add a Network Address
1. Choose the protocol of the address by choosing a protocol button.
2. Choose Add.
3. Fill in all fields for the new address.
4. Choose OK.

The new network address is added to the Network Addresses list.



Delete a Network Address
1. From the Network Addresses list, select a network address.
2. Choose Delete.

The network address is deleted from the list. The object can no longer be found at that address. If that
was the only address using a certain protocol, then no one using that protocol can find the object.



IPX SPX Protocol Dialog
Enter a value for each field shown here to define a network address in this protocol. See your hardware 
documentation for more information on each field if necessary.

The Network number is assigned arbitrarily to a cable segment when the network is set up.

The Node number is unique to each computer, and is determined by the network board in the 
computer. For Ethernet boards, the number is set at the factory; for token ring and ArcNet boards,
the number can be selected using jumpers on the board.



SDLC Protocol Dialog
Enter a value for each field shown here to define a network address in this protocol. See your hardware 
documentation for more information on each field if necessary.
Synchronous Data Link Control (SDLC) is a protocol used to receive data from or transmit data to 
Systems Network Architecture (SNA) networks.



Token Ring and Ethernet Protocol Dialog
To define a network address in this protocol, enter a value for each field shown here. See your hardware 
documentation for more information on each field if necessary.



TCP/IP Protocol Dialog
To define a network address in this protocol, enter a value for each field shown here . See your hardware 
documentation for more information on each field if necessary.
TCP/IP stands for Transmission Control Protocol/Internet Protocol.
An address consists of four one-byte numbers. The left part indicates which part of the network the 
computer is on. The right part identifies the computer.



OSI Protocol Dialog
To define a network address in this protocol, enter a value for each field shown here. See your hardware 
documentation for more information on each field if necessary.
Open Systems Interconnection (OSI) is a higher-level protocol used with TCP/IP.



AppleTalk Protocol Dialog
To define a network address in this protocol, enter a value for each field shown here . See your hardware 
documentation for more information on each field if necessary.



Clear Button
Choose Clear to make all rights above the Clear button undefined. All check boxes in front of the rights 
become grayed. When rights are undefined, no rights are explicitly granted to this trustee. Rights to this 
object can still be inherited.
Note: You are deleting an entry from the ACL property.
Example: You don't want this user to have explicit object rights anymore, so you choose Clear under the 
list of object rights. All boxes become grayed.



Using the See Also Page
The See Also page gives you a place to list the names of objects related to the object you selected. A 
supervisor or manager can use it to record information about this object.
Note: This list is for your reference only. NetWare does not access this information.
On this page, you can

 List the complete name of related objects
 See which objects are listed as having information related to the selected object
 Add objects to or delete objects from the list

You cannot enter text to describe the relationship of other objects to this object.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog Box
Add a New Object to the See Also Page
Delete an Existing from the See Also Page

Screen regions and buttons
See Also lists the names of related objects.

Add opens a dialog where you choose an object to add to this list.

Delete removes the selected object from the list.

OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add a New Object to the See Also Page
1 Choose Add.
2. Select objects you want to add to the See Also page.
3. Choose OK.

The objects you selected are added to the page.



Delete an Object from the See Also Page
1. From the See Also list, select the object that you want to delete.
2. Choose Delete.

The object is deleted from the list.
3. Choose OK to return to the browser.



View or Change the List of Operators
Use the Operators page to record operators of an object. On this page, you can

 See which objects are listed as operators
 Add objects to or delete objects from the list of operators

Note: This list is for your reference only and doesn't affect who can use the object. Some utilities may use
this list to validate who can access statistical information about a NetWare server.
A supervisor or manager can use it to record information about this object.
Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Add a New Operator
Delete an Operator

Screen regions and buttons
OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Add a New Operator
1. Choose Add.
2. Select objects that you want to add as operators.
3. Choose OK.

The objects you selected are listed as operators.



Delete an Operator
1. From the Operators list, select an operator.
2. Choose Delete.

The operator is removed from the list.
3. Choose OK.



Set Address Information
The Postal Address page shows the postal address of the object you selected. On this page, you can

 See the address of this object
 Set the mailing address to match the address in the object's container with Copy to Label

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.
You can search on individual fields in the top half of the page. The bottom half cannot be searched.

Procedures
How to Use the Object Dialog

Screen regions and buttons
Street Address contains the number and street name.

Post Office Box contains the post office box for this object.

City shows for the name of the town.

State or Province shows the state or province that this object is located in.

Postal (Zip) Code (for USA) is where you enter the zip code. For other countries, enter the 
appropriate information.

Copy to Label copies the information entered in the fields above into the fields in the Postal Address 
area.

Note: If you enter street address and post office box information in the fields at the top of the page, 
only the post office box information appears in the Mailing Label Information section.
OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.



Create or Change a Login Script
Use the Login Script page to specify commands that automatically execute when a user logs in. On this 
page, you can

 Add a drive mapping to a login script
 Add a command to run a program automatically when the user logs in

Important: OK and Cancel affect the entire object dialog, not just this page. Do not choose OK until 
you've entered all changes to this page and other pages. If you choose Cancel, you lose all changes in 
every page of this dialog.

Procedures
How to Use the Object Dialog
Edit a Login Script
Copy a Login Script from another Location
Determine What Scripts Will Be Executed at Login

Screen regions and buttons
OK saves changes in all pages of this dialog.

Cancel closes this dialog without saving changes in any page.

Related topics
Login Script Syntax and Commands



Determine What Scripts Are Executed at Login
Use the following list to determine which scripts are executed when a user logs in to NetWare Directory 
Services.
1. Is there a login script entered in the container immediately above the User object?

If so, it is executed first.
2. Is there a Profile object listed for the user? (see the Login Script page of the User's object dialog).

If so, the script in the Profile object is executed second.
3. Is there a login script entered for the user?

If so, it is executed third.
4. If none of these scripts exists, a default login script is used to map a drive to the \PUBLIC directory so

that this user can use NetWare utilities.



Login Script Commands and Syntax
Each login script command must be written on its own line. Blank lines are ignored. This list shows 
commonly used login script commands. There are other commands described in Supervising the 
Network.

Commands
# Executes an external command and returns to the next line of the login script.

Example: #DIR

ATTACH Connects to a NetWare server in a different Directory tree. 
Example: ATTACH Acctserver/John

BREAK [on l off] Allows the use of <Ctrl><Break> or <Ctrl><C> to stop the login script. Default is OFF.
CLS Clears the display screen.
CONTEXT Changes to a specified context.

Example: CONTEXT users.sales

DISPLAY filename Displays a text file.
Example: DISPLAY NOTICE.TXT

DRIVE Specifies the default drive.
EXIT (filename) Terminates execution of a login script.

Example: EXIT Menu Account

FDISPLAY Filters out control characters and display only ASCII character values 1 to 126.
Example: FDISPLAY README.DOC

FIRE PHASERS Makes a sound to alert you to certain conditions.
Example: FIRE PHASERS 3 times

GOTO label Skips part of the script and jump to another label. Usually used with an IF conditional.
Example: Loop:
Set X=<X>+ 1
Write <X>
IF <X> is less than value 10
GOTO loop



IF ... THEN Tests conditions to execute or skip parts of a login script.
Example: IF day_of_week=friday THEN
Write It's the Weekend!

END

INCLUDE Executes another file of login script commands before continuing with this login script.
Example: INCLUDE sys:public\script.fil

MACHINE Sets the machine name in the DOS environment.
Example: MACHINE = IBM_PC

MAP Sets drive mappings during login using a Volume or Directory Map object.
Example: MAP g:=.SALES_Vol.Novell:Apps\WP

PAUSE Temporarily stops the login script.
Example: IF hour24=23 then PAUSE

REMARK Puts comments in the login script or prevents commands from being executed.
Example: REM temporary drive mapping, delete 10/93

SET name = value Sets or changes DOS or OS/2 environment variables.
Example: SET prompt = $p$g

SET TIME [ON l OFF] Synchronize a workstation with the servers. SET TIME ON is the default.
Example: SET TIME OFF

WRITE Prints messages to the screen.
Example: WRITE Hello World



Defining Additional Properties
In the Create dialog, you enter only enough information to name the object. 
Choose Define Additional Properties to enter values for other properties associated with the object.

To define additional properties
1. In the Create dialog, select Define Additional Properties.
2. Choose Create.
3. Enter needed information in the various pages of the object dialog.
4. Choose OK.

The new object appears in the browser.
Note: You can change an object's property values by opening the object's dialog and making 
changes.



Opening an Object Dialog
Options for opening an object's dialog:

 Double-click on the object (leaf objects only).
Double-clicking on a container object displays the objects it holds.

 Right-click the mouse on the object and select Details from the menu that appears.
 Single-click the object and choose Details from the Object menu.
 When creating a new object in the Create dialog, select Define Additional Properties and choose 

Create.
Related topics

How to Use the Object Dialog



Effective Rights to an Object
Effective rights are the rights that an object can use to access information about another object.
In this diagram, if user ESMITH wants to access Profile MANAGERS, user ESMITH's effective rights to 
do so can come from

 
 Trustee assignments on Profile MANAGERS that list User ESMITH (explicit rights are granted)
 Trustee assignments on Profile MANAGERS that list Organizational Unit SALES PV (rights are 

inherited from user ESMITH's container)
 Trustee assignments on Organizational Unit SALES LA that list User ESMITH; rights must pass 

through Profile MANAGERS' Inherited Rights Filter before becoming effective (inherited from object's 
container)

 Trustee assignments on Organizational Unit SALES LA    that list Organizational Unit SALES PV. Rights
must pass through Profile MANAGERS' Inherited Rights Filter before becoming effective (rights are 
inherited from object's container and trustee's container)

 Trustee assignments to any object listed in the Security Equal To list of user ESMITH, such as a Group 
object (only valid when the object requesting rights is a User object)
Note: Every object is security equivalent to all objects in its complete name, that is, all of the objects 
directly above it to the [Root] of the Directory tree. This security equivalence cannot be changed. None of 
those objects are listed in the Security Equal To list.
If user ESMITH has a trustee assignment to Organizational Unit SALES LA and to Profile MANAGERS, 
the Trustee assignment on Profile MANAGERS overrides the trustee assignment on Organizational Unit 
SALES LA. Trustee assignments to Group objects, however, are added to previous trustee assignments 
for User objects.
You cannot change effective rights directly. You must locate the trustee assignment through which the 
rights were granted and then change it, or add an Inherited Rights Filter to block rights.
If you select one trustee before choosing the Effective Rights button, the effective rights of that trustee are
displayed. Otherwise, you can use the browser button to the right of the Name field  to choose whose 
effective rights you want to view.
You must have the Write or Supervisor property right to an object's ACL property to view other object's 
effective rights to the object.
Note: If you have made changes anywhere in the Trustees dialog, those changes are not reflected in the 
Effective Rights dialog until you exit the Trustees dialog with OK. When you return to the Trustees dialog, 
any previous changes are reflected in the effective rights of an object.



Effective Rights Paths to an Object
Effective rights are the rights that an object can actually use to access information about another object. 
Effective rights are verified each time one object tries to access another object.
In this diagram, user ESMITH's effective rights to Profile MANAGERS can come from several places:

 
 Trustee assignments on Profile MANAGERS that list user ESMITH (explicit rights are granted)
 Trustee assignments on Profile MANAGERS that list Organizational Unit SALES PV (rights are 

inherited from ESMITH's container)
 Trustee assignments on Organizational Unit SALES LA that list user ESMITH; rights must pass through

Profile MANAGERS' Inherited Rights Filter before becoming effective (rights are inherited from object's 
container)

 Trustee assignments on Organizational Unit SALES LA that list Organizational Unit SALES PV; rights 
must pass through Profile MANAGERS' Inherited Rights Filter before becoming effective (rights are 
inherited from object's container and trustee's container)

 Trustee assignments to any object listed in the Security Equal To list of user ESMITH, such as a Group 
object (valid only when the object requesting rights is a User object)
Note: Every object is security equivalent to all of the objects in its complete name, that is, all of the 
objects directly above it to the [Root] of the Directory tree. This security equivalence cannot be changed, 
but none of those objects are listed in the Security Equal To list.
If user ESMITH has a trustee assignment to Organizational Unit SALES LA and to Profile MANAGERS, 
the Trustee assignment on Profile MANAGERS overrides the trustee assignment on Organizational Unit 
SALES LA. Trustee assignments to Group objects, however, are added to previous trustee assignment for
User objects.
You cannot change effective rights directly. You must locate the trustee assignments where the right was 
granted and change it, or add an Inherited Rights Filter to block the right.
If you select a trustee then choose Effective Rights, the effective rights of that trustee are displayed. Also, 
you can use the browser button to the right of the Name field  to choose the object whose effective 
rights you want to view.
You need the Write or Supervisor property right to an object's ACL property to view other object's effective
rights to the object.
Note: If you have made changes anywhere in the Trustees dialog, those changes are not reflected in the 
Effective Rights dialog until you exit the Trustees dialog with OK. When you return to the Trustees dialog, 
any previous changes are reflected in the effective rights of an object.



Inherited Rights Filter
An Inherited Rights Filter blocks rights that would otherwise be inherited by objects who had rights 
granted higher in the Directory tree. In other words, the Inherited Rights Filter filters out the rights that 
other objects have to you, not the rights that you have to other objects.
An Inherited Rights Filter can block any of the trustee assignment rights, including rights for specific 
properties, but object rights and property rights are inherited separately. An Inherited Rights Filter can 
block certain property rights without affecting any object rights.
The rights that you have because you are in a container are gained because you are security equal to 
that container, not because you inherit rights from that container.
Note: The Inherited Rights Filter cannot give rights to anyone; it can only take rights away from a user or 
group that has more rights to an object than you want it to have.

 
If user ESMITH has a trustee assignment to Organizational Unit SALES LA, user ESMITH also inherits 
rights to Profile MANAGERS. Those rights can be blocked by an Inherited Rights Filter on Profile 
MANAGERS.
If user ESMITH also has a trustee assignment to Profile MANAGERS, then that trustee assignment 
grants user ESMITH certain rights which are not affected by the Inherited Rights Filter for Profile 
MANAGERS.
If a check box in the Inherited Rights Filter dialog for Profile MANAGERS is selected, user ESMITH can 
inherit that right. If a check box is not selected, user ESMITH or Organizational Unit SALES PV must have
a trustee assignment to Profile MANAGERS to use that right.
Note: For objects in NetWare Directory Services, the Supervisor object right can be blocked by the 
Inherited Rights Filter. For directories and files, the Supervisor right cannot be blocked by the Inherited 
Rights Filter.



Effective Rights in Files and Directories
An object's effective rights to a directory or file are the rights that they can actually use on the directory or 
file.
Effective rights are verified each time someone tries to access a directory or file. They are determined by:

 Trustee assignments to the directory or file.
 Inherited rights from trustee assignments to a parent directory.
 Trustee assignments to objects listed in a user's Security Equal To list, such as Group objects.

Any rights granted to a trustee for a directory above this directory or file must pass through the Inherited 
Rights Filter before becoming part of the effective rights.
Note: If a user has a trustee assignment to a directory that is higher in the directory structure as well as 
an assignment to this directory or file, the current trustee assignment overrides the previous one.
You cannot change effective rights directly. You must locate the trustee assignments where the right was 
granted and change it, or add an Inherited Rights Filter to block the right.
If you select a trustee then choose Effective Rights, the effective rights of that trustee are displayed. 
Otherwise, you can use the browser button to the right of the Name field  to choose which user's 
effective rights to this directory or file you want to view.
You must have the Access Control right to a directory or file to view other user's effective rights to it. 
However, if the directory or file is on a NetWare 2 or 3 volume, you can only see your own effective rights.
Note: If you have made changes anywhere in the Trustees dialog, those changes are not reflected in the 
Effective Rights dialog until you exit the Trustees dialog with OK. When you return to the Trustees dialog, 
any previous changes are reflected in the effective rights of a user or group.



Inherited Rights Filter for Files and Directories
An Inherited Rights Filter blocks rights that would otherwise be inherited by users who had rights granted 
by a trustee assignment higher in the directory structure.
If a user or group has a trustee assignment to a directory or file, that assignment will override the 
Inherited Rights Filter on the same directory or file. But, if a user or group has rights to a directory or file 
only by inheriting rights from a directory higher in the directory structure, those rights can be blocked by 
the Inherited Rights Filter.
An Inherited Rights Filter can block any of the rights that can be specified in a trustee assignment.
The Inherited Rights Filter cannot grant rights to anyone, it can only revoke rights from a user or group 
that has more rights to an object than you want it to have.
If a check box in the Inherited Rights Filter dialog is selected, users can inherit that right for this directory 
or file. If the check box is not selected, only users and groups with a trustee assignment on this directory 
or file have that right.
Note: For directories and files, the Supervisor right cannot be blocked by the Inherited Rights Filter. For 
objects, the Supervisor object right can be blocked by the Inherited Rights Filter.
Example: Users in group SALES have Create and Erase rights for your PROJECTS directory; however, 
you don't want anyone to have rights to the JANUARY subdirectory under PROJECTS. Create an 
Inherited Rights Filter for JANUARY that doesn't have any check boxes selected. Rights given for 
PROJECTS cannot be inherited for JANUARY (except the Supervisor right). The Inherited Rights Filter 
blocks all rights that are not given to trustees of JANUARY.



Trustees of This Object and Rights to Other Objects
You can view both NetWare Directory Services objects and file system files and directories. This means 
that you sometimes view object and property rights, and other times view file/directory rights, and the 
attributes of files or directories.
You can use the following access control and security features:

 Select an object and choose Trustees of This Object from the Object menu. You can see trustees of the
object you selected, its object and property rights, and view and change its Inherited Rights Filter.

 Select an object and choose Rights to Other Objects from the Object menu. You see where the object 
you selected has a trustee assignment. You also see object and property rights that this object has to 
other objects. You can't change the Inherited Rights Filter here.

 Select an object and choose Details from the Object menu. Select the Rights to Files and Directories 
page in the object dialog. You see which files and directories the object has rights to (by a trustee 
assignment). You see file and directory rights.

 Select a file or directory in a volume and choose Details from the Object menu. Then select the 
Trustees of This File or Directory page in the object dialog. The objects that have rights granted to the file 
or directory through a trustee assignment are listed. You see file and directory rights. You can also view 
and change the file or directory's Inherited Rights Filter.

 Volume is a NetWare Directory Services object that allows you to work with the file system as well. If 
you select a volume and choose Trustees of This Object from the Object menu, you see a Trustees dialog
showing who has rights to see or change the Volume object. Object and Property rights are shown. 

If you select a volume and choose Details from the Object menu and then the Trustees of the [Root] 
Directory page, you see the file and directory rights that apply to the first level of directories on that 
volume.



Trustees of the [Root] Object
The following rules control trustees of the [Root] object (the object above the highest Country or 
Organization object) in the Directory tree.

 When the Directory tree is created, user ADMIN is given the Supervisor object right to the [Root] object.
You can change the name of user ADMIN, and user ADMIN can grant to other objects the Supervisor 
object right to the [Root] object.

 At least one user must be a trustee of the [Root] object with the Supervisor object right. If only one 
trustee of the [Root] object has the Supervisor object right, you cannot delete that trustee from the 
Trustees list, or remove the Supervisor object right for that trustee.

 Because the Supervisor object right can be blocked by the Inherited Rights Filter on objects below the 
[Root] object. You would cut yourself off from part of the Directory tree, if you could remove the Supervisor
object right from the last trustee.

 NetWare Administrator prevents you from deleting the last trustee with Supervisor object right or 
changing the Inherited Rights Filter when there is no Supervisor. But you could still delete the user that is 
listed as a trustee with the Supervisor object right. Then no one would have the Supervisor object right to 
part of the Directory tree. 

Important: Keep track of the users who have the Supervisor object right at the [Root] of the Directory 
tree or at container objects in the tree so that you do not cut yourself off from any part of the Directory
tree.



The [Root] Object in the Directory Tree
The [Root] object of the Directory tree contains no information. Its purpose is to

 Provide the highest point to access to Country and Organization objects
 Allow trustee assignments that grant rights to the entire Directory tree



User Object ADMIN
The user ADMIN is created when you create the Directory tree. User ADMIN is granted a trustee 
assignment to the [Root] object of the Directory tree with the Supervisor object right. This allows a 
network administrator to log in to the network as ADMIN, and have sufficient rights to set up the rest of the
network.
Once the network has been set up and other objects (including users) have been created, ADMIN should 
grant a trustee assignment to the user chosen to supervise the entire Directory tree. After another user 
has the Supervisor object right to the [Root] object, consider deleting the user object ADMIN.
ADMIN only has rights granted by trustee assignments. User ADMIN does not have access to everything, 
like user SUPERVISOR had in previous versions of NetWare.



The Root Directory of a Volume    -    Assigning Rights
The file and directory rights for the root directory of each volume are recorded in each Volume object. 
These are separate from the object and property rights that control access to the Volume object.
When a NetWare server and its volumes are installed, the user installing the server and its volumes is 
granted the Supervisor object right to the NetWare Server object. This grants that user supervisor-level 
access to the file systems of all volumes attached to that server. As in previous versions of NetWare, the 
supervisor right on files and directories cannot be blocked by an Inherited Rights Filter.
The trustee who installed the NetWare server and volumes must make other trustee assignments to the 
directories and files, using the FILER or NetWare Administrator utilities. 



Public as a Trustee
PUBLIC can be listed in the Trustees list of any object to indicate the rights that any object requesting 
access receives if no other rights are effective.
A person can use all of the rights granted to PUBLIC before logging in. Because of this, no audit trail is 
created. Restrict the use of PUBLIC as a trustee to non-secure areas.
You can add PUBLIC as a trustee whenever you are defining trustees of an object or file. You can also 
delete PUBLIC as a trustee of any object or file.
PUBLIC is granted the Browse object right to the [Root] object when NetWare 4 is installed. This allows all
objects to see all other objects until trustee assignments or Inherited Rights Filters are put in place by a 
network administrator.



Supervisor Object Right Restrictions
The Supervisor object right allows unlimited access to an object. Because a Directory tree can span many
divisions or organizations, the Supervisor object right can be blocked from part of the tree by the Inherited
Rights Filter.
If the Supervisor object right is blocked at a container object with an Inherited Rights Filter and no other 
object has the Supervisor object right to that object, you can lose access to part of the tree.
The NETADMIN and NetWare Administrator utilities prevent this problem by restricting when you can 
grant or remove the Supervisor object right. You cannot

 Create an Inherited Rights Filter that blocks the Supervisor object right if a trustee with the Supervisor 
object right doesn't already exist for that object.

 Delete the last trustee of an object with the Supervisor object right or remove the Supervisor object 
right for that trustee if the Inherited Rights Filter of that object blocks the Supervisor object right.
Important: Nothing prevents you from deleting a user how is listed as a trustee with the Supervisor object
right. Keep track of users who have this right at the [Root] of the Directory tree or at container objects in 
the tree so that you do not cut yourself off from any part of the Directory tree.



Inheriting Object Rights    -    Inheriting Property Rights
Object rights and all property rights are inherited separately. Specific property rights are not inherited 
(because different object classes have different properties).
An object's effective object rights to a container object flow down to objects below. An object's effective all
property rights to a container object flow down to objects below. Once the effective object rights and the 
effective all property rights are determined for a leaf object, they are combined to determine the total 
effective rights to the object. 



Select Multiple Objects or Trustees
You can select more than one object at the same time. To select multiple objects listed sequentially, hold 
down the <Shift> key while making selections. To select multiple objects not listed sequentially, hold down
the <Ctrl> key.
If you select more than one object at once, the changes you make affect this object's rights to all selected 
objects.




